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Form No. 008-42104-00

WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each
instrument it manufactures to be free from defects in material and workmanship impairing its usefulness under
normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for war-
ranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory inspec-
tion of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications
are made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such prod-
ucts. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials.
Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our
entire liability in respect to such products, except as an authorized person of MICROMERITICS may other-
wise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check
valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects.
Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be
free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manu-
factures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or
implied, including, but not limited to, the implied warranties of merchantability or fitness for use.

4356 Communications Drive         Norcross, GA 30093-1877   Fax (770) 662-3696

Domestic Sales - (770) 662-3633                                            Domestic Repair Service - (770) 662-3666
International Sales - (770) 662-3660                                               Customer Service - (770) 662-3636
Rev. 12/95
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ChemiSorb HTP Organization of the Operator’s Manual
1.  GENERAL DESCRIPTION

This operator’s manual provides a description of the ChemiSorb HTP, its menu options, and 
operating instructions.

To help you operate the ChemiSorb more efficiently:

• read Chapter 2, User Interface, before operating the analyzer and its software

• use the step-by-step instructions in Chapter 3 when performing common operations  

Organization of the Operator’s Manual

This operator’s manual is organized as follows:

Chapter 1 GENERAL DESCRIPTION

Provides a general description of the ChemiSorb HTP, its features, and 
specifications. 

Chapter 2 USER INTERFACE

Provides instrument and software interface. 

Chapter 3 OPERATIONAL PROCEDURES

Provides step-by-step procedures for the operations performed with the 
ChemiSorb HTP.

Chapter 4 SOFTWARE AND SETUP MODIFICATIONS

Provides instructions for installing software updates and for modifying 
analyzer setup configurations.

Chapter 5 FILE MENU

Provides a description of the choices available on the File menu.

Chapter 6 UNIT MENU

Provides a description of the choices available on the Unit menu.

Chapter 7 REPORTS MENU

Provides a description of the choices available on the Reports menu.
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Chapter 8 OPTIONS MENU

Provides a description of the choices available on the Options menu.

Chapter 9 TROUBLESHOOTING AND MAINTENANCE

Provides user maintenance and service information.

Chapter 10 ORDERING INFORMATION

Provides ordering information for system components.

Appendix A ERROR MESSAGES

Lists the error messages that may be displayed by the software and includes a 
cause and action for each.

Appendix B CALCULATIONS

Provides the calculations used by the ChemiSorb program.

Appendix C GAS CONVERSION CONSTANTS

Provides gas conversion constants for the MFC.

Appendix D CONFIGURING AN ETHERNET PORT

Provides information on configuring an ethernet port.

Appendix E ATOMIC WEIGHTS AND CROSS-SECTIONAL AREAS FOR 
SELECTED METALS

Lists the atomic weights and cross-sectional areas of selected metals.

Appendix F FORMAT OF EXPORTED DATA

Contains the format and description of exported data.

Index INDEX

Provides quick access to a subject matter.
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Conventions

This manual uses the icons shown below to identify notes of importance, cautions, and 
warnings.

Notes contain important information pertinent to the subject matter.

Warnings contain information that helps you prevent actions that may cause personal 
injury.

Cautions contain information that helps you prevent actions that may damage the 
analyzer or one of its components.
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System Description ChemiSorb HTP
System Description

The ChemiSorb HTP is a high-throughput chemisorption analyzer that measures the extent of 
active surface in a catalyst by exposing a sample of the catalyst to a reactive gas at a controlled 
temperature. It contains six ports, allowing six analyses to run concurrently. Each port is 
equipped with a furnace enabling independent control of sample temperature and ramping. A 
mass flow controller is also installed in each port to ensure accurate and reproducible flow 
through the sample.

Software

The ChemiSorb analysis program operates in a Windows® environment. This makes operation 
of the analyzer easier and allows you to run other applications while an automatic operation is 
in progress. 

The report system provided in the analysis program allows you to manipulate and customize 
reports in a variety of ways. You can zoom in on portions of the graphs or shift the axes to 
examine fine details. Graphs and data can be copied to the clipboard and pasted into other 
applications. Reports can be customized with your choice of fonts and a company logo added 
to the report header for an impressive presentation. 
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ChemiSorb HTP Specifications
Specifications

The ChemiSorb HTP has been designed and tested to meet the specifications provided below.

Characteristic Specification

Electrical

Voltage: 100/115/230 VAC

Power: 1300 VA, maximum (exclusive of vacuum fore pump which is 
powered separately) 

Frequency: 50 or 60 Hz

Environment

Temperature: 10 to 35 ºC (50 to 95 ºF), operating; 
-10 to 55 ºC (14 to 131 ºF), storing or shipping 

Humidity: Up to 90% noncondensing (for instrument)
20 to 80% (for computer system)

Physical

Height: 159 cm (63 in.)   

Width: 103 cm (41 in.)  

Depth: 51 cm (20 in.) 

Weight: 215 kg (475 lbs)  

Analysis

Capacity: Six sample ports

Manifold Temperature

Type: Platinum resistance device (RTD), one per port and one in dosing 
manifold

Accuracy: ± 0.02 ºC

Stability: ± 0.1 ºC per month

Gas Flow Control

Type: Mass Flow Controller, one per port

Range: 0 to 200 sccm (nitrogen equivalent flow rate)

Accuracy: Full scale  +1%

Gas Dosing

Accuracy: 0.05 cm3 STP, normal doses
0.01 cm3 STP, low-pressure doses
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Characteristic Specification

Pressure Measurement

Analysis Manifold Transducers:

Range:
A to D Resolution:

Accuracy:

0 to 950 mmHg
0.001 mmHg, 1000-mmHg transducer
0.00001 mmHg, 10-mmHg transducer
Within 0.15% of reading, 1000- and 10-mmHg transducers
(Includes nonlinearity, hysteresis and nonrepeatability; 
transducer manufacturer’s specifications.)

Sample Port Transducers:

Range:
A to D Resolution:

Accuracy:

0 to 1000 mmHg
0.001 mmHg, 1000-mmHg transducer
0.00001 mmHg, 10-mmHg transducer
Within 0.5% of reading, 1000- and 10-mmHg transducers
(Includes nonlinearity, hysteresis, and nonrepeatability; 
transducer manufacturer’s specifications.)

Vacuum Gauge

Type:
Range:
On-screen Resolution:

Thermocouple gauge tube
0 to 100 mHg
0.1 mHg

Furnace System

The ChemiSorb HTP has six independent furnaces, one for each sample port with 
temperature monitoring of the furnace and sample tube.

Temperature Range:
Accuracy:
Stability:
Ramp Range:
Cool down:
Temperature increment:
Thermocouples:

10 ºC above ambient to 700 ºC
± 1.0 ºC
± 0.5 ºC up to 50 ºC; ± 1.0 ºC from 50 to 700 ºC
1 to 20 ºC/min up to 500 ºC; 1 to 10 ºC from 500 to 700 ºC
From 700 to 10 ºC above ambient in less than 60 minutes
1 ºC
12 type K thermocouples

Vacuum System

Oil-sealed vacuum pump: Ultimate vacuum 2.3 × 10-3 mmHg

High-vacuum pump: Less than 3.8 × 10-9 mmHg, measured by pump manufacturer 
according to Pneurop Standard 5608
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Characteristic Specification

Computer

Minimum requirements: Computer capable of running Windows® 7, Windows XP 
    Professional, or Windows Vista® Business or Ultimate 
    operating system
512 megabytes of main memory
20-gigabytes hard drive
Ethernet port (capable of communicating with a 10 base-T
    ethernet card)
CD-ROM drive
1024 × 768 video display capability
 248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01                                        1-7 



Specifications ChemiSorb HTP
1-8                                                      248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01



ChemiSorb HTP Instrument Components and Connectors
2.  USER INTERFACE

This chapter contains information to familiarize you with the hardware and software compo-
nents of the ChemiSorb HTP. It is recommended that you read this chapter before attempting 
to operate the ChemiSorb analyzer.

Instrument Components and Connectors

Front Panel

Power indicator

Sample port connectors

Sample tube storage

Port status and 
elevator controlsHigh-vacuum pump

power indicator
(located underneath)

Provides access to the 
vacuum pumps

Thermocouple connector Furnace/
elevator

Power indicator Illuminates when analysis program is initiated and ready for 
operation

Sample port connector For installing the sample tube; one for each port
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Thermocouple connector For attaching the thermocouple, one for each port

Furnace/elevator The furnace resides on the elevator and is operated using the 
push buttons on the Port status pad.

Port status
Elevator control

Each port has a status indicator and elevator control.

The indicator lights on the left side illuminate to reflect the 
state of the port.

The elevator push buttons on the right side function as 
follows:

Up raises the elevator to its uppermost position.

Down lowers the elevator to its lowest position.

Stop will stop the elevator at its current position.

High-vacuum pump 
power indicator

Illuminated when power is applied to the high-vacuum pump 
and the pump is running at the correct speed. 

Sample tube storage For convenient storage of sample tubes.

Indicate port status Control elevator movement
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Rear Panel

Exhaust connector

Exhaust connector For certain gases it is necessary to vent the gases via an 
external venting system. This connector is used to attach an 
external exhaust system.

When using dangerous gases, an exhaust system must be used to vent gas fumes.
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Right Side Panel

Gas inlet connectors

Inlet diagram

Service access panel

On/Off switch

Power connector

Voltage selector

Compressed Air 
connector Ethernet connector

RS-232 connector

Gas inlet connectors For attaching analysis gases

Inlet diagram Provides a pictorial representation of inlet connectors. Use 
these numbers when assigning gas ports on the Gas 
Configuration dialog (see page 6-26).

Compressed air connector For connecting a compressed air (or nitrogen) supply to cool 
the furnace

Compressed air is released into a hot furnace. Be sure air is clean and dry. Oily or wet 
air may cause dangerous conditions, resulting in personal injury or damage to the 
instrument.
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Turning the Analyzer On and Off

Turning On the Analyzer

1. Place the On/Off switches for the computer and all peripheral devices in the ON position.

2. Place the analyzer On/Off switch in the ON position.

Turning Off the Analyzer 

1. Select Close from the System menu or Exit from the File menu.

If an analysis is in progress, the following message is displayed:

If you click Yes and the analysis program closes, the analysis continues and data continue 
to be collected. Reports that are queued under the Print Manager will print. If, however, a 
power failure occurs and an uninterruptible power supply (UPS) is not attached to the 
analyzer, the data collected after exiting the analysis program are lost.

Ethernet connector For connecting the ethernet cable, allowing communication 
between the analyzer and the computer

RS-232 connector Used by service personnel to perform calibration procedures.

On/Off switch For turning the analyzer on and off

Power connector For connecting the power cord

Voltage selector For selecting the proper operating voltage

Always exit the analysis program and the Windows application before turning off the 
computer. Failure to do so could result in loss of data.

2459- An Instrument is busy. A delay in restarting this 
application could result in loss of new data. Continue 
program exit?

              Yes                        No
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2. Place the On/Off switches for the computer and all peripheral devices in the OFF position.

3. Place the analyzer On/Off switch in the OFF position.

Using the Software

The ChemiSorb program requires familiarity with standard Windows operations such as using 
the mouse, menus, and dialog boxes. While this manual provides brief instructions for such 
standard operations, you may have to refer to your Windows documentation or to its online 
help system to clarify functions which are specific to Windows.

Shortcut Menus

Shortcut menus (sometimes referred to as context-sensitive menus or pop-up menus) are avail-
able for onscreen graphs, tabular reports, and components on the instrument schematic. These 
menus are accessed by selecting the item for which you wish to display its menu and clicking 
the right mouse button. For example, right-click in a column of an onscreen report and the fol-
lowing menu is displayed.

Shortcut Keys

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combina-
tions (if assigned) are listed to the right of the menu item. Instead of opening the menu and 
choosing the command, simply press the key combination. For example, to open a sample 
information file, press F2; the Open Sample Information dialog is displayed.

You can also use shortcut keys to access a menu or any function that contains an underlined 
letter by pressing Alt plus the underlined letter in the command. For example, press Alt, then F 
to access the File menu.
2-6                                                      248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01



ChemiSorb HTP Using the Software
The following table provides a list of the Shortcut keys available for the ChemiSorb program.

File Name Conventions

For sample information files, a default file name (the next available sequence number) and a 
default extension display. For Analysis conditions and Report options, only a default extension 
displays.

The following table shows the file name extensions for the ChemiSorb program.

Default File Name Extensions

Key(s) Function

F1 Access electronic copy of operator’s manual

F2 Open a sample information file

F3 Open an analysis conditions file

F5 Open a report options file

F6 Tile windows

F7 Cascade windows

F8 Start a report

F9 Close all open reports

F10 Generate a Heat of Adsorption report

Alt + F4 Exit the analysis program

Shift + F2 List sample information files

Shift + F3 List analysis conditions files

Shift + F5 List report options files

Shift + F9 Access shortcut menu for (1) selected component on instrument schemat-
ic, or (2) onscreen reports

File Type Extension

Sample information SMP

Analysis conditions ANC

Report options RPO

Report REP

Spreadsheet XLS

ASCII TXT
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Menu Structure

All functions for the ChemiSorb program are located on menus which are accessed from the 
Menu bar. Each menu contains commands and, in some cases, a submenu. A submenu is indi-
cated when the command is followed by an arrow. 

Brief descriptions of each menu are provided below; refer to the chapter given in parentheses 
for a detailed description of the options contained on that menu.

File Allows you to manage sample and parameter files. 
(Chapter 5, FILE MENU)

Unit [n] Enables you to perform analyses. A unit menu is displayed 
for each attached unit. (Chapter 6, UNIT MENU)

Reports Enables you to generate, open, and close reports. 
(Chapter 7, REPORTS MENU)

Options Allows you to edit sample defaults and select data 
presentation formats. (Chapter 8, OPTIONS MENU)

Windows Enables you to arrange the windows and icons on your 
screen. It also displays the names of all open windows. 
(this chapter, page 2-9)

Help Provides access to the online manual. (this chapter, 
page 2-9)

Submenu

Command

Menu Bar

Menu Name
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Windows

The commands on this menu allow you to arrange your open windows and icons. 

The Windows menu also displays all open files; the active window is preceded with a check 
mark.

Help Menu

Cascade Resizes all open windows and arranges them in a stacked 
fashion. The active window is positioned on top of the stack. 
Each window’s title remains visible, making it easy to select 
other windows.

Tile Resizes all open windows and arranges them side by side so 
that the contents of all open windows are visible.

Arrange Icons Arranges the symbols for all minimized windows in an 
orderly manner.

Operator’s Manual Provides a copy of the ChemiSorb operator’s manual in 
Adobe® PDF format.

Micromeritics on the Web Provides a link to the Micromeritics web site.

About ChemiSorb HTP Displays information about the ChemiSorb program.
 248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01                                         2-9 



Menu Structure ChemiSorb HTP
2-10                                                      248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01



ChemiSorb HTP Specifying Sample Defaults
3.  OPERATIONAL PROCEDURES

This chapter contains step-by-step procedures for operating the ChemiSorb analyzer. It does 
not provide detailed descriptions of the fields in the dialogs used to perform these procedures. 
Chapters 5 though 8 contain details for the dialogs.  

Maintenance procedures are described in Chapter 9.

Specifying Sample Defaults

Sample information files include the information required by the analyzer to perform an anal-
ysis and collect data. The software automatically generates sample information file names and 
assigns the default values which you specify.  Sample defaults allow you to customize your 
sample file as well as the file name sequence. It is best to specify defaults for materials that 
you most commonly analyze. You can always edit the values when the sample file is created.

Sample defaults can be specified using the Advanced or Basic format. 

Advanced Format

The values you specify in the parameter portions of the Advanced sample file (Analysis 
Conditions and Report Options) are saved as the defaults for newly created parameter files.

For example, after specifying defaults for a sample file in the Advanced format:

• Select File > Open > Sample Information, click Open, then Yes to create the file, 
and the defaults you specify display for all parameters.

• Select File > Open > Analysis Conditions, enter a file name; click Open, then Yes 
and the defaults you specify in the Analysis Conditions portion of the Advanced 
Sample Defaults dialog display in the fields.

Refer to Advanced, page 8-6 for a detailed description of the fields on this dialog.
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1. Select Options > Sample Defaults; the Sample Defaults dialog is displayed.

2. In the Sequence field, specify a default string. This is the number that is incrementally 
sequenced and displays in the File name field when you select File > Open > Sample 
information.

3. In the field to the right of the Sample line, enter a format for the identification. Include 
the $ symbol if you wish to have the sample file number/name included as part of the 
identification. 

You can also edit the label (Sample); for example, you may wish to use Material. 

4. Edit the Operator and Submitter lines as desired. Or you can select Omit if you wish 
not to use these fields.

5. If bar code information is not applicable, select Omit to omit this field from the sample 
information dialog. Or, if you prefer to use this line for some other type of information, 
edit the label (or not enter a label name). 

6. You can enter a sample mass or have it calculated automatically; choose the desired 
method. 

• Enter: enter a default value in the Mass field. 
• Calculate: enter default values in the Empty tube and Sample+tube fields

7. Click the Analysis Conditions tab and specify appropriate analysis conditions. Refer to 
Analysis Conditions, page 3-6 for detailed instructions.
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8. Click the Report Options tab and specify report options. Refer to Report Options, page 
3-7 for detailed instructions. 

9. Click Save, then Close.

Basic Format

Perform the following steps to establish defaults for a sample information file in the Basic for-
mat. The defaults you establish with this format also serve as defaults for files created using 
the Restricted format.

When specifying defaults in the Basic format, you will have to select default parameter files. 
You may wish to define parameter files before entering sample defaults (refer to Defining 
Parameter Files, page 3-5).

Refer to Basic, page 8-9 for a detailed description of the fields on this dialog.

1. Select Options > Sample Defaults; the Sample Defaults dialog is displayed.

2. In the Sequence field, specify a default string. This is the number that is incrementally 
sequenced and displays in the File name field when you select File > Open > Sample 
information.

3. In the field to the right of the Sample line, enter a format for the identification. Include 
the $ symbol if you wish to have the sample file number/name included as part of the 
identification.  
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You can also edit the label (Sample); for example, you may wish to use Material.

4. You can enter a sample mass or have it calculated automatically; choose the desired 
method. 

• Enter: enter a default value in the Mass field. 
• Calculate: enter default values in the Empty tube and Sample+tube fields

5. Select the down arrow to the right of the following fields to choose default parameter 
files:

• Analysis Conditions
• Report Options

6. Click Save, then Close.

Opening Files

When you use the File >Open command to open a sample information or a parameter file an 
Open File window similar to the example below is displayed.

• Sample Information files - the File name field contains the next sequential file name 
generated by the program. The sample information file extension is .SMP.
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• Parameter files - the File name text box contains an asterisk (*) and a default file exten-
sion depending on the type of parameter file selected. Default file extensions are:

*.ANC Analysis Conditions
*.RPO Report Options

Creating a New File

1. Select File > Open > (file type).

2. Enter the new file name in the File name text box or, for a sample information file, you 
can accept the default name.

3. Click Open.

4. At the prompt, click Yes to create a new file. 

Opening an Existing File

1. Select File > Open > (file type).

2. The files in the active directory are displayed. You can navigate to another directory if you 
want to open or create a file in a different directory.

3. Click a file in the files list, then click Open.

Defining Parameter Files

The following file types can exist as part of the sample information file, as well as individual 
parameter files:

• Analysis conditions
• Report options

Having these files exist independently allows you to use them over and over again. 

Several predefined parameter files are included with the analysis program. Although these 
files may come close to the needs of your laboratory, you may wish to define additional ones 
or use a predefined file as a starting point. You can do this by creating a new file and then 
clicking Replace. A dialog is displayed so that you can select the existing parameter file. Then 
you can make any changes you need to make and the original file remains unchanged.

Make sure you save these files to the directory specified as the Parameter File directory, or 
they will not be included in the drop-down lists on the Basic and Restricted sample informa-
tion dialogs. Unless you have changed the parameter file directory, the software defaults to the 
correct directory (refer to Parameter Files Directory, page 8-17 for details).
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Analysis Conditions

Analysis conditions specify the data used to guide an analysis. 

Refer to Analysis Conditions, page 5-12 for a detailed description of the fields on this dialog.

1. Refer to Creating a New File, page 3-5 to open the Analysis Conditions window.

2. Enter a description in the Description field; use an intuitive description so that you can 
recognize it easily.

3. Click Insert to insert tasks for the analysis; the Select a task dialog is displayed.

4. Select a task, then click Insert.

Each task has an associated dialog, which contains appropriate parameters for that task. 
Define parameters for each task. Only one Analysis task may be inserted.

5. Click Save, then Close.
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Report Options

Report options files specify the type of reports which can be generated from an analysis or 
from manually entered data. They also contain report details such as axis scale, axis range, and 
column headings. These report options files may be used to generate reports automatically at 
any time during or after the analysis. Of course, reports generated during analysis can only 
report on data collected up to the time of the report.

Report options files may contain tabular reports only, plots only, or both tabular reports and 
plots. They may also contain user-defined report tables.

Report options files also may be defined to include overlay options. The ChemiSorb program 
enables you to overlay up to eight plots of different samples onto a ninth plot of the same type. 
Refer to Generating Graph Overlays, page 3-29 for instructions on generating overlays.

Refer to Report Options, page 5-25 for a detailed description of the fields on this dialog.

1. Refer to Creating a New File, page 3-5 to open the Report Options window. 

2. Enter a description in the Description field. Enter an identifier that gives an intuitive 
description of the file’s contents. 

3. The reports that may be generated are listed in the Selected Reports list. 

a. Click the check box for the reports you wish to include in this file; this inserts a check 
mark and indicates they are selected.

b. Click Edit to specify report options; be sure the report is highlighted and selected. 

4. Select Apply thermal transpiration correction if you wish to correct for thermal 
transpiration in the sample tube, then enter the inside diameter of the sample tube (or 
filler rod when used).
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5. If you wish to compare the same type of graph from multiple files, click Overlays and 
choose the files. Then be sure you edit the graph from the Selected Reports window and 
choose Samples from the Overlay drop-down list.

6. Select Show report title and enter the title you wish to appear at the top of the report. 
Deselect this option if you prefer not to have a report title.

7. Click Save, then Close.  

Creating a Sample Information File

Whether you choose to create your sample file in advance or at the time of analysis, a sample 
information file must be created for each analysis. The sample information file consists of 
information groups which, collectively, identify the sample, guide the analysis, and specify 
report options.

A sample file may be created in any of the following formats:

• Advanced
• Basic
• Restricted

Select Options > Options Presentation to choose a format (refer to Option Presentation, 
page 8-2 for additional information).

Advanced Format

The Advanced format presents all parts of the sample file in an index card manner. This format 
lets you customize your sample file, allowing quick access to all parameters. 

Refer to Advanced Format, page 5-5 for a detailed description of the fields on this dialog.

If your company logo exists as a bitmap (bmp) or enhanced metafile (emf), you can 
have it display in the report header by selecting Show graphic. Click Browse to select 
the file; use the Height and Width fields to specify the size.
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1. Refer to Creating a New File, page 3-5 to open the Sample Information file window. 

2. Enter a description in the Sample field, or edit the one specified in sample defaults. 

3. In the Operator field, enter the name of the person who will be performing the analysis.

4. In the Submitter field, enter the name of the department, company, etc. submitting the 
sample for analysis. 

5. Enter bar code information (if used). This field (as well as the Operator and Submitter 
fields) will also accept input from a bar code reader (connected to a USB port on the 
computer).

6. Select Enter to enter a value for the sample’s mass (if different from the default value), or 
Calculate to have the mass calculated automatically. If you select Calculate, you must 
enter weights for the Empty tube and the Sample + tube.

7. Choose whether you are going to use manually entered data or have data collected.

8. After you complete the Sample Information dialog, click on the parameter tabs to open 
associated dialogs and edit as desired. Instructions for completing these dialogs are 
explained in Defining Parameter Files, page 3-5.

9. After you have completed all parameters, click Save, then Close.

These fields may not 
display if omitted in 
sample defaults.
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Basic and Restricted Formats

The Basic and Restricted formats are the easiest and simplest way to create a sample file. You 
simply create your sample information file using predefined parameter files (explained in this 
chapter beginning on page 3-5). 

• If you are using the Basic format, you can switch to the Advanced format when editing 
is required. 

• If you are using the Restricted format, you cannot switch to Advanced and edit 
parameter files.

Refer to Basic Format, page 5-8 for a detailed description of the fields on this dialog.

1. Refer to Creating a New File, page 3-5 to open the Sample Information window.

2. Enter a description in the Sample field, or edit the one specified in sample defaults. 

3. Enter the name of the technician that will perform the analysis.

4. Select Enter to enter a value for the sample’s mass (if different from the default value), or 
Calculate to have the mass calculated automatically. If you select Calculate, you must 
enter weights for the Empty tube and the Sample + tube.
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5. Click on the down arrow to the right of each of the Analysis Conditions and Report 
Options fields to choose parameter files.

6. Click Save, then Close.

Preparing for Analysis

The table shown here outlines the tasks necessary to properly prepare for an analysis, as well 
as the location of the procedure for performing the task. It is best to perform the tasks in the 
order given in the table. 

Cleaning and Labeling Sample Tubes

Sample tubes and filler rods must be clean and dry before samples are added and weighed.  
Refer to the table below for a list of materials needed to clean and weigh samples.

1. Turn on the drying oven used for heating the sample tubes and filler rods and set the 
temperature to 110 ºC.  

2. Check the reservoir of the ultrasonic cleaning unit to make sure it is clean.

If you have an existing sample file containing the values you wish to use for this file, 
click Replace All to choose the file and copy the values into the current file. 

Task Name and Location

Clean the sample tube Cleaning and Labeling Sample Tubes, page 3-11

Create the sample file Creating a Sample Information File, page 3-8

Weigh your sample Determining the Sample Mass, page 3-14

Load sample on sample port Installing the Sample Tube, page 3-18

Supplied by Micromeritics Supplied by User

Sample tube Drying oven

Filler rod (if used) Ultrasonic cleaning unit

Stoppers for sample tube Detergent

Sample tube brush Rubber gloves or lint-free cloth

Sample tube rack Isopropyl alcohol

Sample weighing support Safety glasses

Quartz wool Analytical balance

Pipe cleaners
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3. Using five grams of Alconox® (or other suitable detergent) per 500 mL of warm water, 
fill the reservoir of the ultrasonic unit with enough water to cover the sample tubes and 
filler rods. Make sure the detergent is dissolved before placing the sample tubes and filler 
rods into the water. If too much detergent is used, it may be difficult to rinse from the 
sample tubes.

4. Fill the sample tubes with warm water and place them and the filler rods in the reservoir 
of the ultrasonic cleaning unit. Turn on the ultrasonic cleaning unit for approximately 
fifteen minutes.

5. Using latex gloves, remove the sample tubes and filler rods from the reservoir.  

6. Clean the interior of the sample tubes with the brush supplied with the ChemiSorb 
System.

7. Rinse the sample tubes and filler rods thoroughly with hot water, then with isopropyl 
alcohol.

If isopropyl alcohol is not available, deionized water may be used to rinse the sample 
tubes.
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8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in 
the rack. Bake in a vacuum oven for two hours.

9. Remove the sample tubes and filler rods from the oven and allow them to cool.

10. Wipe the rubber stoppers with a lint-free cloth. 

11. Label the sample tube and stoppers for identification.

Do not insert the filler rods at this time. Filler rods are inserted just before the sample 
tube is installed on the analysis port.
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Determining the Sample Mass

Carefully weigh each sample tube set and sample as described below.

1. Place the sample weighing support on the balance. Tare the balance and allow it to 
stabilize at zero (0).                             

2. If you are analyzing a powder or sample made of fine particles, push a piece of quartz 
wool all the way down inside the sample tube. 

                               

Quartz wool
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Then choose one of the following:

• If using quartz wool, put a second piece of quartz wool just inside the sample tube. 

• If using filter disks, push a filter disk down into the tube on top of the quartz wool, and 
place a second filter disk just inside the sample tube.

Quartz wool

Filter disk

Filter disk

Quartz wool
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3. Place the sample tube set (sample tube with quartz wool or filter disks and the stoppers) 
on the sample support. Record the stabilized weight as the Empty tube (contains no 
sample). 

4. Remove the sample weighing support and sample tube set from the balance.

5. Place a sample container on the balance; allow the balance to stabilize at zero (0).

6. Slowly add sample (approximately 0.5 to 1.0 gram) to the sample container.

7.  If you are analyzing a powder or sample made of fine particles, remove the top portion of 
quartz wool or the filter disk from the tube.

8. Using a funnel, slowly pour sample from the container into the sample tube on top of the 
quartz wool remaining in the tube. 

Do not touch the sample with bare hands while performing the next step. Oil from your 
fingers could affect the accuracy of results. 

Make sure all of the sample in the container is placed in the sample tube to avoid 
errors caused by incorrect sample weight.
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9. Choose one of the following:

• If using quartz wool, insert the top portion of quartz wool into the tube and press it 
down.

•  If using filter disks, insert the filter disk into the tube and press it down.

10. Wipe the top of the sample tube with a lint-free cloth, such as a Kimwipe®, to remove any 
quartz wool that may have adhered to its surface.

11. Weigh the sample tube set containing the sample and the stoppers. Record this weight as 
the Sample + tube.

12. Enter the sample mass in your sample file as follows:

Make sure the disk is flat on top of the sample. It needs to seal around the edges so 
there will be no gap allowing the sample to escape.

If you selected ... Then  ...

Enter Subtract the empty tube mass from the sample + tube mass. 
Enter this value in the Sample Mass field.

Calculate Enter the value you recorded for the sample plus the tube in 
the Sample + tube field.

Enter the value you recorded for the empty tube in the 
Empty tube field.

The value entered for Mass is used in report calculations; therefore, it should be exact. 
To ensure accuracy, reweigh the sample after analysis. If the value is not equal (or very 
close) to the one entered previously for Mass, you may want to change the value after 
analysis.
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Installing the Sample Tube

These instructions are for installation on a single port; repeat for the number of ports being 
used.  

Be sure to wear latex gloves when installing the sample tube onto the port. It is important that 
the sample tube and its components, as well as the sample and exhaust ports be clean and free 
of debris. Dust particles from quartz wool or from the insulator disk of previous analyses may  
adhere to the port and/or components, preventing a proper seal of the sample tube. 

1. Using a lint-free swab moistened with IPA, wipe the interior rims of the sample and 
exhaust ports.

2. Use a lint-free tissue moistened with IPA and wipe the O-ring, ferrule, and connector nuts 
for the sample and exhaust tubes. Place on a lint-free tissue until installed (step 5).

3. Remove the stopper from the sample tube stem and the cap from the exhaust stem.

4. If using a hanging filler rod (recommended), hold the sample tube slightly tilted and 
carefully place the filler rod into the tube.

5. Assemble and install the sample and exhaust tube components as shown below.

6. Align the sample and exhaust tube stems with their respective ports and carefully push 
the sample tube into the ports. Slide the connector nuts up the stems. Screw the nuts 
clockwise to secure the tube in place; hand-tighten both nuts.

It is very important that the sample and exhaust ports, as well as all components that 
contact the sample and exhaust ports, be clean. Therefore, it is recommended that 
steps 1 and 2 be repeated each time you install a sample onto the port. 

 

Connector nut

Connector nut

Ferrule

Ferrule

O-ring

O-ring

Filler rod
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7. Slide the insulator disk onto the sample tube. The insulator disk surrounds the sample 
tube when the furnace is raised, preventing heat loss and improving thermal stability.

8. Place the sample thermocouple between the stems of the sample and exhaust tube. Attach 
the thermocouple retaining clip to hold the thermocouple in place. 

 

Sample Port Exhaust Port

Thermocouple

Insularor disk

Retaining clip

Bottom lid of 
furnace
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9. Check to ensure that the bottom lid is on the furnace.

10. Press the Up push button on the port status pad to raise the furnace. Be sure the  
insulating disk seats properly on the top of the furnace.

11. Install the furnace shield.

   
3-20                                                      248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01



ChemiSorb HTP Performing an Analysis
Performing an Analysis

After the samples have been installed on the analysis ports, you may begin analysis. The Che-
miSorb provides two types of analyses:

• Sample Analysis: allows you to perform up to six analyses 
• Sequence Analysis: allows you to perform sequenced analyses using the same sample 

Sample Analysis

Refer to Sample Analysis, page 6-3 for a detailed description of the fields on this dialog.

1. Select Unit > Sample Analysis; the Analysis dialog is displayed.

2. Click Browse at the right of the Port 1 field to choose a sample information file. The 
sample identification, free space, and sample mass contained in the sample information 
file are displayed. 

3. Use the Browse push button to the right of each port containing a sample to select a file. 
A compatibility check is performed to ensure that certain parameters match those of the 
sample chosen for port 1. If all parameters are not compatible, a dialog giving the 
incompatible areas is displayed. Use the Edit push button to edit the file or choose 
another file. 

4. Select Report after analysis to have reports generated or isotherm data exported 
automatically when the analysis completes. Be sure to designate the destination if you 
choose this option.
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5. Click Start; a second view of the analysis dialog prompting you to install insulating disks 
and safety shields is displayed.

Ensure that the tasks have been completed. 

6. Click Next; an analyzing view of the window is displayed so that you can view data as 
collected. A short delay is encountered before the port status changes from the Idle state.

7. After the analysis is finished, remove the sample tube and dispose of the sample 
appropriately.

Sequence Analysis

Refer to Analysis Sequence, page 6-8 for a detailed description of the fields on this dialog.

1. Select Unit > Analysis Sequence; the Sequence Analysis dialog is displayed.
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2. Click Append to assign sample files for the first sequence.

a. Click Browse; the Open Sample Information dialog is displayed.

b. Select (or create) a file and click Open to return to the Sequence Analysis dialog.

c. Repeat steps (a) and (b) for relevant ports.

d. Use the Edit button if you wish to review or change file details.

e. Click OK to return to the Sequence Analysis dialog.

3. Repeat step 2 to assign sample files for the second sequence (if desired).

4. Click Start; a view of the analysis dialog prompting you to install insulating disks and 
safety shields is displayed.

Ensure that the tasks have been completed. 

5. Click Next; an analyzing view of the window is displayed so that you can view data as 
collected. A short delay is encountered before the port status changes from the Idle state.

6. After the analyses have finished, remove the sample tube and dispose of the sample 
appropriately.
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Printing File Contents

Using the Print command on the File menu, you can print the contents of one or more sample 
or parameter files. 

1. Select File > Print > (file type); a dialog similar to this one is displayed.

2. From the files window, select the file(s) you wish to print. If you plan to print multiple 
files, hold down Ctrl while selecting the files.

3. Click Open. The Report Settings dialog is displayed.

4. Choose a destination for file output. 

• Preview: prints file contents to the screen.

• Print: prints file contents to the default printer. The Copies field is enabled allowing 
you to print up to 10 copies. 

• File: prints file contents to a file. The adjacent field is enabled allowing you to enter a 
name for the file, or you can accept the default.
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5. Click OK; the file is sent to the specified destination. The following example shows a 
sample information file printed to the screen.
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Listing File Statistics

You can generate a list of the following information on one or more sample or parameter 
files:

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• Status (sample files only)

1. Select File > List> (file type); a dialog similar to this one is displayed.

2. From the files window, select the desired file(s). If you plan to select multiple files, hold 
down Ctrl while selecting them. From the files window, select the file(s) you wish to 
print. If you plan to print multiple files, hold down Ctrl while selecting the files.

3. Click Open. The Report Settings dialog is displayed.

4. Choose a destination for file output. 
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• Preview: generates file statistics to the screen.

• Print: generates file statistics to the default printer. The Copies field is enabled 
allowing you to print up to 10 copies. 

• File: generates file statistics to a file. The adjacent field is enabled allowing you to 
enter a name for the file, or you can accept the default.You can also choose the type of 
file from the File type drop-down list.

5. Click OK; file statistics are sent to the specified destination. The following example 
shows statistics for three sample information files printed to the screen.
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Exporting Isotherm Data

Export allows you to copy the isotherm data in a sample information file and export it as an 
.xls, .rep. or .txt file. 

1. Select File > Export; the Sample Information File Export dialog is displayed.

2. From the files window, select the desired file(s). If you plan to select multiple files, hold 
down Ctrl while selecting them.

3. Click Open. The Report Settings dialog is displayed.

4. Choose a destination for file output. 

• Preview: generates file statistics to the screen.

• Print: generates file statistics to the default printer. The Copies field is enabled 
allowing you to print up to 10 copies. 
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• File: generates file statistics to a file. The adjacent field is enabled allowing you to 
enter a name for the file, or you can accept the default. The File type dropdown list is 
enabled allowing you to select either Spreadsheet or ACSII text as the output file 
type.

5. Click OK; the file is sent to the specified destination. 

Generating Graph Overlays

Use the graph overlay function to overlay the same type of graph for multiple samples. 

You must use the Advanced format for generating overlays. Select Options > Options pre-
sentation > Advanced to access the Advanced mode, or click the Advanced push button on 
the Basic Sample Information dialog.

1. Select File > Open > Sample Information to display the Open Sample Information File 
dialog. 

2. Select a sample on which to overlay graphs of other samples, then click Open; the 
Sample Information dialog is displayed.

3. Click the Report Options tab to display the Report Options dialog.
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4. Choose the desired report from the Selected Reports list; then click Edit to display   
report options. This example shows Isotherm Report Options.

5. Select the Overlay samples check box, then click OK to return to the Report Options 
dialog.

6. Click Overlays; the Graph Overlays Samples dialog is displaed.

7. Click Browse to the right of the Sample [n] field; the Plot Overlay Sample Selection 
dialog is displayed.

8. Choose the file containing the graph you wish to overlay, then click Open. You may 
choose up to eight files in this manner.

9. After selecting your files, click OK to return to the Report Options dialog.

10. Click Save if you wish to save your selections; you can still generate the overlays even if 
you do not wish to save them.
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11. Select Reports > Start Report; the Start Report dialog with the name of your edited file 
highlighted is displayed. 

12. Click Report; the Select Reports dialog is displayed. 

13. Ensure that the desired report is selected, then click OK.
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4.  SOFTWARE AND SETUP MODIFICATIONS

This chapter provides instructions for:

• Installing the software
• Using the Setup Program for other functions

You can also install the analysis program for offline data manipulation on a computer other 
than the one controlling the analyzer. This allows you to:

• create or edit sample and parameter files
• generate reports on completed sample files

Review the Micromeritics PROGRAM License Agreement for restrictions on the use of 
another copy of the analysis program.

Installing the Software

1. Insert the installation CD into the CD-ROM drive. The program automatically starts the 
installation.

If the installation does not immediately start, perform the following steps:

a.) Select Start from the Status bar, then Run from the Start menu.

b.) Enter the name of the drive designator, followed by setup. For example, if the CD-
ROM drive is drive e, enter:      e:setup

c.) Click OK. The Welcome screen displays.
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2. Click Next to continue the setup process.

Make sure the steps described on this screen are complete, then click Next.

3. On the Choose Users screen, select either of the following:

• Install for anyone using this computer - anyone who logs on to this computer will 
have access to the analyzer program.

• Install just for me - only the person logged onto the computer at the time of 
installation will have access to the analyzer program.

4. Click Next.

5. On the Choose Install Location screen, verify that enough disk space is available to 
continue the installation. If not, click Cancel and free up enough disk space. If the disk 
space is OK, click Browse to change the default installation location then click Next. Or 
click Next to accept the default directory of C:\ChemiSorb HTP.
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6. On the Choose Start Menu Folder screen, select a folder for the program shortcut. 

• Click Install to accept the default (Micromeritics), or
• Select another folder from the list and click Install, or
• Enter a new folder name in the text box, then click Install

7. The installation continues. When complete, the screen title changes to Installation 
Complete. Click Next on the next three screens. 

8. The Installation Complete screen displays the installed version and indicates the 
installation has finished. Click Finish to complete the process and close the screen.

9. Remove the CD from the CD-ROM drive and store in a safe place.

DIsk space required 
for installation.

DIsk space available 
for installation.
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Using the Setup Program for Other Functions

After initial installation of the analysis program, the application setup program can be used to:

• install software upgrades, page 4-5
• add an analyzer, page 4-6
• move an analyzer from one computer to another computer, page 4-8
• change the analyzer setup (port configuration), page 4-13
• remove an analyzer from the computer, page 4-12
• reinstall calibration files, page 4-15
• uninstall the analysis program, page 4-16

Starting the Setup Program

To start the setup program:

1. Ensure that the analysis program is not operating and the analyzer is idle.

1. Ensure that the analysis program is not operating and the analyzer is idle.

2. Insert the CD into your CD-ROM drive.

3. The Setup program starts automatically. 

If the program does not start automatically, enter the drive designator of the CD-ROM 
drive, followed by setup. For example: e:setup

Alternatively, you can click Browse, navigate to the CD-ROM drive, and select 
setup.exe.

4. The Welcome window is displayed. Click Next.

5. Select the task you want to perform, then click Next.
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Installing Software Updates or Reverting to a Previous Version

When you install a software upgrade, existing data files are not overwritten. There are three 
types of subsequent installations; the software version controlled by the setup program is:

• a later version than the version installed on the computer
• the same version as the version installed on the computer
• an earlier version than the version installed on the computer

The setup program automatically detects which type of installation applies and customizes the 
selection in the Setup dialog accordingly.

1. Start the Setup Program (refer to Starting the Setup Program, page 4-4).

2. Choose the software option (only the applicable option will display); it will be one of the 
following:

• Upgrade software to version (number) from version (number)
• Reinstall software version (number)
• Downgrade software to version (number) from version (number)

3. Click Start File Installation; the application installs the software and displays the setup 
Welcome dialog.

If the option Downgrade software to version (pervious number) displays, contact your 
Micromeritics representative before proceeding. Reverting to a previous version can 
damage existing sample files.
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Adding an Analyzer

An ethernet switch is required when connecting multiple analyzers. After connecting the eth-
ernet switch, continue with the software section.

Ethernet Switch

An Ethernet switch with an Ethernet cable is required when installing multiple analyzers.

1. Connect the power cord of the Ethernet switch to an appropriate power outlet.

2. Disconnect the ethernet cable of the current analyzer from the computer; do not 
disconnect it from the analyzer.

3. Connect one end of the Ethernet cable to the Ethernet switch and the other end to the 
computer.

4. Connect the ethernet cable of the current analyzer to a numbered port on the Ethernet 
switch (do not use the uplink port).

5. Connect one end of the Ethernet cable (for the analyzer you are adding) to the connector 
labeled Ethernet on the rear panel of the analyzer and the other end to a numbered port 
on the Ethernet switch. 

The finished configuration should look similar to the following illustration.  

6. Turn on the analyzer that was added. Also ensure that the computer and current analyzer 
are on.

Ethernet switch Be sure cables are not 
connected to the uplink port.
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Software

1. Start the Setup Program (refer to Starting the Setup Program, page 4-4).

2. Select Add an analyzer, click Next; the Set up analyzer being added dialog is displayed.

3. Enter the serial number of the analyzer being added.

4. Click Next. The following screen is displayed.

5. Click Finish.

You may see the Ethernet Introduction screen. This information is not applicable since 
you are connecting to an ethernet switch which is connected to a port that has been 
configured. Click OK to close the screen and proceed.
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Moving an Analyzer from One Computer to Another Computer

Use the instructions in this section to move a configured analyzer (along with its status, cali-
bration, and log file) from one computer (Source PC) to a different computer (Destination 
PC). This operation does not move sample or parameter files. Use a file management program 
such as Explorer or a backup/restore utility to move these types of files.

1. Start the application setup program on the Source computer. 

2. In the Setup dialog, select Move an analyzer from one PC to another PC, then click 
Next; the Move analyzer operation dialog is displayed. 

3. From the drop-down list, select the analyzer that is to be moved from this computer.

4. Click Next; the Move Analyzer dialog is displayed.

5. Click Browse to select a location for the program that will be created to install the 
software on another computer.
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6. Click Next; the files are moved to the install program and the following screen is 
displayed.

7. Click Finish.

8. Remove the CD from the CD-ROM drive.

9. Disconnect the ethernet cable from the Source computer and reconnect it to the 
configured ethernet port on the Destination computer.

If you are moving this analyzer to a computer that already has an analyzer attached, an 
ethernet switch is required (refer to Ethernet Switch, page 4-6 for instructions on 
attaching an ethernet switch).

10. If you saved the installation program to a network directory (Step 4), open the program. 
For example, Analyzer SN 111 Installer.exe.

If you saved the directory to a local directory, copy the Installer.exe file to a media device 
such as a USB stick, install it on the destination computer, then open the program.
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11. The Welcome dialog is displayed, click Next.

12. Click Next; the Ethernet Introduction dialog will be displayed if the network connection 
was not previously configured.
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13. Make sure the tasks described on the screen are completed, then click Next to display the 
Analyzer Installed dialog.

14. Click Finish.

Sample and parameter files are not copied and moved with the analyzer. Use a file 
management program such as Explorer or a backup/restore utility to move these 
files.
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Removing an Analyzer

You can remove an analyzer from the computer as follows. 

1. Start the Setup Program (refer to Starting the Setup Program, page 4-4).

2. Select Remove an analyzer, then click Next; the Remove an analyzer dialog is 
displayed.

3. From the drop-down list, choose the serial number of the analyzer you want to remove.

4. Click Next; the following screen is displayed.

5. Click Finish.

This operation removes the selected instrument from the list of attached instruments. 
It does not remove calibration and status files associated with the analyzer, nor does it 
remove sample and parameter data files.
4-12                                                      248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01



ChemiSorb HTP Using the Setup Program for Other Functions
Changing the Analyzer Setup Configuration

This option allows you to change the ethernet port being used by the analyzer(s). For example 
if the current ethernet port malfunctions, you would use this option to move the analyzer to 
another ethernet port.

Be sure that the ethernet port you are switching to has been configured; refer to Configuring 
an Ethernet Port, page D-1.

1. Start the Setup Program (refer to Starting the Setup Program, page 4-4).

2. Select Change analyzer setup, then click Next; the Ethernet Introduction screen is 
displayed. This screen outlines the steps that should be completed to configure the 
ethernet port to which the analyzer will be connected. 

• Select the desired ethernet port from the list of available port, click Next, and proceed to 
Step 4, or

• If an Ethernet configuration has not been detected, click Specify.
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3. Enter the Ethernet port, then click Next.

4. The Analyzer Configuration Updated dialog is displayed.

5. Click Finish.
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Reinstalling Calibration Files

Calibration files specific to the analyzer are contained on the original program CD; they are 
not contained on an update CD. It is important that you store your original program CD in a 
safe location. CDs containing calibration files will always end with a suffix of 99. Update CDs 
end with a suffix of 00.

Reinstall calibration files as follows:

1. Start the Setup Program (refer to Starting the Setup Program, page 4-4).

2. Select Re-install calibration files for an analyzer, then click Next: 

If .... Then ....

you have only one 
analyzer installed

the calibration files are installed and the Finish screen is 
displayed.

you have multiple ana-
lyzers installed, a 
dialog enabling you to 
choose the desired 
analyzer is displayed.

select the appropriate analyzer, then click Next; the cali-
bration files are installed and the Finish screen is 
displayed.
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Uninstalling the Analysis Program

When you uninstall the ChemiSorb program, the application removes the analysis program, 
status files, analyzer setup files, and resulting empty directories. It does not remove data files. 
Perform the following steps to uninstall the program:

1. Locate the Uninstall.exe file in the directory where the DataMaster files are located.

2. Double click the Uninstall.exe file and click Uninstall to start the uninstall process.

3. Select Uninstall, then click Next; the Uninstall dialog is displayed.

4. The uninstall process continues and the Uninstallation Complete screen displays. Click 
Next to finish the process. 
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5. The computer must be rebooted to complete the uninstallation process. Select:

• Reboot now - to immediately restart the computer, then click Finish, or

• I want to manually reboot later - to restart the computer later, then click Finish.
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5.  FILE MENU

This chapter describes the file maintenance options used to create, edit, print, list, and export 
sample and parameter files.

Description

Listed below are brief descriptions of the commands on the File menu. Detailed descriptions 
follow this section.

Open Allows you to create a new sample or parameter file, or open 
an existing one. Page 5-3.

Save Saves the file in the active window. Page 5-44.

Save As Allows you to save the file in the active window under a new 
name. It can also be used to save a subset of a sample file as a 
parameter set. Page 5-44.

Save All Saves all open files. Page 5-44.

Close Closes the file in the active window. Page 5-44.

Close All Closes all open files. Page 5-44.

Print Prints the contents of one or more files. Page 5-45.
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List Generates a list of certain information for specified sample or 
parameter files. Page 5-47.

Export Exports isotherm data from a sample information file in the 
selected format. Page 5-48.

Exit Exits the ChemiSorb program. Page 5-51.
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Open

Open enables you to create a new or open an existing sample or parameter file.

Select the desired file type; a dialog similar to the following is displayed:

Files list This list contains the files located in the current directory.  

File name For sample information files, this field contains the next 
sequenced file name (as specified in sample defaults) 
generated by the system. 

For parameter files, the name includes the wild card (*) and 
the default extension as follows:

*.ANC for analysis conditions
*.RPO for report options

If you are creating a file, enter a name in the File name field.  

If you are opening an existing file, select the desired file  
from the list, then click Open. Use the Ctrl key to select 
multiple files; hold down the key while selecting the files.
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Sample Information

A Sample information file contains data that guide the analysis; it consists of:

• sample information
• analysis conditions
• report options
• collected (after analysis) or manually entered data

Parts of the sample information file can also exist as standalone parameter files. Having these 
files exist independently allows you to use them as many times as you wish. For example, if 
you typically use the same analysis conditions for many of your analyses, you can create an 
analysis conditions file containing the desired conditions. Then when you create your sample 
file, select that file for your analysis conditions; the values are copied into the sample file. 
After it becomes part of the new sample file, you can edit it in any way you wish. The file from 
which the values were copied remains intact and ready for the next use.

Sample information files can be created and presented in the Advanced, Basic, or Restricted 
format. 

• Advanced
Presents all parts of the sample information file in a tabbed dialog. Each tab opens its 
associated dialog, allowing you to edit conditions.

• Basic
Presents all parts of the sample information file as a single dialog. This format allows 
you to create quickly a sample information file using predefined parameter files. You 
can also switch to the Advanced format if desired.

• Restricted
Identical to the Basic format except that you cannot switch to the Advanced format for 
editing. Certain functions also are disabled.
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Advanced Format

The Advanced format of a sample information file displays all parts of the sample file in a 
tabbed dialog. Quick-access tabs enable you to move quickly and easily among the 
parameters.

Refer to Advanced Format, page 3-8 for step-by-step instructions for creating a Basic sample 
information file.

Sample Displays the default file description for a new file or the 
description of the file you are opening. 

You can enter a new description or edit the existing one if 
desired.

Operator
Submitter

Displays the operator and submitter names in the current 
sample file.

If this is a new file, these fields contain the names specified in 
Sample Defaults. 

You can enter a different name or edit the current one. 
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Operator
Submitter
(continued)

These fields can be omitted or changed to display a different 
label if desired. Refer to Sample Defaults, page 8-6 for 
additional information.

Bar Code This field enables you to enter bar code information. If bar 
code information is not used, you can use this field to enter 
additional information about the sample; for example, you 
may wish to enter the lot number of your sample. This field 
can be omitted in Sample Defaults if it is not needed.

This field, as well as the Operator and Submitter fields, 
will accept data from a bar code reader.

Mass You can enter a sample mass or have the mass calculated 
automatically.

Enter the sample’s mass. If you are using a Sample Data 
Worksheet, enter the value recorded as Mass of Sample 
After Degas.

The value entered for Mass is used in report calculations; 
therefore, it should be exact. To ensure accuracy, reweigh the 
sample after analysis. If the value is not equal (or very close) 
to the one entered previously for Mass, you may want to 
change the value after analysis.

Enter Enables the Sample Mass field allowing you to enter a value.

Calculate Enables the Empty tube and Sample + tube fields, allowing 
you to enter appropriate values. These values are used to cal-
culate the mass of the sample, 

               

Refer to Determining the Sample Mass, page 3-14 for addi-
tional information.

Type of Data Displays the type of data for the current sample file. If this is 
a new file, choose Automatically collected to have data 
collected automatically, or Manually entered if you plan to 
enter data collected from another source. An Entered tab is 
added to the sample information dialog for entering the 
values.

Masssample Masssample tube+ Masstube–=
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Comments Allows you to enter pertinent information about the sample 
or analysis. The information you enter in this window is 
displayed in the report header.

Add Log Entry Displays the Add Log Entry dialog.

Use this dialog to enter information pertinent to the sample 
file. Any information you enter here is printed as part of the 
sample log report. You may make multiple entries by 
selecting this push button as many times as you wish.

Replace All Use this button to replace the values of all parameters of the 
current file with those from an existing one. You can edit the 
values after they have been copied into the current file; 
editing the current files will not affect the file from which 
they were copied.

Save Saves all parameters of the current file; the dialog remains 
open.

Close Closes the dialog. If the dialog contains changes that have not 
been saved, you will be prompted to save them before the 
dialog closes.

Advanced Drop-down list that enables you to switch the sample editor 
to the Basic format.

Preview Prints the reports selected on the Reports Options dialog.

This option is disabled for sample files that have not been 
used in an analysis. 
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Basic Format

The Basic format displays all parts (parameters) of the file on a single dialog. With this format, 
you can quickly create a sample information file using predefined parameter files. This format 
also allows you to switch to the Advanced format to view or edit parameters.

Refer to Basic and Restricted Formats, page 3-10 for step-by-step instructions for creating a 
Basic sample information file.

Sample Displays the default file description (new files) or the 
description in the file you are opening. If a dollar ($) symbol 
was included in sample defaults, the next sequenced file 
number will also display (as shown in the above example).

You may enter a new description or edit the existing one.
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Operator Displays the operator name in the current sample file.

If this is a new file, this field contains the name specified in 
Sample Defaults. 

You can enter a different name or edit the current one if 
desired. 

This field can be omitted or changed to display a different 
label if desired. Refer to Sample Defaults, page 8-6 for 
additional information.

Mass You can enter a sample mass or have the mass calculated 
automatically.

Enter Enables the Sample Mass field allowing you to enter a value.

Calculate Enables the Empty tube and Sample + tube fields, allowing 
you to enter appropriate values. These values are used to cal-
culate the mass of the sample. 

               

Refer to Determining the Sample Mass, page 3-14 for addi-
tional information.

Analysis Conditions
Report Options

Each parameter field contains the description of the current 
parameter file.

If this is a new sample file, these fields contain the descrip-
tions of the files chosen as the defaults.

Click on the down arrow to the right of each field to choose a 
different file. File parameters can be viewed or edited by 
switching to the Advanced format.

Masssample Masssample tube+ Masstube–=
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Add Log Entry Displays the Add Log Entry dialog.

Use this dialog to enter information pertinent to the sample 
file. Any information you enter here is printed as part of the 
sample log report. You may make multiple entries by 
selecting this push button as many times as you wish. 

Replace all Use this push button to replace all parameters of the current 
file with those copied from an existing one. A dialog box is 
displayed allowing you to choose the desired file.

Save Saves all parameters of the current file; the dialog remains 
open.

Close Closes the dialog.

Basic Drop-down list that enables you to switch the sample editor 
to the Advanced format.

Preview Prints the reports selected on the Reports Options dialog. 

This option is disabled for sample files that have not been 
used in an analysis. 
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Restricted Format

A third format is provided to control access to some portions of the sample information file. 
The Restricted format displays in the same manner as the Basic presentation format.

The fields on this dialog are identical to the ones on the Basic Information dialog except that 
this dialog does not allow you to switch to the Advanced format. This format is also password-
protected, preventing the operator from making changes to file parameters. Refer to 
Restricted, page 8-5 for additional information on the Restricted format.

Restricted presentation is ideal for laboratories in which standard analysis procedures are 
established by a lab manager, while one or more lab technicians actually perform the analyses. 
The lab manager can create independent parameters files containing standard sets of operating 
conditions, then the operator can use Restricted mode for daily operations, selecting the stan-
dard parameter files from the drop-down lists.

This dialog is identical to the 
Basic dialog except that it does 
not allow you to switch to the 
Advanced format.
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Analysis Conditions 

Analysis conditions specify the data, or tasks, used to guide the analysis. This section 
describes the analysis conditions options available on the ChemiSorb system. An analysis con-
ditions file may exist as an independent file or as part of the sample information file.

Refer to Analysis Conditions, page 3-6 for step-by-step instructions on creating analysis con-
ditions files.

Description Contains the description of the current Analysis conditions 
file.

If this is a new file, this field contains the identification spec-
ified in Sample Defaults. You can edit this name if desired.

Replace Use this push button to replace the values of the current file 
with those of another; a dialog allowing you to choose the 
desired file is displayed. After the values are copied into the 
current file, you can edit them in any way desired.

Selected Tasks This window lists the tasks selected for the analysis. Tasks 
are inserted using the Insert push button.

You can include up to 20 tasks.
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Insert Displays the Select a Task dialog enabling you to insert 
analysis tasks in the Selected Task list.

An analysis is defined by the tasks from which it is com-
prised. Tasks are executed in the order in which they are 
sequenced. You do not have to include all the tasks in an 
experiment. 

You may insert only one Analysis task; other tasks can be 
inserted as desired.

Select a task and click Insert to specify task parameters. 
Refer to Analysis Tasks, page 5-15 for details on task 
descriptions.

Delete Removes the selected (highlighted) task.

Edit Displays a dialog pertinent to the selected (highlighted) task, 
allowing you to view or edit the values.

In the Analysis Conditions portion of a sample file with an 
Analyzing or Complete status, this button displays as View; 
allowing you to view parameters but editing is not allowed.

Clear Clears the Selected Tasks list of all tasks.

Step Detail Shows details of the selected task without having to open the 
associated dialog.

Backfill gas Allows you to choose a gas for backfilling the sample tube 
prior to evacuation. Make sure the gas selected is either the 
one used in the previous task or helium. 
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Match transducer at start Enables you to match the port and analysis transducers before 
analysis begins. In a sequence analysis, this will apply only to 
the first analysis on a port. 

Analysis Termination 
group box

The options in this group box are enabled when you choose 
Automatically collected as the type of data on the Sample 
Information dialog. These options enable you to specify 
analysis conditions for termination of the analysis.

Cool to less than 50 ºC 
(323 K)

Select this option to cool the sample to a temperature less 
than 50 ºC (323 K) before the analysis terminates.

In a sequence analysis, Cool to less than 50 ºC will apply 
only for the last temperature-controlled analysis on a port.

Backfill sample tube Select this option to have the sample tube backfilled. Use the 
Backfill gas option (explained on the previous page) to 
choose the gas.

In a sequence analysis, Backfill sample tube applies only for 
the last temperature-controlled analysis on a port.

Disable temperature control Allows you to manually control the temperature for each 
stage of the analysis. 

Manually Entered 
Analysis Data

The options in this group box are enabled when you choose 
Manually entered as the type of data on the Sample 
Information dialog. These options enable you to enter   
analysis conditions. 

Adsorptive Choose the adsorptive used in the experiment which 
produced the data. Gases available in this list are those 
specified in the Gas Table Defaults dialog. Refer to Gas 
Defaults / MFC Constants, page 8-14 for more information. 

Temperature Enter the temperature at which the analysis was performed.

Free space Enter the free-space volume determined in the analysis.
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Analysis Tasks

Evacuation

To ensure safe operation and reliable results, you should include an evacuation task under the 
following conditions:

• Between tasks using different gases
• Preceding a leak test
• Preceding an analysis

If an evacuation is not inserted as specified above, a warning is displayed.

All fields on this dialog are disabled during analysis or if the sample file has a Complete status.

Evacuation The options in this group box allow you to specify conditions 
during evacuation. 

Evacuation rate Enter a rate at which evacuation is to occur.

Unrestricted evac
pressure 

This value represents the pressure at which unrestricted 
sample evacuation begins.

Evacuate for __ below __ Enter the number of minutes and pressure for preliminary 
evacuation. 
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Flow

Temperature The options in this group box allow you to choose 
temperature options during evacuation. These options are 
disabled during analysis or if the analysis is complete.

Enter the temperature during evacuation in the Temperature 
field.

Enter the rate at which you wish the temperature to change 
(ramp rate) in the Rate field.

Gas Enables you to choose a gas for the Flow task. Do not use 
ammonia for this task.

The gases in this drop-down list are those specified in the Gas 
Table Defaults dialog. Refer to Gas Defaults / MFC 
Constants, page 8-14 for information on changing or adding 
gases.

The MFC contains Viton which may swell and cause erratic MFC control. Please 
contact you Micromeritics representative if flowing NH3 is required during the 
preparation and activation of your sample.

Flow rate
Enter the rate at which to flow gas.

Temperature Enter the temperature at which the gas is to start flowing. 

Rate Enter the rate at which the temperature is to change (ramp 
rate) while advancing to the target temperature.

Time Enter the duration of time the sample is to remain at the 
specified temperature.
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Leak Test

Temperature Enter the target temperature desired during the leak test.

Heat rate Enter the rate at which the temperature is to change (ramp 
rate) while advancing to the target temperature.

Outgas rate Entry in this field allows a system check for tasks or sample 
outgassing before the analysis. The leak test allows sample 
pressure to rise during the test. If the pressure rises more 
than the value in this field, the analysis proceeds but you are 
notified with an error message. The default of 10 mHg is 
recommended.

The results of the leak test are printed in the Options Report. 
Leak testing slightly increases analysis time, but it allows 
the program to notify you of any analyses which may 
contain erroneous results.
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Soak

Gas Enables you to choose a gas for the Soak task. Gases 
available are those specified in the Gas Table Defaults dialog. 
Refer to Gas Defaults / MFC Constants, page 8-14 for 
information on changing or adding gases.

Temperature Enter the temperature at which soaking is to begin.

Rate Enter the rate at which the temperature is to change while 
advancing to the target temperature.

Time Enter the duration of time the sample is to soak at the 
specified temperature.

Minimum pressure Enter the minimum pressure to which the sample is to be 
exposed during soaking.
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Analysis

You can include only one Analysis task in the Task list.

All fields on this dialog, as well as on the subdialogs accessed using the push buttons, are dis-
abled for sample files that have a Complete status.

Adsorptive This drop-down list allows you to select an adsorptive gas for 
the analysis. The gases listed are those specified in the Gas 
Table Defaults dialog. Refer to Gas Defaults / MFC 
Constants, page 8-14 for additional information on 
specifying adsorptive gases.

Temperature The options in this group box enable you to specify 
temperature parameters for the analysis. These options are 
disabled during analysis.

Enter the analysis temperature in the Temperature field and 
the rate at which the temperature changes in the Rate field.

Dosing This group box enables you to specify conditions for dosing 
the sample.
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Relative target 
tolerance 

Absolute target 
tolerance

The values in these fields are used to determine how close the 
actual pressure must be to each target pressure from the pres-
sure table. At lower pressures the relative tolerance value is 
smaller, and at higher pressures the absolute tolerance value 
is smaller.

For example, with relative tolerance = 5% and absolute toler-
ance = 5 mmHg, the relative tolerance at 40 mmHg target 
pressure is 5% of 40 mmHg, or 2 mmHg; 2 mmHg is smaller 
than the absolute tolerance of 5 mmHg, so 2 mmHg is used. 
At 200 mmHg target pressure, the relative tolerance is 5% of 
200 mmHg, or 10 mmHg; in this case, the absolute tolerance 
of 5 mmHg is smaller and is used.

In the above example, a minimum pressure of 40 - 2 = 38 
mmHg must be attained to collect data for a target pressure of 
40 mmHg. For a target of 200 mmHg, 200 - 5 = 195 mmHg 
must be attained.

Maximum volume 
increment

Select this option to determine when additional data points 
are collected between target pressures in regions of 
adsorption. When the maximum increment has been adsorbed 
since the last collected data point, another point is 
equilibrated and collected.

Low-pressure 
incremental dose mode

Select this option to dose the sample successively with a 
specified amount of gas until the first pressure point is 
reached. Because the data points recorded during Incremental 
Dose Mode may define most of the analysis, one point on the 
pressure table can be sufficient and serve as the end point for 
the analysis. This mode measures equilibrium points at 
approximately equal intervals on the volume adsorbed axis. 
Each dose is fully equilibrated and recorded as a data point.

     Dose amount Enabled when you select Low-pressure incremental dose 
mode, allowing you to specify the amount of gas to be added 
to the sample for each data point until the first point on the 
pressure table is reached.

Tight tolerance may lengthen the analysis.
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Repeat The options in this group box allow you to specify conditions 
for a repeat analysis.

Repeat analysis Select this option to repeat the analysis. The initial analysis 
measures chemisorption and physisorption activity. The 
repeat analysis measures only physisorption activity. The 
difference between the initial and repeat analysis is the strong 
chemisorption activity of the sample.

Evacuation rate Enter a rate for evacuation. A rate of 25 to 50 is sufficient for 
most samples. 

Unrestricted evac
pressure 

This value represents the pressure at which unrestricted 
sample evacuation begins.

Evacuate __ below __ Enter the number of minutes for preliminary evacuation. 
Preliminary evacuation takes place prior to the free-space 
measurement. 

Pressure Displays the Pressure Table dialog so that you may create or 
edit a pressure table. 

A pressure table is a table of pressure points at which data are 
to be collected. The pressures may span the entire range from 
the lowest absolute value of 0.050 to the maximum value of 
900 mmHg.

These points are used for the first analysis and the repeat 
analysis (if selected); however, the low-pressure dose does 
not apply for the repeat analysis.
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Pressure
(continued)

Several analysis conditions files are included with the Chemi-
Sorb software. You can load one of these files into your file 
using the Replace push button as a starting point if desired. 
Edit the values as appropriate for your analysis.

The pressure table for automatically collected data includes 
the pressure points for data collection and identifies which 
points are used in reports.

The pressure table must contain a sequence of strictly ascend-
ing absolute pressures. You can enter a maximum of five 
hundred pressure points.

Use the check boxes to have the pressure points included in 
the desired reports.

Insert Inserts a row above the selected one.

Delete Deletes the selected row.

Clear Removes all but one entry from the table; one entry is 
required. A warning message appears requesting 
confirmation before the table is cleared.

Append Adds a row at the end of the table.
5-22                                                      248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01



ChemiSorb HTP Open
Equilibration Displays the Equilibration dialog.

The table contains a list of absolute pressures and 
equilibration intervals. 

     Equilibration Interval The number of seconds between successive pressure readings 
during equilibration. Long equilibration intervals tend to 
lengthen analyses, however, they do improve data integrity. 
Short equilibration intervals produce a faster analysis but 
may reduce the accuracy of data.

     Insert Inserts a row above the selected one.

     Delete Deletes the selected row.

     Clear Removes all but one required entry from the table. The rows 
do no have to be selected. A warning message appears 
requesting confirmation before the table is cleared.

Append Adds a row to the end of the table.
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Free Space Displays the Free Space Options dialog so that you can 
specify free-space measurement conditions. 

Measure Select this option to have free space measured automatically 
by the system at the end of analysis. The radio button is 
disabled during analysis. It is also disabled when analysis is 
complete if free space was not measured during analysis. 

Evacuation rate
Enter the evacuation rate.

Unrestricted evac pressure
Enter the pressure at which unrestricted sample evacuation is 
to begin.

Evacuate for __ minutes below __
Enter the number of minutes for preliminary evacuation. 
Preliminary evacuation takes place prior to the free-space 
measurement.

Estimated free space
Enter the gas capacity of the sample tube. It is important to 
provide a reasonable estimate in the field. In most cases, 20 
to 25 is appropriate.

Enter Select this option to enter free space manually. This option 
may be necessary if the sample retains helium, and 
measurement of pressures below 0.1 mmHg is required. (The 
radio button is disabled during analysis.) 
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Report Options

Report options specify the types of reports generated from an analysis or manually entered 
data. They also help you customize details of reports such as axis scale, axis range, and col-
umn headings. A report options file may be created as an independent file, or as part of a 
sample information file.

Refer to Report Options, page 3-7 for step-by-step instructions on creating report options 
files.

Description Contains the description of the current Report Options file.

If this is a new file, this field contains the description you 
specified as the default. You can enter a new description or 
add to the existing one if desired.

Replace Allows you to replace the values in the current report options 
file with those from an existing file. A dialog is displayed so 
that you may select the desired file. Select the file, click 
Replace, and the values are copied into the current file 
automatically. You can edit the values in the new file; it will 
not change anything in the file from which they were copied.
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Selected Reports Lists the available reports. Click the check box to the left of 
the report to select it; a check mark is placed in the box when 
selected.

The following reports are available:

• Isotherm
• Difference Method
• Sinfelt Method
• Langmuir Surface Area
• Freundlich
• Temkin
• Options
• Sample Log

Edit Displays an associated dialog for the selected report. Editing 
options for available reports are shown in the subsequent 
sections. 

This button is disabled for the Options and Sample Log 
reports.

Overlays Displays the Graph Overlay Samples dialog so that you can 
choose the sample files you wish to use in the overlay 
function.

Click Browse to the right of each field to choose the desired 
file; you may choose up to eight files.

Use Clear to clear the field of its entry.
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Active Metals Displays the Active Metals Table Options dialog allowing 
you to specify the characteristics of up to fifteen elements 
used in your analysis.

Element This column displays the active metals specified in the 
Active Metals Table Defaults dialog (Options menu). This 
list can be customized using the defaults dialog. Refer to 
Appendix E, page E-1 for a list of metals. 

Atomic Weight The atomic weight of the element.

Atomic Cross. Sect. Area 
(nm2)

The atomic cross-sectional area of the element.

Density (g/cm3) Lists the element’s density.

% of Sample Weight Enables you to enter the percentage of the element contained 
in your sample. 

If the composition is specified as a pure metal, X=1 and Y=0 
for MxOy - the % of sample is for a pure metal. If a metal 
oxide composition is specified, Y > 0 - the % sample is based 
upon a metal oxide.

% Reduced The percent of metal reduced during preparation.

MxOy, X The number of metal atoms in the oxide.
 248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01                                       5-27 



Open ChemiSorb HTP
MxOy, Y The number of oxygen atoms in the oxide.

Adsorptive Use this push button to specify the stoichiometry factors for 
each adsorptive associated with a selected element. The 
adsorptives and stoichiometry factors for the selected element 
are displayed.

Adsorptive
Gases available are those specified in the Gas Table Defaults 
dialog. Refer to Gas Defaults / MFC Constants, page 8-14 
for additional information.

Stoichiometry Factor
A factor which expresses the ratio between the number of 
active metal molecules and the number of adsorbate 
molecules.

Insert Inserts a row above the selected one, allowing you to enter a 
new element. 

Delete Deletes the selected row.

Clear Removes all but one entry from the table; one entry is 
required. A confirmation query is displayed before the table 
is cleared.

Append Adds a row at the end of the table, allowing you to enter a 
new element. 
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Apply thermal 
transpiration correction

Select this option to correct for the temperature-induced 
pressure difference between the manifold and the sample 
tube. This option is most significant for pressures less than 
approximately 1.0 mmHg. 

Inside diameter of 
sample tube or 
filler rod

Enabled when you select Apply thermal transpiration 
correction, so that you may enter the inside diameter of the 
sample tube or filler rod.

Show report title Select this option to have a title display on your report; the 
adjacent field is enabled allowing you to enter the title. You 
can use up to 50 characters in this field.

If this is a new file, the title you specified as the default is dis-
played. Accept the default title or enter a different one. 

If you deselect this option, a title will not display on your 
report(s).

Show graphic Select this option to have an illustration display above the 
report title. For example, you may wish to display your 
company logo. You can use a bitmap (bmp) or an enhanced 
metafile (emf).

Click Browse to choose the graphic, then enter the height 
and width in the appropriate fields. This image can also be 
edited from the report window.
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Isotherm Report Options

The isotherm report indicates adsorption of a gas by a solid held at constant temperature. 

Print tabular report Select this option to have collected data printed in a tabular 
format.

Plot data Select this option to have data plotted as a graph. 

Analysis Includes an isotherm plot for the primary analysis. 

Repeat analysis Includes an isotherm plot for a repeat analysis. 

Overlay samples Select this option to overlay the current plot with those of 
other samples. Click Overlays on the Report Options dialog 
to choose the sample files.

Plot curve 
Plot points

Use these options to specify in which manner to have the data 
plotted. You can plot data as a curve, points, or both.

X-Axis Scale Enables you to have the x-axis displayed on a logarithmic or 
linear scale.
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Autoscale Options Select Autoscale to have the X- and/or Y-axes automatically 
scaled. Linear X-axes begin at zero, and logarithmic X-axes 
begin at an appropriate value. Y-axes begin at zero. The 
system uses the highest values collected during analysis as 
the ending points for axes ranges. 

From/To fields Enabled when you choose not (deselect) to AutoScale, 
allowing you to specify beginning and ending values for the 
X- and Y-axis ranges. Data collected outside these ranges are 
not included in the plot.

The value entered in the To field must be greater than the 
value entered in the From field.

The X-Axis Range fields show the pressure.

The Y-Axis Range fields show the quantity of gas adsorbed.
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Difference Method Report Options

The Difference Method report consists of a summary page, a tabular report, and a line fit plot.

Print analysis summary Select this option to print a summary of analysis difference 
results. 

Show Analysis results generates a summary of the following 
for the first analysis:

• Percent metal dispersion
• Metallic surface area
• Volume adsorbed
• Slope
• Correlation coefficient

Show difference results generates a summary of the differ-
ences between the following information for the first and 
repeat analyses:

• Percent metal dispersion
• Metallic surface area
• Average difference volume

Print tabular report Select to have analysis data printed in a tabular format.

Plot Data Select this option to produce a graph showing the line fit 
difference between the analysis and repeat analysis. 
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Analysis Includes a line fit plot for the primary analysis. 

Repeat analysis Includes a line fit plot for the secondary analysis. 

Difference Plots the difference between the analysis and repeat analysis 
lines.

Plot curve 
Plot points

Use these options to specify the manner in which to have  
data plotted. You can plot data as a curve, points, or both.

Overlay samples Allows you to overlay data from the current sample with that 
of other samples. Click Overlays on the Report Options 
dialog to choose the other sample files.

Crystallite size Allows you to specify the crystallite shape of your sample, or 
to enter one.

Autoscale Options Select these options to have the X- and/or Y-axes 
automatically scaled. The system uses the highest values 
collected during analysis as the ending points for an axis 
range.

Axis Range These fields are enabled if you deselect AutoScale, allowing 
you to specify beginning and ending values for the X- and Y-
axis ranges. Data collected outside these ranges are not 
included in the plot.

The X-Axis Range fields show the pressure.

The Y-Axis Range fields show the quantity of gas adsorbed.

Valid ranges for these fields are shown in the information bar 
across the bottom of the dialog.
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Sinfelt Method Report Options

The fields on this screen are the same as the Difference Method report (refer to page 5-32) 
with one additional option. Under Analysis summary, you can select to Show repeat results.
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Langmuir Surface Area Report

Calculation Options Enables you to choose the data to include in calculations.

Tabular report Select this option to have a tabular report of the plotted data.

Transform plot Generates a traditional Langmuir surface area plot that is 
used to determine monolayer volume.

Langmuir isotherm plot Uses the Langmuir monolayer volume and constant to 
produce an isotherm.

Overlay samples Select this option to overlay the current type plot with those 
of other samples. Click Overlays on the Report Options 
dialog to choose the other sample files.

Autoscale Options Select these options to have the X- and/or Y-axes automati-
cally scaled. The system uses the highest values collected 
during analysis as the ending points for an axis range.
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Freundlich Report

The Freundlich isotherm is an empirical isotherm that is used to model low-pressure adsorp-
tion data. It can also be applied to model some micropore isotherms.

From/To These fields are enabled when you choose not (deselect) to 
Autoscale, allowing you to specify beginning and ending 
values for the X- and Y-axis ranges. Data collected outside 
these ranges are not included in the plot.

The X-Axis Range fields show the pressure.

The Y-Axis Range fields show the quantity of gas adsorbed.

Valid ranges for these fields are shown in the information bar 
across the bottom of the dialog.

Specify the monolayer 
capacity

In this field, enter the monolayer capacity of the sample.

Calculation Options Enables you to choose the data to include in calculations.

Tabular report Select this option to have a tabular report of the pressure 
points generated.
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Transform plot Plots the linear form of the Freundlich equation.

Freundlich Isotherm plot Plots the absolute pressure vs quantity adsorbed. Shows best 
fit line.

Overlay samples Choose this option to overlay data from the current file with 
the same type of data from other samples (files). Click Over-
lays on the Report Options dialog to choose the other files.

Autoscale Options Select these options to have the X- and/or Y-axes 
automatically scaled. The system uses the highest values 
collected during analysis as the ending points for an axis 
range.

From/To These fields are enabled if you choose not (deselect) to 
AutoScale, allowing you to specify beginning and ending 
values for the X- and Y-axis ranges. Data collected outside 
these ranges are not included in the plot.

The X-Axis Range fields show the pressure.

The Y-Axis Range fields show the quantity of gas adsorbed.

Valid ranges for these fields are shown in the information bar 
across the bottom of the dialog.
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Temkin Report

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops lin-
early with increasing coverage.

Specify monolayer capacity In this field, enter the monolayer capacity of the sample.

Calculation Options Enables you to choose the data to include in calculations.

Specify differential heat of 
adsorption at zero surface 
coverage

Enter the differential heat of adsorption at zero surface 
coverage. This allows inclusion of all Temkin constants.

Tabular report Select this option to have a tabular report of the pressure 
points generated.

Transform plot Plots a linear form of the Temkin isotherm.

Temkin Isotherm plot Overlays the Temkin isotherm with analysis data.
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Overlay samples Choose this option to overlay data from the current file with 
the same type of data from other samples (files). Click 
Overlays on the Report Options dialog to choose the other 
files.

Autoscale Options Select these options to have the X- and/or Y-axes 
automatically scaled. The system uses the highest values 
collected during analysis as the ending points for an axis 
range.

From/To These fields are enabled if you choose not (deselect) to 
AutoScale, allowing you to specify beginning and ending 
values for the X- and Y-axis ranges. Data collected outside 
these ranges are not included in the plot.

The X-Axis Range fields show the pressure.

The Y-Axis Range fields show the quantity of gas adsorbed.

Valid ranges for these fields are shown in the information bar 
across the bottom of the dialog.
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Options Report

The Options Report is a predefined collection of sample information file parameters printed by 
selecting Options from the Report Options dialog. You cannot edit this report.

If Type of Data is Automatically collected, the following information appears on the report:

Redundant data appear in the Task Summary and the Experiment Log if the instrument is 
performing correctly.

If Type of Data is Manually entered, only the adsorptive gas, sample temperature, and free-
space volume are reported.

Sample Log

The Sample Log report provides the following statistics:

• manual control operations performed during analysis
• information entered using on the sample file editor
• warnings and/or errors that occurred during analysis

Task Summary Lists conditions you specified for each task selected.

Analysis Task Options Details conditions you specified for the analysis task.

Experiment Log Identifies actual conditions under which each task transpired.

Leak Test Results Identifies outgas rates and the outcome for each leak test 
performed.
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Collected/Entered Data

If you select Manually Entered on the Advanced view of the Sample information dialog, an 
Entered tab is added enabling you to enter the data. 

If you select Automatically collected, a Collected tab is added after the analysis is com-
pleted. This dialog contains the data points collected during analysis and the specified 
calculation assignments. You can edit calculation assignments during or after an analysis.
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Pressure table For collected data, columns for the following are displayed:

• pressure
• quantity adsorbed
• repeat pressure
• quantity adsorbed (for repeat pressure)
• calculation assignments for each requested report option 

For entered data, columns for the following are displayed:

• pressure
• quantity adsorbed
• repeat pressure
• quantity adsorbed (for repeat pressure)
• report assignments

Insert Enabled for entered data. Inserts a row above the selected 
row.
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Delete Enabled for entered data. Deletes the selected row.

Clear Enabled for entered data. Clears the table of all but one entry; 
one is required.

Append Enabled for entered data. Adds a row at the end of the table.

Free Space Displays the Free Space dialog, allowing you to edit free-
space values.

This dialog also shows the isotherm for the analysis. The 
isotherm is redrawn each time values are edited.

You can also customize parts of the isotherm plot, as well as 
zoom in for finer detail. Right-click in the graph area to 
display a shortcut menu displaying the options available. 
Refer to Shortcut Menus, page 7-13. 

Measured Displays the measured free space if Measured was chosen as 
the Free-space method for the analysis; these values cannot 
be edited.

Entered Enables you to enter a free-space value.
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Save

Save enables you to save the file in the active window under its current name. The Save push 
button at the bottom of the main dialogs performs the same function.

Save As

Save As enables you to:

• save a sample or parameter file in the active window under a different name. This 
option is useful for making a duplicate copy of a file that you can modify as desired 
without changing the original one. 

• save a subset (parameter) of the sample file in the active window as a standalone 
parameter file. For example, select Analysis Conditions from the Save As menu to 
create a standalone parameter file of the analysis conditions portion of the active sample 
file.

Save All

Save All enables you to save all open files under their current names. This option provides a 
faster way to save all open files at one time and avoids having to perform a Save operation on 
each individual file. 

Close

Close enables you to close the file in the active window. 

You will be prompted to save before closing if the file contains changes that have not been 
saved.

Close All

Close All enables you to close all active files at one time. You will be prompted to save before 
closing for each file containing changes that have not been saved.
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Print

Print enables you to print the contents of one or more sample or parameter files to the screen, a 
printer, or a file. For example, if you choose to print the contents of an Analysis Conditions 
file, you will receive the parameters used for all analysis conditions associated with the file(s). 
The print dialog is common to all file types.

Select the desired file type from the drop-down menu; a dialog similar to the following is 
displayed:

Files list This list contains the files located in the current directory.  

File name The name of the file you select from the Files list is copied to 
this field. 
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Open This button displays the Report Settings dialog.

• Preview: prints file contents to the screen.

• Print: prints file contents to the default printer. The 
Copies field is enabled allowing you to print up to 10 
copies. 

• File: prints file contents to a file. Enter a name in the 
File name field and select one of the following file 
types from the drop-down list: 

rep: system report which can be opened using the 
Open Report command on the Reports menu.

xls: spreadsheet format

txt: text file
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List

List enables you to display the following information on one or more sample or parameter 
files:

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status

The List dialog is common to all file types. 

The behavior of the List dialog is the same as the Print dialog; refer to Print, page 5-45 for an 
explanation of the fields on this dialog. 
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Export

Export copies the isotherm data in sample information files and reformats it in .rep, .txt. or 
.xls format. The output file consists of six columns: pressure, quantity dosed, elapsed time, 
sample temperature, port temperature, and port assignment. Refer to Appendix F, page F-1 for 
record descriptions. The data can then be imported into other applications accepting spread-
sheet or text file formats. 

Select File > Export to display the Export Sample File dialog.

Files list This list contains the files located in the current directory.  

File name The name of the file you select from the Files list is copied to 
this field. 
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Open This button displays the Export Settings dialog.

• Preview: prints file contents to the screen.

• Print: prints the isotherm data to the default printer. 
The Copies field is enabled allowing you to print up 
to 10 copies. 

• File: prints the isotherm data to a file. Enter a name in 
the File name field and select one of the following 
file types from the drop-down list: 

rep: system report which can be opened using the 
Open Report command on the Reports menu.

xls: spreadsheet format

txt: text file
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Format of Data Output

This example shows the format of the output file for exported data.
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Exit

Exit enables you to close the ChemiSorb program. When you select Exit, analyses in progress 
continue until completion; analysis data are collected and stored in the analyzer’s memory.

When you select File > Exit:

• If a window containing a modified file is open, you are queried to save before closing.

• If an analysis is in progress, the following message is displayed:

2459- An instrument is busy. A delay in restarting this application 
could result in loss of data. Continue with program exit?

Yes No

Yes exits the ChemiSorb program. The analysis continues and data are collected.

No allows the program to remain active.
 248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01                                       5-51 



Exit ChemiSorb HTP
5-52                                                      248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01
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6.  UNIT MENU

The Unit menu contains the options for the operations that can be performed with the Chemi-
Sorb HTP analyzer. The main menu contains a Unit menu for each attached analyzer. For 
example, if you have two attached analyzers, the main menu contains two Unit menus. The 
appropriate unit number and serial number display in the title bar of the operational windows. 
The status windows also display in different colors.

Description

Listed below are brief descriptions of the Unit menu options. Detailed descriptions are found 
on the pages indicated.

The Unit menu does not display on the menu bar if the analysis program is being used 
for offline data manipulation on a computer other than the one controlling the 
analyzer.

Sample Analysis Enables you to perform an analysis. Page 6-3

Analysis Sequence Allows you to schedule a series of analyses. Page 6-8

Enable Manual Control Allows you to control certain components of the system 
manually. Page 6-13

Show Instrument Schematic Displays a schematic of the analyzer components. Page 6-18

Show All Readings Enables you to view the pressure and temperature 
calibrations. Page  6-19 
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Show Status Shows the status window for the selected unit. Page  6-20 

Show Instrument Log Displays a log of recent analyses, calibrations, and error 
messages. Page 6-22

Unit Configuration Displays software version, hardware configuration, and 
calibration information. Also allows you to assign gases to 
analyzer ports. Page 6-24

Calibration Enables you to calibrate certain components of the analyzer. 
Page 6-27
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Sample Analysis

When you select Unit >Sample Analysis, the Analysis dialog is displayed. This dialog 
enables you to select files for performing up to six analyses. During the analysis process, any 
one analysis can be cancelled without cancelling the other analyses. 

View Allows you to view one of the following in the current 
window:

• the current operation
• the instrument schematic
• the instrument log
• status
• all readings (see Show All Readings, page 6-19)
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Browse Enables you to select a sample file for the associated port. 
When you select a file, its path name and description are 
displayed.

The files selected for any port after the first port must pass a 
compatibility check with the first port’s sample file. If the 
check fails, the file path displays with a red background and 
an error message lists all parameters that failed the 
compatibility check.

The following parameters must be the same for all sample 
files that will be used in analyses run at the same time:

• Backfill gas

• Number of tasks

• For each task, the following parameters must be the same:
- Type of task
- Temperature 
- Rate

• For evacuation tasks:
 - Vacuum level
 - Evacuation time

• For soak tasks:
- Gas
- Minimum pressure
- Soak time

• For flow tasks:
- Gas
- Flow time

• Analysis gas

Edit Open the selected sample file so you can edit the parameters 
in the file. 

After you edit the file, it is checked again for compatibility.

Clear Removes the selected sample file.

Free Space Displays the estimated free space.
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Mass Enabled if Enter is selected in the sample file; displays the 
value you entered for the sample mass. You can edit this 
value if you wish.

If you selected Calculate in the sample file, the calculated 
mass is shown in this field, but disabled.

Sample + tube Enabled if Calculate is selected in the sample file; displays 
the mass you entered for the sample + sample tube.

Tube Enabled if Calculate is selected in the sample file; displays 
the value you entered for the empty sample tube.

The calculated mass is shown in the Mass field (greyed).

Report after analysis Displays the Report Settings dialog so that you may specify 
report and/or export output options. 

• Report after analysis generates selected reports
• Export after analysis exports the isotherm data

Preview Generates reports or exports data to the screen. You can print 
a paper copy from the report window if desired.

Print Generates reports or exports data to your default printer; you 
do not have the option to select a specific printer. The Copies 
field is enabled, allowing you to print up to 10 copies.
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Start Displays the second view of the Analysis dialog. This view of 
the dialog simply instructs you to raise the elevators and 
install the insulator disks and safety shields. 

If these tasks have been completed, Next is enabled. If the 
tasks have not been completed, you must complete them to  
proceed.

Next Displays a message requesting you to install the oven 
insulator disks and safety shields. After you have installed 
these, click Next. The next view of the Analysis dialog is 
displayed.

This view of the dialog displays a live graph of data for the 
analyses in progress. The graph will have up to twelve 
curves; six for the first analysis on each port and six for the 
repeat analysis (if requested) on each port.

Report Port [n] Generates a report for the sample on the selected port.
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Skip Displays a dialog enabling you to select the port on which to 
skip the current step.

Use caution when skipping steps. The ChemiSorb performs 
multiple steps for a given task. Skipping certain steps may 
cause corruption of data, instrument damage, or personal 
injury. 

Be careful when using this function. Skipping certain steps can cause personal injury, 
instrument damage, or may corrupt your data.

Resume Displays a dialog enabling you to select the port on which to 
resume a suspended analysis.

Suspend Displays a dialog enabling you to select the port on which to 
suspend an analysis.

Cancel Displays a dialog that enables you to select the port on which 
the analysis will be cancelled. Cancelling an analysis on a 
port does not affect the other analyses in progress.

Close Enabled at the completion of analysis. Closes the dialog.

Status bar The status bar across the bottom of the gives the current 
status of the ports.
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Analysis Sequence

This option allows you to perform a series of analyses on one or more ports.  

If you select this option and a sequence analysis is already in progress, the screen will show 4

the steps for the analysis in progress.

View Allows you to view one of the following in the current 
window:

• the current operation
• the instrument schematic
• the instrument log
• status
• all readings

Sequence Table Displays the following information for ports 1 through 6:

Free Space Displays the estimated free space. You may edit if required.
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Sample Mass Enabled if Enter is selected in the sample file; displays the 
value you entered for the sample mass. You can edit this 
value if you wish.

If you selected Calculate in the sample file, the calculated 
mass is shown in this field, but disabled.

Sample + tube Enabled if Calculate is selected in the sample file; displays 
the mass you entered for the sample + sample tube.

Tube Enabled if Calculate is selected in the sample file; displays 
the value you entered for the empty sample tube.

Sequence steps A column is displayed for each sequence step. 

The column is marked with an X if the port has a sample file 
selected for this sequence.  

Sequence step columns are added using the Insert and 
Append push buttons.

Sequence Step window Displays the sample files assigned to the selected Sequence 
step.

Insert
Append

Enables you to choose a file for the sequence step you are 
inserting. 

Insert places the step before the selected step. This push 
button becomes enabled after a step has been added.

Append places the step at the end of the table.
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Browse Enables you to select a sample file for the associated port. 
When you select a file, its path name and description are 
displayed.

After the first file is selected, each subsequent file must pass 
a compatibility check. If the check fails, the file path displays 
a red background and an error message lists all entries that 
fail the compatibility check.

Edit Opens the selected sample file so that you can edit the 
parameters in the file. 

After you edit the file, it is checked again for compatibility 
(see above).

Clear Removes the selected sample file.

Sequence Step
Parameters

Displays the tasks entered for the analysis.
6-10                                                      248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01



ChemiSorb HTP Analysis Sequence
Edit Enables you to edit or select a different file for the sequence.

Delete Deletes the selected sequence.

Clear Removes all sequence steps from the table.  

Start Displays the second view of the Analysis dialog. This view of 
the dialog simply instructs you to raise the elevators and 
install the insulator disks and safety shields. 

If these tasks have been completed, Next is enabled. If the 
tasks have not been completed, you must complete them to  
proceed.

Next Displays a live graph of data for the analyses in progress. The 
graph will have up to twelve curves; six for the first analysis 
on each port and six for the repeat analysis (if requested) on 
each port..
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Report Port [n] Generates a report for the sample on the selected port.

Skip Displays a dialog enabling you to select the port on which to 
skip the current step.

Use caution when skipping steps. The ChemiSorb performs 
multiple steps for a given task. Skipping certain steps may 
cause corruption of data, instrument damage, or personal 
injury. 

Be careful when using this function. Skipping certain steps can cause personal injury, 
instrument damage, or may corrupt your data.

Resume Displays a dialog enabling you to select the port on which to 
resume a suspended analysis.

Suspend Displays a dialog enabling you to select the port on which to 
suspend an analysis.

Cancel Displays a dialog that enables you to select the port on which 
the analysis will be cancelled. Cancelling an analysis on a 
port does not affect the other analyses in progress.

Close Enabled at the completion of analyses. Closes the dialog.

Status bar The status bar across the bottom of the gives the current 
status of the ports and sequence steps.
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Enable Manual Control

Select this option to control certain components of your system manually; the instrument sche-
matic is displayed with manual control enabled. 

Each component that can be manually controlled has a shortcut menu displaying the opera-
tions available for that particular component. These menus may be accessed by selecting the 
desired component, then clicking the right mouse button once, or pressing Shift + F9.

The options available for the components on the instrument schematic are:

Valves Actions: Open, Open All, Close, Close All, Pulse

Open and Close open and close the valves. You can also 
open and close the valves by double-clicking on the valve or 
by pressing the Spacebar while the valve is selected.

Open All and Close All open all and close all valves in its 
series. For example, if a MFC icon is selected and you choose 
Open All, all MFC valves will open. 

Pulse quickly turns the valve on and off, allowing the 
operation to proceed in small increments. You can also pulse 
the valve by pressing P while the valve is selected.

System valves and their functions are listed in the following 
table.

Open Closed
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Valve(s) Description

1 through 6 Sample ports

7 Unrestricted vacuum

8 Supply valve, supplies gas to the 
manifold

9 Vacuum valve, allows evacuation of  
gas inlet manifold

10 MFC isolation valve

F1 through F6 MFC valves; purge the gas from the 
lines when closed

G1 through G12 Gas inlet ports

X1 through X6 Exhaust from sample tube 

Unmarked Servo valve

Servo Valve Actions: Set, Close

Set displays the Servo Valve Settings dialog so that you may 
choose to dose or evacuate and specify a target pressure. 

When set, the directional arrow indicates whether it is dosing 
or evacuating.

Close closes the servo valve. 

The Spacebar can also be used for operation. 

• Press the Spacebar when the servo is closed, the settings 
dialog is displayed. 

• Press the Spacebar when the servo is in operation, the 
servo is turned off.

Closed

Evacuating

Dosing
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Sample Tube
Furnace/Elevator

Actions: Set, Raise, Lower, Stop

The sample tube icon is white when the sample and furnace 
temperature is 50 ºC or lower. If either temperature exceeds 
50 ºC, the sample tube icon will turn orange and the elevator 
control will be disabled. Temperature readings and ramp rate 
are displayed below the icon.

The furnace resides on the elevator. 

Set displays the Set Temperature Controller dialog. You can 
also access this dialog by pressing Spacebar while the 
elevator area is selected.

Enable Temperature Control
Allows you to enter the target temperature and ramp rate. The 
elevator must be fully raised for this option.

Disable Temperature Control
This option allows you to manually control the temperature; 
automatic temperature control will be disabled. For example, 
you may wish to use this option when using subambient 
temperatures for an analysis.

Raise and Lower raises and lowers the elevator. An indicator 
arrow is displayed in the elevator icon to indicate its 
direction. 

Stop stops the elevator at its current position. 

Sample Tube

Elevator

Sample temp. 

Target temp.

Ramp rate

Furnace temp.

Being raised Being lowered
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These components are for informational purposes only; they cannot be controlled manually.

Mass Flow Controller Actions: Set Flow Rate, Stop Flow

The Mass Flow Controllers (MFCs) control the flow of gas 
into the sample ports. The current (C) rate and target (T) rate 
are shown to the right of each MFC icon. 

Set Flow Rate enables you to enter a flow rate.

Stop Flow stops the flow of gas.

Manifold Pressure
Vacuum Gauge Pressure
Manifold Temperature

The group of rectangles on the manifold display the manifold 
pressure, the vacuum gauge pressure, and the manifold 
temperature.

Sample Port transducer Each sample port has a 1000- and a 10-mmHg transducer; 
only the reading for the 1000-mmHg transducer is shown on 
the schematic. You may select Unit > All Readings to view 
the reading for the 10-mmHg transducer (refer to Show All 
Readings, page 6-19).

Manifold pressure

Manifold temperature

Vacuum gauge pressure
6-16                                                      248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01



ChemiSorb HTP Enable Manual Control
Status bar The status bar across the bottom of the instrument schematic 
gives the current status of the ports. 

The status bar is separated into seven sections; one for each 
port and one (last section on the right side of the bar) for  
sequence analysis detail. This section will be blank for a 
standard sample analysis.

During sample preparation, the following steps are displayed:

Evacuation
Leak
Flow
Soak

During analysis, the following steps are displayed:

First analysis
Repeat evacuation
Repeat analysis
Free space evacuation
Free space

Termination displays when the analysis is complete and the 
furnace is being lowered and the sample cooled.

Idle displays when the port is completely idle (termination 
criteria are complete).

Port 1 Port 2 Port 3 Port 4 Port 5 Port 6 Sequence analysis
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Show Instrument Schematic

Select this option to display a schematic of the ChemiSorb analyzer. The schematic is a graph-
ical representation of the plumbing system including system valves, the analysis station, and 
the furnace position. The valves, furnace and MFC can be controlled from the schematic when 
Manual control is enabled. Refer to the previous section for an explanation of the components 
displayed on the instrument schematic.

The state of the valves can be determined quickly by color representation even when manual 
control is not enabled:

• Green = open
• White = closed

If you wish to change the state of a valve, you must enable manual control.
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Show All Readings

This dialog shows the calibrated and nominal readings of all system sensors. This information 
can also be viewed from the analysis dialogs by selecting All Readings from the View drop-
down list. 
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Show Status

The Show Status option enables you to view the current status of all six ports. 

If you have two instruments attached to your computer, the status bar for each instrument is 
displayed in a different color. 

Analysis status bar Shows the progression of the analysis. This bar contains three 
stages:

• Preliminary:  sample is prepared; displays green during 
progression

• Analysis: data and free space are collected; displays blue 
during progression

• Termination: the furnace lowers, and the sample is 
cooled and backfilled; displays grey during progression

All stages are displayed in red if the analysis has been 
suspended.
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Analysis details The following analysis details are displayed:

Sample: Sample file number
Stage: Stage of the analysis (as in status bar)
Last Point: Last point and number of points requested
P: Pressure of last point
Est. Vol. Ads.: Volume adsorbed
Run Time: Elapsed time since the start of analysis
Manifold Gas: Current manifold gas

Step details Provides details of the current step of the analysis.
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Show Instrument Log

Displays a log of recent analyses, calibrations, and errors or messages. By default, this infor-
mation is logged for a 7-day period for analyses and a 30-day period for messages and 
calibrations. You may change the time for which this information is retained in the Unit sec-
tion of the WIN2480.INI file.

Analysis
Calibration
Messages

These options allow you to choose the type of entries 
displayed in the window. For example, select only the 
Calibration check box to display only calibration 
information.

Report Allows you to generate the log contents to a specified 
destination; the Log Report Settings dialog is displayed.
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Destination This group box contains print options; you may print to the 
screen (Preview), to a printer, or to a file.

Preview prints the report to the screen.

Print sends the report to the default printer; you cannot select 
a specific printer. The Copies field is enabled, allowing you 
to print up to 10 copies.

File enables you to print and save the report as a file. 

rep: system report which can be opened using the 
        Open Report command on the Reports menu.

xls: spreadsheet format

txt: text file

The adjacent field displays the print destination and allows 
you to name the file. Use the Browse button to the right of 
the field if you wish to save the file in a different directory.
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Unit Configuration

Select this option to view the current calibration settings, the date on which calibration was 
performed, and the software and hardware configuration of your system.

Software Versions Displays the software versions being used by the analyzer.

Volume Calibration Displays the manifold and reference volumes, and the date of 
calibration.

A/D Calibration Click Details for Temperature and Pressure to display a 
dialog containing calibration details for each port.

Configuration Displays the IP address used by the analysis program and the 
serial number of the selected analyzer. Also enables you to 
view details of the boards installed in the analyzer and assign 
gas ports.
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Change Displays the Unit IP Setup dialog. 

This dialog shows the IP address and Subnet mask that were 
assigned during installation. Do not edit these fields unless 
directed by a Micromeritics service representative.

Board ID Displays the Board ID dialog so that you can view the 
statistics of the board contained in the requested slot of the 
computer. For example, this dialog shows statistics of the 
backplane board.
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Gas Displays the Gas Configuration dialog.

This dialog allows you to choose which gases are attached to 
each port of the analyzer. 
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Calibration

This option allows you to perform system calibrations. Some calibrations are disabled and can 
be accessed only when using the Service Test Mode with the assistance of your service 
representative.  

Pressure Zero

Use this option to evacuate the manifold and zero the selected transducers; the Calibrate Pres-
sure Offset dialog is displayed.
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Choose the transducer(s) you wish to have offset to zero. Be sure to install a sample tube on 
the selected ports. Click Start; a dialog indicating evacuation is in progress is displayed. When 
evacuation is complete, the dialog closes automatically.

Match Transducers

Use this option to zero and match the selected transducers to the main manifold transducer.

Choose the transducer(s) you wish to have matched. Be sure to install a sample tube on the 
selected ports. Click Start; a progress dialog is displayed. When the operation is complete, a 
confirmation dialog is displayed; click OK to close the dialog.

Servo

Use this option to calibrate the servo valve to the manifold pressure transducer. The servo 
valve should always be recalibrated after a pressure calibration has been performed. The Cali-
brate Servo dialog is displayed.
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The only action required here is to click Start. The servo valve is then used to fill and equili-
brate the manifold, first to approximately 760 mmHg and then to approximately 50 mmHg. 
The pressure transducer readings (previously calibrated) at these points are used to calibrate 
the servo set point. Status messages are displayed during this procedure and a confirmation 
dialog is displayed when the operation is finished; click OK to close the dialog.

Save to File

Use this dialog to save the current calibration settings to a file that you can reload; the Select 
Calibration File dialog is displayed.

Load from File

Displays the Select Calibration File dialog (shown above) so that you can load a different cali-
bration file. After you choose a file and click Open, a confirmation dialog is displayed; click 
OK to close the dialog.

It is recommended that you save the current calibration settings using the Save to File com-
mand before loading another file. 

File name The default for naming calibration files is the serial number, 
then the next sequenced number. For example in the dialog 
shown above, the number has defaulted to 201-002.CAL, 
where 201 represents the instrument serial number and 002 
represents the second calibration file saved. 

You can enter a different name if you wish.
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ChemiSorb HTP Description
7.  REPORTS MENU

This chapter describes:

• how to start reports, page 7-2
• how to close reports, page 7-4
• how to open reports saved from the report window, page 7-4
• how to generate Heat of Adsorption reports, page 7-5
• the appearance of reports, page 7-9
• manipulation tools for onscreen reports, page 7-9

This chapter also contains examples of some of the reports available for the ChemiSorb analy-
sis program beginning on page 7-18.

Reports can be generated for data:

• collected on a sample that has completed analysis

• collected on a sample that is currently being analyzed (includes only the information 
collected up to the time of the report)

• that are manually entered

Description

Listed below are brief descriptions of the commands contained on the Reports menu. Detailed 
descriptions follow this section.

Start Report Allows you to generate a report on a completed sample 
analysis or on the data collected thus far for an analysis in 
progress. Page 7-2.

Close Reports Closes all open report windows. Page 7-4.
 248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01                                        7-1 



Start Report ChemiSorb HTP
Start Report

Select this option to generate a report on a sample analysis; the Start Report dialog is 
displayed.

Open Report Enables you to open a report that was saved from the report 
window. Page 7-4.

Heat of Adsorption Allows you to generate a heat of adsorption report. 
Page 7-5.

Files list This list contains the files located in the current directory.

File name The name of the file you select from the Files list is copied to 
this field. 
7-2                                                      248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01



ChemiSorb HTP Start Report
Open Displays the Report Settings dialog. 

• Preview: prints file contents to the screen.

• Print: prints file contents to the default printer. The 
Copies field is enabled allowing you to print up to 10 
copies. 

• File: prints file contents to a file. Enter a name in the 
File name field and select one of the following file 
types from the drop-down list: 

rep: system report which can be opened using the 
Open Report command on the Reports menu.

xls: spreadsheet format

txt: text file

If you chose a single file, the following dialog is displayed.

This dialog allows you to confirm or edit the selection of the 
reports you wish to generate.

Reports are selected when a check mark is in the box adjacent 
to the report name. 
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Close Reports

This option enables you to close all open report windows at one time. This avoids having to 
select Close on each report window. This option is unavailable if reports are being generated.

Open Report

This option enables you to open a report that was saved from the Report window; the Open 
dialog is displayed. 

Files list This list contains the files located in the current directory.

File name The name of the file you select from the Files list is copied to 
this field. 

Open Displays the selected report(s) in the Report window.
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Heat of Adsorption Report

The isosteric heat of adsorption is an important parameter for characterizing the surface  het-
erogeneity and for providing information about the adsorbent and the adsorption capacity. 
Multiple adsorption isotherms are obtained on the same sample using the same adsorptive but 
at different temperatures to obtain the heat of adsorption.

This option allows you to choose the sample files, define the quantities, and generate a Heat of 
Adsorption report; the Heat of Adsorption dialog is displayed.

Table Contains the files you choose; also lists the quantity 
adsorbed.

Analysis options Enables you to select the analysis data to include. You can 
include analysis data, repeat analysis (if requested in the 
files), and difference data.

Add Samples Displays the Select Samples dialog so that you can choose 
desired files.

Remove Sample Removes the selected sample file from the table. If a sample 
file is not selected, the first one is removed.
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Clear Samples Removes all sample files from the list.

Edit Quantities Displays the Edit Quantities Adsorbed dialog so that you can 
specify the range of surface coverage to include in the heat of 
adsorption report.

Quantity Adsorbed 
table

Allows you to enter the points.

Insert Range Displays the Insert Quantity Range dialog.

This dialog allows you to specify the starting and ending 
quantities adsorbed, as well as the number of points to insert 
within the specified range.

Insert Inserts a row above the selected row.
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Delete Deletes the selected row.

Clear Clears the entire table of all entries except one; one is 
required.

Append Adds a row to the end of the table.

Load Table Allows you to import a previously saved table.

Save Table Allows you to save the current table as a file (QNT 
extension).

Tabular report Select this option to have data generated in a tabular format.

Isostere plot Select this option to generate a graph showing quantities of 
gas adsorbed vs. the temperature.

Heat of adsorption plot Select this option to generate the Heat of Adsorption data in a 
graphical format.

Show report title Choose this option to have a title display in the header of 
your report; use the adjacent field to enter the title.

Show graphic This option allows you to have a graphic appear in your title; 
for example, you may wish to show your company logo. You 
can use a bitmap or an enhanced metafile.

Use the Height and Width fields to specify a size.

Preview Prints the report to the screen. You can print a paper copy 
from the report window if desired.

Print Prints the report to your default printer; you cannot select a 
specific printer. The Copies field is enabled, allowing you to 
print up to 10 copies.
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File Prints the reports to a file; you may print as a:

rep: system report which can be opened using the Open 
Report command on the Reports menu.

xls: spreadsheet format

txt: text file

The adjacent field displays the print destination and allows 
you to name the file. The Browse button is enabled so that 
you can choose a directory in which to save the file.

Open Enables you to open a previously saved report.

Save Saves the current report.  

Report Generates the report to the selected destination.
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Printed Reports

Header

All reports contain a header displaying file and instrument statistics such as date and time of 
analysis, software version, analysis conditions, and so forth.

Report headers also contain notes of any changes to the sample file that occur after analysis.

Onscreen Reports

The report window containing onscreen reports provides many options for customizing and 
manipulating reports: 

• a tool bar
• shortcut menus
• zoom feature
• axis cross hairs 

When reports are printed to the screen, they are printed in a window like the one shown below. 
Each requested report is listed in the Reports window on the tool bar; they are also indicated 
by selectable tabs across the top of the report header. To view a specific report, select its tab or 
select the report in the Reports window and click Show.

Tabs display for each type of report you choose to generate.

Options on 
Tool Bar

List of reports 
requested.

Header

Displays graphical 
(or tabular) data.
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Tool Bar

Reports Contains a list of all requested reports.

Show Shows the selected report in the report window. If the report 
has been hidden, it and its associated tab will become visible.

Delete Deletes the selected reports. A deletion confirmation dialog is 
displayed since this function cannot be undone. The deleted 
report(s) will have to be regenerated if deleted in error.

Hide Hides (removes) the selected report from the report window. 
The report’s associated tab is also removed. 

Print Displays a print dialog so that you can choose an appropriate 
printer for report output. A list of available reports is 
displayed in the window on the right side of the dialog. 
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Print
(continued)

For convenience in selecting which reports to print, push 
buttons are provided beneath the report window. Or, you can 
make your selection by clicking on the desired reports.  

Current selects the report displayed in the report window.

Shown selects only the shown reports; any nonhighlighted 
reports indicate they are hidden. You can still select hidden 
reports from this window to print.

All selects all reports, including those that may have been 
hidden.

Clear clears all selections.

Save Saves all reports of the currently open file in a report format 
using the same name as the sample file, only with an rep 
extension. If you wish to specify a name and/or specific 
reports to save, use the Save As push button.

Save As Saves all or specified reports from the currently open file. 
The push buttons displayed on this dialog perform in the 
same manner as the print dialog (explained above).

Reports can be saved in three different formats:

Report system (*.rep): Saved in a format which allows you 
to reopen the file using the Open Report command on the 
Reports menu.

Spreadsheet (*.xls): Saved in a format which can be 
imported into most spreadsheet programs.

Ascii Text (*.txt): Saved in ASCII text which can be 
imported into programs accepting this type of file.
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Default Style Displays the Default Style dialog so that you can specify 
default parameters for report fonts and curve properties.

Font Contains a list of report elements for which the font can be 
edited. Simply highlight the desired element and click Edit; a 
font dialog enabling you to specify the desired font and 
attributes is displayed.

Curve The items in this group box enable you to specify a thickness 
for report curves and, when using histograms, the type of fill 
to apply.

Graph border
line thickness

Enables you to specify a thickness for the border of the graph.

Load Loads the last saved defaults.

Save Saves the changes as the defaults. If you do not click Save, 
the changes will apply to the current report set only. The next 
reports will revert to the defaults.

Close Closes the Default Style dialog and applies the changes. If 
you clicked Save, the changes become the defaults. If you 
did not click Save, the changes apply only to the current 
report set. 

Close Closes the report window.
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Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a 
report. 

Tabular Reports

Resize column Displays a dialog so that you can specify the width (in 
inches) of the selected column.

Rename column Displays a dialog so that you can edit the name of the 
selected column. Use Ctrl + Enter to insert line feeds.

Move column Allows you to move the location of the selected column to 
the left or to the right.

Align column Enables you to right-align, left-align, or center the data in the 
selected column.

Hide column Displays a list of all columns, enabling you to select the one 
you wish to hide.

Show column Displays a list of all hidden columns, enabling you to select 
the one you wish to have shown again.

Column font Displays a Font dialog, allowing you to change font attributes 
for the tabular data in the current report. 
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Graphs

Header font Displays a Font dialog, allowing you to change font attributes 
for column headers in the current report.

Edit title Allows you to edit the table title and font.

Copy table as text Enables you to copy the entire table (column headers and 
data) and then insert it into another program. Columns are 
tab-delimited, allowing easy alignment.

Autoscale Autoscales all axes of the graph. This function is useful for 
returning to a full view after having zoomed in.

Redraw Sets axis boundaries to its original view. You can also use this 
function to remove cross-hairs.

Show curve Shows any curve that has been hidden. This option is 
disabled (greyed) if no curves have been hidden.

Hide curve Hides (removes from view) any unwanted curve.
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Edit curve Displays the Curve Properties dialog, allowing you to edit 
curve properties.

Title Displays the title of the curve you are editing.

Style Drop-down list containing styles in which collected data can 
be displayed.

Choices: Curve, Histogram, Points, Curve and Points

Curve group box Contains options for curves and points. You can edit the 
curve interpolation, the style of curve and/or points, the 
thickness of the pen, and the pen color. 

The options in this group box are disabled if Histogram is 
chosen in the Style drop-down list.

Histogram group box Allows you to specify the type of fill as well as the color if 
Histogram is chosen as the style for collected data.
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Edit axis Displays the Axis Properties dialog, allowing you to edit axis 
properties.

Edit legend Displays the Legend Properties dialog, allowing you to edit 
the placement of the legend.

Edit title Displays the Title Properties dialog, allowing you to edit the 
current graph’s title and font.

Copy Graph Copies the graph and places it on the clipboard, allowing you 
to paste it into other applications. 

Copy Data Copies the data used to generate the graph as a series of tab-
delimited columns of text.

Select this 
option to 
remove the 
legend.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine fine details. To 
use this feature, simply hold down the left mouse button and drag the mouse cursor (drawing a box) 
across the area you wish to view; then release the button. The enlarged area immediately fills the 
graph area. Right-click in the graph area and choose Reset or Autoscale from the shortcut menu to 
return to the normal view.

Axis Cross Hair

A cross-hair function is available so that you can view axis coordinates. To use this feature, simply 
left-click in the desired area of the graph.

Right-click in the graph area and choose Reset or Autoscale form the shortcut menu to remove cross-
hair lines and return to the normal view. Alternatively, you can click outside of the graph area.

X-axis position

Point of Coordination

Y-axis position
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Report Examples

The remainder of this section contains samples of some of the reports which may be generated 
by the ChemiSorb program. Most of the reports can be varied through entries on the report 
options screens.
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Isotherm

Plot

Micromeritics Instrument Corporation

Page 1ChemiSorb HTP Version 1.01 ChemiSorb HTP Version 1.01 S/N: 102, Unit: 1, Port: 1 Page 1

Sample: CO Pt-Al LP P7 1
Operator: samv

Submitter: 102
File: C:\cygwin\home\samv\development\32bitp...\manual-reports.SMP

Started: 2011-05-09 09:58:57 Analysis Gas: CO
Completed: 2011-05-09 20:39:32 Analysis Temperature: 35.0 °C

Report Time: 2011-08-31 11:32:34 Equilibration Interval: 20 s
Sample Mass: 0.7024 g Low Pressure Dose: 0.0002 mmol/g

Measured free space: 25.1639 cm³ Thermal Correction: No

Pressure (kPa)
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Isotherm Plot
CO Pt-Al LP P7 1 - First analysis data point
CO Pt-Al LP P7 1 - Repeat analysis data point
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Tabular Report

Micromeritics Instrument Corporation

Page 1ChemiSorb HTP Version 1.01 ChemiSorb HTP Version 1.01 S/N: 102, Unit: 1, Port: 1 Page 1

Sample: CO Pt-Al LP P7 1
Operator: samv

Submitter: 102
File: C:\cygwin\home\samv\development\32bitp...\manual-reports.SMP

Started: 2011-05-09 09:58:57 Analysis Gas: CO
Completed: 2011-05-09 20:39:32 Analysis Temperature: 35.0 °C

Report Time: 2011-08-31 11:32:34 Equilibration Interval: 20 s
Sample Mass: 0.7024 g Low Pressure Dose: 0.0002 mmol/g

Measured free space: 25.1639 cm³ Thermal Correction: No

Isotherm Tabular Report

Analysis Data

Pressure (kPa)
Quantity

Adsorbed
(mmol/g)

Time
(hh:mm)

Repeat
Pressure (kPa)

Repeat Quantity
Adsorbed
(mmol/g)

Time
(hh:mm)

0.00113 0.00360 00:05
0.00284 0.00696 00:15
0.05989 0.00768 00:30 0.05584 0.00086 03:16
0.12746 0.00798 00:38 0.12432 0.00112 03:22
0.20052 0.00821 00:43 0.19393 0.00131 03:28
0.33005 0.00854 00:49 0.33408 0.00164 03:34
0.66666 0.00916 00:54 0.66436 0.00229 03:40
1.00321 0.00964 00:58 0.99872 0.00278 03:45
1.33681 0.01007 01:01 1.32911 0.00313 03:49
1.60555 0.01038 01:07 1.59504 0.00344 03:54
3.33678 0.01168 01:11 3.32824 0.00465 03:58
6.69795 0.01275 01:15 6.67819 0.00573 04:02

13.36156 0.01457 01:20 13.35568 0.00758 04:06
20.02378 0.01651 01:24 20.01299 0.00952 04:10
26.69877 0.01822 01:28 26.68701 0.01131 04:14
33.37028 0.01976 01:33 33.36202 0.01293 04:18
40.04853 0.02119 01:38 40.03775 0.01438 04:22
46.72648 0.02258 01:43 46.71710 0.01567 04:26
53.40162 0.02379 01:48 53.39798 0.01689 04:30
60.07649 0.02494 01:53 60.07578 0.01811 04:35
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Difference Method

Summary

Micromeritics Instrument Corporation

Page 1
ChemiSorb HTP Version 1.01 ChemiSorb HTP Version 1.01 S/N: 102, Unit: 1, Port: 1 Page 1

Sample: CO Pt-Al LP P7 1
Operator: samv

Submitter: 102
File: C:\cygwin\home\samv\development\32bitp...\manual-reports.SMP

Started: 2011-05-09 09:58:57 Analysis Gas: CO
Completed: 2011-05-09 20:39:32 Analysis Temperature: 35.0 °C

Report Time: 2011-08-31 11:32:34 Equilibration Interval: 20 s
Sample Mass: 0.7024 g Low Pressure Dose: 0.0002 mmol/g

Measured free space: 25.1639 cm³ Thermal Correction: No

Difference Summary
Element Percent of

Sample
Weight (%)

Percent
Reduced

(%)

MxOy,X MxOy,Y Atomic
Weight

Stoichiometry
Factor

Atomic
Cross-Sectional

Area (nm²)

Density
(g/cm³)

platinum 0.50 100.00     1     0 195.090 1.000 0.0800 21.450

Analysis Results
Metal Dispersion: 47.2394 %

Metallic Surface Area: 0.5834 m²/(g of sample)
Metallic Surface Area: 116.6734 m²/(g of metal)

Crystallite Size (6.000 V / A): 2.39746 nm
Y-Intercept Quantity Adsorbed: 0.01211 ± 0.00030 mmol/g

Slope: 0.000658 ± 0.000023
Correlation Coefficient: 0.996511

Difference Results
Metal Dispersion: 27.3088 %

Metallic Surface Area: 0.3372 m²/(g of sample)
Metallic Surface Area: 67.4483 m²/(g of metal)

Crystallite Size (6.000 V / A): 4.14718 nm
Y-Intercept Quantity Adsorbed: 0.00700 ± 0.00005 mmol/g

Slope: -0.000008 ± 0.000004
Correlation Coefficient: -0.657288
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Tabular Report

Micromeritics Instrument Corporation

Page 1
ChemiSorb HTP Version 1.01 ChemiSorb HTP Version 1.01 S/N: 102, Unit: 1, Port: 1 Page 1

Sample: CO Pt-Al LP P7 1
Operator: samv

Submitter: 102
File: C:\cygwin\home\samv\development\32bitp...\manual-reports.SMP

Started: 2011-05-09 09:58:57 Analysis Gas: CO
Completed: 2011-05-09 20:39:32 Analysis Temperature: 35.0 °C

Report Time: 2011-08-31 11:32:34 Equilibration Interval: 20 s
Sample Mass: 0.7024 g Low Pressure Dose: 0.0002 mmol/g

Measured free space: 25.1639 cm³ Thermal Correction: No

Difference Tabular Report

Pressure
(kPa)

Total Quantity
Adsorbed
(mmol/g)

Repeat Quantity
Adsorbed
(mmol/g)

Difference Quantity
Adsorbed
(mmol/g)

0.00113 0.00360 0.00086 0.00273
0.00284 0.00696 0.00086 0.00609
0.05989 0.00768 0.00088 0.00680
0.12746 0.00798 0.00113 0.00685
0.20052 0.00821 0.00133 0.00688
0.33005 0.00854 0.00163 0.00691
0.66666 0.00916 0.00229 0.00687
1.00321 0.00964 0.00279 0.00685
1.33681 0.01007 0.00314 0.00693
1.60555 0.01038 0.00345 0.00692
3.33678 0.01168 0.00466 0.00702
6.69795 0.01275 0.00574 0.00701

13.36156 0.01457 * 0.00758 0.00699
20.02378 0.01651 * 0.00952 0.00699
26.69877 0.01822 * 0.01131 0.00691
33.37028 0.01976 * 0.01294 0.00682
40.04853 0.02119 * 0.01438 0.00681
46.72648 0.02258 * 0.01567 0.00691
53.40162 0.02379 * 0.01689 0.00689
60.07649 0.02494 * 0.01811 0.00684

* Included in calculation of line fit and difference data.
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Plot

Micromeritics Instrument Corporation

Page 1
ChemiSorb HTP Version 1.01 ChemiSorb HTP Version 1.01 S/N: 102, Unit: 1, Port: 1 Page 1

Sample: CO Pt-Al LP P7 1
Operator: samv

Submitter: 102
File: C:\cygwin\home\samv\development\32bitp...\manual-reports.SMP

Started: 2011-05-09 09:58:57 Analysis Gas: CO
Completed: 2011-05-09 20:39:32 Analysis Temperature: 35.0 °C

Report Time: 2011-08-31 11:32:34 Equilibration Interval: 20 s
Sample Mass: 0.7024 g Low Pressure Dose: 0.0002 mmol/g

Measured free space: 25.1639 cm³ Thermal Correction: No

Pressure (kPa)
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Difference Plot
Selected first analysis data Selected repeat analysis data
Difference Non-selected first analysis data
Non-selected repeat analysis data
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Sinfelt Method

Micromeritics Instrument Corporation

Page 1
ChemiSorb HTP Version 1.01 ChemiSorb HTP Version 1.01 S/N: 102, Unit: 1, Port: 1 Page 1

Sample: CO Pt-Al LP P7 1
Operator: samv

Submitter: 102
File: C:\cygwin\home\samv\development\32bitp...\manual-reports.SMP

Started: 2011-05-09 09:58:57 Analysis Gas: CO
Completed: 2011-05-09 20:39:32 Analysis Temperature: 35.0 °C

Report Time: 2011-08-31 11:32:34 Equilibration Interval: 20 s
Sample Mass: 0.7024 g Low Pressure Dose: 0.0002 mmol/g

Measured free space: 25.1639 cm³ Thermal Correction: No
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Langmuir Surface Area

Micromeritics Instrument Corporation

Page 1
ChemiSorb HTP Version 1.01 ChemiSorb HTP Version 1.01 S/N: 102, Unit: 1, Port: 1 Page 1

Sample: CO Pt-Al LP P7 1
Operator: samv

Submitter: 102
File: C:\cygwin\home\samv\development\32bitp...\manual-reports.SMP

Started: 2011-05-09 09:58:57 Analysis Gas: CO
Completed: 2011-05-09 20:39:32 Analysis Temperature: 35.0 °C

Report Time: 2011-08-31 11:32:34 Equilibration Interval: 20 s
Sample Mass: 0.7024 g Low Pressure Dose: 0.0002 mmol/g

Measured free space: 25.1639 cm³ Thermal Correction: No

Pressure (kPa)
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Options Report

Page 1

Micromeritics Instrument Corporation

Page 1
ChemiSorb HTP Version 1.01 ChemiSorb HTP Version 1.01 S/N: 102, Unit: 1, Port: 1 Page 1

Sample: CO Pt-Al LP P7 1
Operator: samv

Submitter: 102
File: C:\cygwin\home\samv\development\32bitp...\manual-reports.SMP

Started: 2011-05-09 09:58:57 Analysis Gas: CO
Completed: 2011-05-09 20:39:32 Analysis Temperature: 35.0 °C

Report Time: 2011-08-31 11:32:34 Equilibration Interval: 20 s
Sample Mass: 0.7024 g Low Pressure Dose: 0.0002 mmol/g

Measured free space: 25.1639 cm³ Thermal Correction: No

Options Report

Task Summary
Task Number Task Name  Gas Temperature

(°C)
Rate (°C/min) Time (min) Pressure

(kPa)
Flow Rate

(sccm)

    1 Evacuation 110.0 10.0    30
    2 Flow H2 100.0 10.0    10 50.0
    3 Flow H2 400.0 10.0    30 50.0
    4 Evacuation 400.0 10.0    30
    5 Evacuation 35.0 100.0    60
    6 Leak Test 35.0 10.0
    7 Evacuation 35.0 10.0    20
    8 Analysis CO 35.0 10.0

Task Number: 8
Adsorptive: Carbon Monoxide

Temperature: 35.0 °C
Heat rate: 10.0 °C/min

Relative target tolerance:   5.0 %
Absolute target tolerance: 0.6666 kPa

Use maximum volume increment: No
Incremental dosing: Yes

Dose amount: 0.0002 mmol/g
Repeat analysis: Yes
Evacuation rate: 6.67 kPa/s

Unrestricted evac. from: 4.00 kPa
Evacuate for 60 minutes below 1.3 Pa.

    
Free space group: Measured

Evacuation rate: 6.67 kPa/s
Unrestricted evac. from: 4.00 kPa
Evacuate for 60 minutes below 1.3 Pa.

Estimated free space: 25.0000 cm³

Equilibration
Pressure

(kPa)
Equilibration
Interval (s)

119.9901600    20

Experiment Log
Task

Number
Task

Name
Start
Time

(h:min)
Gas

Sample
Temp.
(°C)

Time
(min)

Pressure
 (kPa)

    1 EVAC 0:03 109.9    40
    2 FLOW 0:44 H2 98.3    12 739.71576
    3 FLOW 0:56 H2 400.2    60 739.61572
    4 EVAC 1:56 400.0    45
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Page 2

Micromeritics Instrument Corporation

Page 2
ChemiSorb HTP Version 1.01 ChemiSorb HTP Version 1.01 S/N: 102, Unit: 1, Port: 1 Page 1

Sample: CO Pt-Al LP P7 1
Operator: samv

Submitter: 102
File: C:\cygwin\home\samv\development\32bitp...\manual-reports.SMP

Started: 2011-05-09 09:58:57 Analysis Gas: CO
Completed: 2011-05-09 20:39:32 Analysis Temperature: 35.0 °C

Report Time: 2011-08-31 11:32:34 Equilibration Interval: 20 s
Sample Mass: 0.7024 g Low Pressure Dose: 0.0002 mmol/g

Measured free space: 25.1639 cm³ Thermal Correction: No

Experiment Log
Task

Number
Task

Name
Start
Time

(h:min)
Gas

Sample
Temp.
(°C)

Time
(min)

Pressure
 (kPa)

    5 EVAC 2:41 35.2   107
    6 LEAK 4:29 35.1     0 0.03048
    7 EVAC 4:29 35.1    20
    8 ANL 4:55 CO 35.0   275

Leak Test Results
Start Time (min) Maximum

Allowed Outgas
Rate (Pa/min)

Observed
Outgas Rate

(Pa/min)

Status

4:29   1.3   0.06 Pass

2
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ChemiSorb HTP Description
8.  OPTIONS MENU

The commands on the Options menu allow you to configure the system to your laboratory’s 
requirements and specify defaults for sample and parameter files.

Description

Option Presentation Allows you to display the sample file dialog in Advanced, 
Basic, or Restricted format. Page 8-2.

Sample Defaults Enables you to specify default values for sample and 
parameter files. Page 8-6.

Active Metals Defaults Allows you to specify options for the chemisorption 
elements. Page 8-12.

Gas Defaults
MFC Constants

Enables you to specify options for the adsorptives. Page 8-14.

Units Allows you to choose the types of units to use for 
measurement, pressure, and temperature. Page 8-16.

Graph Grid Lines Enables you to choose the types of grid lines to display for 
the X- and Y-axes. Page 8-16. 

Thermal Transpiration
on Live Graph

Enables you to apply thermal transpiration to the current 
graph. Page 8-17.
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Option Presentation ChemiSorb HTP
Option Presentation

The sample editing dialogs for the ChemiSorb HTP analysis program may be presented in 
three modes: Restricted, Basic, and Advanced. 

Each format displays sample information and menu options differently.

• Advanced: displays all parts of the sample information file in a tabbed dialog similar 
to that of an index card file.

• Basic: displays all parameters of the sample file in a single dialog. 

• Restricted: displays in the same manner as the Basic format, except that some options 
are disabled.

Parameter Files Directory Allows you to specify a location for the parameter files used 
in the Basic and Restricted sample file dialogs. Page 8-17.

Service Test Mode Enables you to perform certain troubleshooting procedures. 
This option is available only under the direction of a 
Micromeritics service representative. Page 8-17.
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ChemiSorb HTP Option Presentation
Advanced

The Advanced format presents all parts of the sample information file in a tabbed dialog. Each 
tab opens its associated dialog. For example, if you wish to open or create a sample file using 
the Advanced format, the following dialog is displayed. 

The Advanced format is used to create customized sample files and edit values in parameter 
files. You can also switch to the Basic format by clicking the down arrow next to Advanced 
and selecting Basic. Refer to Advanced Format, page 5-5 for a detailed description of this 
dialog.

If Manually entered data is 
selected, an Entered Data tab 
also displays. 

If Automatically collected is 
selected, a Collected Data tab 
displays after analysis.
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Basic

The Basic format presents the sample information file and its parameter files as a single dia-
log. For example, if you wish to open or create a sample information file using the Basic 
format, the dialog is displayed in this manner.

The Basic format is used to quickly create sample information files using previously defined 
parameter files. You can easily switch to Advanced format by clicking the down arrow next to 
Basic and selecting Advanced. Refer to Basic Format, page 5-8 for a detailed description of 
this dialog.
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Restricted

The Restricted format is identical to the Basic format, except that certain options are disabled 
and you cannot switch to the Advanced format. 

This format is password-protected and is typically used in laboratories where analysis condi-
tions must remain constant, for example, in the pharmaceutical industry.

When you select Restricted, a dialog prompting you to enter a password is displayed.

You can enter any password (up to 31 characters) to enable the Restricted format. You must 
enter the same password to exit the Restricted format. For example, if you enter “password” to 
enable the Restricted format, then you must enter “password” to exit. If you forget the pass-
word, open the system INI file and navigate to the Private section. The current password is 
shown immediately following “OptionPresentationPassword.” Make a note of the password, 
exit the INI file, and enter the password where requested. Deleting the password from the INI 
file will not disable the Restricted mode; you must enter the password using the Password dia-
log to exit the Restricted format.
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Sample Defaults ChemiSorb HTP
Sample Defaults

This option allows you to specify default parameters for sample information files. This option 
is presented in two formats: Advanced and Basic. Select Options > Option presentation to 
choose the format you wish to use. Alternatively, you can switch between the two formats 
using the Advanced / Basic toggle push button displayed on the lower right side of the dialog.

Advanced

The Advanced Sample Defaults dialog resembles a set of index cards. The values you specify 
in the parameter portions of the sample file (Analysis Conditions and Report Options) are 
saved as the defaults for newly created parameter files.

For example, after specifying defaults for a sample file in the Advanced format:

• Select File > Open > Sample Information, then click Yes to create the file, and the 
defaults you specify display for all parameters. 

• Select File > Open > Analysis Conditions, name and create the file, and the defaults 
you specify in the Analysis Conditions portion of the Advanced Sample Defaults dia-
log display in the fields

The Advanced Sample Defaults dialog displays in this manner:
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ChemiSorb HTP Sample Defaults
Sequence Allows you to specify a default sequence for the sample file 
name. The number you specify is sequenced incrementally 
each time you create a sample file. It is the number that 
appears in the File name field when you select File > Open > 
Sample information.

• Use numbers, letters, or other printable characters, such 
as dashes. At least three numbers must be included.

Sample Allows you to enter an additional identification. 

In the field on the left, edit the prompt for Sample if you 
wish. For example, you may prefer to use Test or Material.

In the field on the right, enter a default identification.

• Use the $ symbol to have the automatically generated file 
number/name included in the identification. Enter the $ 
symbol where you want the sequence number/name to 
appear.

For example, if the sequence number is 000-001, enter 
the identification as follows:

Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

Lab #25 - 000-001

for the second file:

Lab #25 - 000-002, and so on.

If you have added an additional name to the sequence num-
ber, the entire string will appear. 

Operator
Submitter
Bar code

These fields enable you to enter defaults for the operator, 
submitter, and bar code information. 

The fields on the left can be edited to display a different 
label for the prompts if desired.
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Sample Defaults ChemiSorb HTP
Click on each remaining tab of the Advanced Sample dialog to establish parameter defaults. 
Refer to the appropriate page as indicated below if you need assistance on the fields of the 
dialogs.

• Analysis Conditions, page 5-12
• Report Options, page 5-25

Operator
Submitter
Bar code
(continued)

The fields on the right allow you to specify default names or 
titles, and bar code information.

• Include the automatically generated file number/name as 
part of the identification by using the $ symbol where 
you want the name to appear

• Select Omit adjacent to any field you wish to omit from 
displaying on the sample information dialog.

Mass You can choose to enter a sample mass or have the mass auto-
matically calculated. Regardless of which option you choose 
for your default, you can change it in the sample file.

Enter Enables the Sample Mass field allowing you to enter a 
default value.

Calculate Enables the Empty tube and Sample + tube fields, allowing 
you to enter default values. These values are used to calculate 
the mass of the sample, 
               

Replace All Allows you to replace the contents of all parameter files 
contained in the current default sample file with those from 
an existing sample file. For example, you may have an 
existing sample file that contains most (or all) of the 
parameters that you wish to use. You can click this push 
button, choose the file, and then click OK. All parameters of 
the file you choose are copied into the sample defaults dialog. 

Save Saves the current values as the defaults.

Close Closes the dialog.

Basic Switches the sample editor to the Basic format.

Masssample Masssample tube+ Masstube–=
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ChemiSorb HTP Sample Defaults
Basic

The defaults you specify for the Basic format also serve as the defaults for the Restricted 
format. 

The Basic Sample Defaults dialog displays in this manner.

Sequence Allows you to specify a default sequence for the sample file 
name. The number you specify is incrementally sequenced 
each time you create a sample file. It is the number that 
appears in the File name field when you select File > Open > 
Sample information.

You can use numbers, letters, or other printable characters, 
such as dashes. At least three numbers must be included.

Sample Allows you to enter an additional identification that provides 
more information than the sample file name itself. 

You can edit the Sample prompt if desired. For example, you 
may prefer to use Test or Material.
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Sample
(continued)

Enter a default identification if desired. You can edit the 
default identification in the sample file to make it unique, or 
you can leave the default identification blank and enter the 
identification in the sample file when created.

Include the automatically generated file name as part of the 
identification by using the $ symbol where you want the 
name to appear.

For example, if the name is 000-001, enter the 
identification as follows:

Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

Lab #25 - 000-001

for the second file:

Lab #25 - 000-002, and so on.

If you have added an additional name to the sequence num-
ber, the entire string will appear. 

Operator This field enables you to enter a default name for the 
operator. You can also edit the prompt if desired.

Select Omit adjacent to the field if you do  not wish to have 
the field display on the sample information dialog.

Mass You can choose to enter a sample mass or have the mass auto-
matically calculated. Regardless of which option you choose 
for your default, you can change it in the sample file.

Enter Enables the Sample Mass field allowing you to enter a 
default value.

Calculate Enables the Empty tube and Sample + tube fields, allowing 
you to enter default values. These values are used to calculate 
the mass of the sample, 

               Masssample Masssample tube+ Masstube–=
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ChemiSorb HTP Sample Defaults
Analysis Conditions
Report Options

Each parameter has a drop-down list containing predefined 
parameter files. Several default files are included with the 
analysis program. For files to appear in this drop-down list, 
they must be saved to the Parameter Files directory; the 
default directory is params. Refer to Parameter Files Direc-
tory, page 8-17 for additional information.

Replace All Use this push button to replace the current default values with 
those from an existing sample file.

Save Saves the current definition as the defaults.

Close Closes the dialog.

Advanced Switches the sample editor to the Advanced format.
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Active Metals Defaults ChemiSorb HTP
Active Metals Defaults

This option enables you to specify characteristics for up to twenty elements. You must enter at 
least one element in the table.

Element Displays the element. You may insert or delete as desired. 
Refer to Appendix E, page E-1 for a list of elements. This 
appendix provides a list of elements, their atomic weights, 
cross-sectional area, and density.

Atomic Weight The atomic weight of the element.

Atomic Cross. Sect. 
Area (nm2)

The atomic cross-sectional area of the element.

Density The density of the element.

% of Sample Weight The percentage of element contained in the sample.
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ChemiSorb HTP Active Metals Defaults
Adsorptive Enables you to specify adsorptive properties for a selected 
element; displays the Adsorptives dialog for the selected 
element (in this example, chromium is shown).

Adsorptive Gases shown in the list are the ones specified in the Gas Table 
Defaults dialog. Refer to Gas Defaults / MFC Constants, 
page 8-14 for information on adding gases.

Stoichiometry Factor A factor which expresses the ratio between the number of 
active metal molecules and the number of adsorbate 
molecules. This value is used in report calculations but not in 
the analysis itself.

Insert Inserts a row above the selected row, allowing you to enter a 
new element to the table.

Delete Deletes the selected row.

Clear Clears the table of all entries except one; one is required.

Append Adds a row at the end of the table.
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Gas Defaults / MFC Constants ChemiSorb HTP
Gas Defaults / MFC Constants

In order to characterize the gases used in an analysis, a symbol and a Mass Flow Controller 
(MFC) Constant must be defined. A table containing default gases and values is provided on 
the Options menu.

The gases contained in this table display in the drop-down lists for assignment to the gas ports 
(refer to Unit Configuration, page 6-26).

Gas Lists the name of the gas.

Symbol Lists the standard symbol (mnemonic) for each gas.

MFC Constant Contains the MFC Conversion Constant for each gas listed. 
This constant allows the MFC to control the gas flow 
precisely. If this number is incorrect, the actual flow rate for 
that gas differs from the rate reported.

This value defaults to 1 when a new gas is listed. You must 
enter the correct gas constant. A table of MFC conversion 
constants is provided in Appendix C, page C-1. If you are 
using a mixture of gases, you can determine an MFC 
Constant using the instructions in Appendix C.

In general, the MFC conversion constants provided with the analyzer are accurate 
and should be used. 

Hard-sphere Diameter Lists the hard-sphere diameter of the gas molecule. 
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ChemiSorb HTP Gas Defaults / MFC Constants
Compressibility File Displays the path and name of the current compressibility file 
for the gas.

Insert Inserts a row in which to enter a new gas and its values; the  
row is inserted before the selected row. 

Delete Deletes the selected row. No confirmation is provided. If you 
delete a row in error, click Cancel to close the dialog and 
void the deletion; all other edits will be discarded as well.

Clear Clears all but one entry of the table, after confirmation. One 
entry is required.

Append Adds a row at the end of the table in which to enter a new gas 
and values.

Compressibility Factor File Compressibility factors compensate for the forces of attrac-
tion between molecules in a real gas. Each gas compatible 
with the analyzer has a compressibility factor table.

Open Enables you to load the compressibility table for the selected 
gas; the Open Compressibility Factor Table dialog is dis-
played. 

Highlight the file containing the mnemonic for the selected 
gas, then click Open.

Save As Enables you to save the compressibility factor table as a dif-
ferent name. The Save Compressibility Factor Table dialog is 
displayed (identical to the above), allowing you to enter a file 
name.

Delete Removes the compressibility data from the selected gas.
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Units ChemiSorb HTP
Units

This menu command displays the Units Selections dialog which allows you to choose the 
manner in which to display data on dialogs and in reports. 

Graph Grid Lines

Graph Grid Lines enables you to choose the type of grid lines to show on your reports; the 
Graph Grid Lines dialog is displayed.

X-Axis
Y-Axis

Enables you to choose Major and/or Minor lines to 
display in printed reports for the Logarithmic and Linear 
scales. 

If you deselect these items (remove the check marks), 
your report will not display grid lines.

Grid Line Style Allows you to choose the type of grid line to display if 
grid lines are being shown.
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ChemiSorb HTP Thermal Transpiration on Live Graph
Thermal Transpiration on Live Graph

Select this option to apply thermal transpiration to pressure in the live graph (refer to page 5-
29 for additional information on thermal transpiration). 

Parameter Files Directory

This option allows you to specify a location for the predefined Analysis conditions and Report 
options files displayed in the drop-down lists on the Basic and Restricted Sample Information 
dialogs.  

When you select this option, the Parameter File Directory Selection dialog is displayed.

The directory specified here is the one you should use when creating parameter files to be 
included in the drop-down lists on the Basic and Restricted sample information dialogs. It is 
where the software looks to retrieve files for the drop-down lists. The default directory is 
PARAM and includes several parameter files supplied with the analysis program. If you spec-
ify a different directory, these files will not be included in the drop-down lists unless you copy 
(or move) them to the new directory.

If you wish to continue to use the PARAM directory for parameter files, it will display as the 
default when saving parameter files.

Service Test Mode

Various service tests are included in the ChemiSorb application. These tests can be performed 
only with the assistance of a trained Micromeritics service representative. When you select 
Options > Service Test Mode, a dialog prompting you to enter a password is displayed. This 
password is coded to change on a regular basis. You must contact your local service represen-
tative to obtain the correct password. You will not be able to perform these tests without his 
guidance. 
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ChemiSorb HTP Troubleshooting
9.  TROUBLESHOOTING AND MAINTENANCE

The ChemiSorb system has been designed to provide efficient and continuous service. How-
ever, certain maintenance procedures should be followed to obtain the best results over the 
longest period of time. 

Troubleshooting

What Happened Why What To Do

Vacuum pump is noisy Sample tube fitting or connector 
nuts are loose.

Turn the connector nuts 
clockwise to tighten.

Sample tube is cracked. Replace with a new sample tube.

A gas inlet valve is open while 
the vacuum valve is open.

Enable manual control, then use 
the instrument schematic to close 
the gas inlet valve. Refer to 
Enable Manual Control, page 
6-13.

Furnace cannot be 
raised (or lowered).

Possible obstruction. Check for and correct any 
obstruction that may be in the 
path of the elevator.

Valves cannot be 
operated.

Ethernet cable from the computer 
to the instrument is loose.

Ensure the ethernet cable is 
seated securely.

High-vacuum pump 
indicator light is not on

No power to the pump. Restore power to the pump.

Pump slowed down evacuating a 
large gas volume. It should turn 
on the indicator light after 
accelerating again.

Wait 5 minutes for the pump to 
speed up. 

If power is not restored, refer to 
the causes for Vacuum pump is 
noisy above.
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Preventive Maintenance ChemiSorb HTP
Preventive Maintenance

The table below lists the preventive maintenance procedures you should complete to keep 
your analyzer operating at peak performance. Instructions for each procedure follow the table. 
Micromeritics also recommends that you have preventive maintenance procedures and cali-
bration performed by one of our service representatives every 12 months.

Maintenance Required Frequency

Clean the outside of the analyzer, page 9-4 As required or every 6 months

Replace sample tube O-ring, page 9-4 As required or every 6 months

Replace port filters and O-rings, page 9-6 As required or every 6 months

Inspect and change vacuum pump fluid, page 9-9 As required or every 3 to 6 months

Replace alumina in oil vapor traps, page 9-12 As required

Lubricate elevator drive assembly, page 9-3 Every 12 months

Perform a reference material analysis As required or every 3 months
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ChemiSorb HTP Preventive Maintenance
Lubricating Elevator Drive Assembly

The elevator screws should be greased annually to maintain smooth movement of the elevator. 

1. Remove the middle panel on the back of the analyzer by loosening, then removing the 
retaining screws.

2. Apply a light coat of lithium grease at the base of all six elevator screws.

3. Using the Up and Down push buttons on the front panel of the analyzer, raise and lower 
each of the elevators 2 or 3 times to distribute the grease evenly. 

4. Wipe away any excess grease at the base of the elevator screws.

5. Replace the back panel.

Apply grease here
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Preventive Maintenance ChemiSorb HTP
Cleaning the Analyzer

The exterior casing of the analyzer may be cleaned using a clean cloth, dampened with isopro-
pyl alcohol (IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type 
of abrasive cleaner.

Clean the shield only with mild soap and water. Do not use glass cleaner, ammonia, IPA, or 
acetone.

Replacing the Sample Tube O-rings

It is important to maintain a vacuum-tight seal near the top of both sample tube stems (analysis 
and exhaust). If an O-ring becomes worn or cracked, it does not provide a good seal and will 
need to be replaced. 

1. Make sure the analysis port (sample valve) is closed and the furnace is in its lowest 
position. 

2. Place something on top of the furnace area to prevent anything from falling into the 
furnace. 

3. Holding the sample tube firmly with one hand, loosen the connector nuts for the sample 
tube and the exhaust tube by turning counterclockwise.

4. Finish unscrewing the connector nuts, being careful not to let them drop onto the bottom 
of the tube.

Do not allow liquid to penetrate the casing of the analyzer. Doing so could result in 
damage to the unit.

Before removing (or installing) a sample tube, ensure that the port valve is closed. 
Observe the instrument schematic to verify valve status and sample backfill. 

Be careful not to let the sample tube connector nuts drop onto the bottom of the tube 
as it may break the tube.
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5. Carefully pull the sample tube down until it is free from the port. 

6. Remove the filler rod from the sample tube. Then remove the O-rings from the sample 
and exhaust tubes and replace with new ones.

7. Replace the filler rod, then insert the sample tube back into the sample and exhaust ports 
until it is fully seated.

8. Slide the connector nuts up the tubes (the ferrule and O-ring will move along with the 
connector nut). Then, turning clockwise, hand-tighten the connector nuts for the sample 
and exhaust tubes. 

 

Connector nut

Connector nut

Ferrule

Ferrule

O-ring

O-ring

Filler rod

Sample tube Exhaust tube
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Replacing the Port Filters and O-rings

Using a contaminated filter on the analysis port may extend the time required to achieve a vac-
uum at that port. More importantly, the contaminant may adsorb or desorb during analysis, 
affecting analysis results. A contaminated filter on the analysis port may be detected by a leak 
test (if the contaminant outgasses) or by a free space reading much lower than normal.

A 20-m filter is located in each analysis (1/4 in.) and exhaust (3/16 in.) port of the analyzer.

Perform the following steps to replace the filters:

1. Make sure the analysis port (sample valve) is closed and the sample tubes are backfilled 
with a safe gas. 

2. Lower the furnace and remove the sample tube. 

3. Place something on top of the furnace area to prevent anything from falling into the 
furnace. 

4. Loosen the three captive retaining screws underneath the grill, then pull down to remove 
the grill from the top panel.

5. Using a wrench, loosen the sample and exhaust tube fittings. 

6. Unscrew and remove the exhaust tube fitting from its connector. Lay it aside until you 
have removed the sample tube fitting. 

7. Slide the exhaust valve from its retaining bracket; move it out of the way of the sample 
tube fitting. Do not disconnect any wiring or tubing.
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8. Slide the foam insulator down from the top of the fitting, unscrew the sample tube fitting, 
and remove the fitting from its connector. Screw the red cap (provided in the accessories 
kit) on the end of the fitting to prevent contamination from the insulator; be sure the cap is 
clean.

9. Pull the port fitting down and remove the foam insulator. Then unscrew the cap and 
completely remove the port fitting from the analyzer.

10. Remove the O-rings and filter frits from the sample and exhaust port fittings and replace 
with new ones (extra O-rings and filter frits are provided in the accessories kit).

Occasionally, the O-ring and/or filter will remain in the port. Use a pointed plastic tool to 
gently dislodge from the port. Be careful not to scratch or contaminate the manifold.

11. Clean both port fittings with acetone or alcohol.

O-ring

Filter frit
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12. Reinstall the Sample port fitting first.

a. Insert the clean fitting through the opening and screw on the red cap (to maintain
cleanliness of the O-ring and filter).

b. Slide the foam insulator onto the port fitting.

c. Pull the foam insulator down and remove the red cap.

d. Insert the port fitting into its connector, then release the insulator. Do not allow the 
insulator to touch the top of the fitting.

e. Screw the port fitting onto its connector until it is fully seated, then tighten with the
wrench to prevent leaks when evacuated.

13. Slide the exhaust valve back into its retaining bracket and reinstall the exhaust port 
fitting.

14. Reinstall the grill on the front panel; hand-tighten the retaining screws.
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Inspecting and Changing Vacuum Pump Oil

The oil in the vacuum pump should be changed every three months, when the efficiency of the 
vacuum pump declines (requiring increased time to reach vacuum levels), or if it becomes dis-
colored. The oil is easily inspected to determine if a change is necessary.

Inspecting the Oil

View the vacuum pump oil through the oil-level window. The oil level should be midway 
between the indicators on the oil-level window. Oil in good condition is clean, clear or light in 
color, and transparent. 

• Change the oil if it has darkened
• Add oil if it is below the midway level

Changing or Adding Oil

Use oil supplied by Micromeritics, or refer to the vacuum pump manual for other acceptable 
oils.

1. Unplug the vacuum pump from the power source.

2. Loosen the wing nut on the clamp at the top of the oil vapor trap. Swing the clamp open 
and remove the trap from the hose.

Oil-level window

Always drain the vacuum pump while the pump is warm and disconnected from the 
power source.
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3. Grasp the handle on top of the vacuum pump and place it on a work table.

4. Drain the used oil: 

a. Place a waste container under the drain spout.

b. Remove the plug from the drain spout; allow the oil to drain into the waste container.

d. Replace the drain plug.

5. Remove the plug from the oil-fill port.

If you are adding oil, skip this step and continue with Step 5.

Oil-fill port
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6. Slowly add oil to the port until the level is midway between the indicator lines in the oil-
level window.   

7. Check the washer or O-ring used at the oil-filling port; replace if necessary. 

8. Insert the oil-fill plug and turn counterclockwise to tighten.

9. Check the alumina in the oil vapor trap. If most of the pellets are no longer white, replace 
the alumina in the oil vapor trap before reattaching the vacuum pump. Refer to Replacing 
the Alumina in the Oil Vapor Trap, page 9-12 for instructions.

10. Reconnect the vacuum pump hose.

11. Reconnect the power cord to the power source.

12. Allow the pump to run a few hours (overnight if possible) to eliminate air and moisture 
from the fresh fluid and to produce efficient vacuum operations.

Midway level

Do not allow oil to rise above the midway position. Doing so may cause oil to splash 
into the oil filter and contaminate it.
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Replacing the Alumina in the Oil Vapor Trap

The activated alumina in the oil vapor trap becomes saturated during use. The alumina should 
be inspected periodically and replaced when most of the alumina pellets are no longer white. 

1. Loosen the wing nut on the clamp at the bottom of the oil vapor trap. Swing the clamp 
open and remove the trap. 

2. Remove one end fitting from the trap body; dispose of the used alumina in an appropriate 
manner.

3. Wash the trap body with a detergent-based soap. Rinse with water, then with isopropyl or 
ethyl alcohol. Set the trap aside and allow to dry thoroughly.

Do not perform the following procedure on used alumina. The resultant oil vapors may 
cause a fire or an explosion.

 

Exposure of the trap body to oil vapor may cause small cracks on the inside surface of 
the trap body. Under normal circumstances, these cracks will not cause problems or 
leaks.
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4. Prepare fresh alumina as follows:

a. Preheat the oven to 300 °C.

b. Pour approximately 180 grams of fresh alumina into a glass or metal container for 
(approximately 250 mL if a graduated beaker is used). Place the container in the 
oven.

c. Bake the alumina for two hours.

d. Remove the baked alumina from the oven and allow it to cool until luke warm. A 
desiccator may be used to speed the cooling process.

5. Using a small spatula, gently pry the O-ring from the end fittings of each end of the trap 
body.

6. Inspect the O-rings.

• If dusty, clean with a lint-free tissue.
• If damaged, replace with a new O-ring.

7. Screw one of the end fittings onto the trap body.
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8. Be sure the trap body is dry and the alumina is lukewarm; pour the alumina pellets into the 
trap until they are level with the top of the trap body.

9. Screw the other end fitting back onto the trap and tighten securely by hand. 

10. Lightly tap both ends of the trap body on the work surface. This will remove any 
remaining dust from the pellets.

11. Make sure the centering ring is in place on the intake port.

12. Place the trap on the centering ring.

Centering Ring
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13. Open the clamp and place it around the flange of the intake port and the flange of the trap. 
Swing the clamp fastening screw toward the intake port until it fits into the slot in the 
other half of the clamp. Tighten the wing nut securely by hand.

14. Reconnect the hose from the analyzer to the oil vapor trap.

a. Place the clamp around the flange of the vacuum pump hose and vapor trap.

b. Swing the clamp fastening screw around until it fits into the slot on the other half of the 
clamp. Tighten the wing nut securely by hand.

15. Plug the pump power cord into the power source.

16. Allow the pump to run a few hours (overnight if possible) to eliminate air and moisture 
from the fresh oil and to produce efficient vacuum operations.
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Connecting Gases

This section includes instructions for attaching gas bottles to the instrument.

Guidelines for Connecting Gases to the Analyzer

Use these guidelines when installing regulators and gas lines:

• Place gas bottles close to the analyzer. Using gas line extenders on gas bottles located in 
remote areas may degrade gas quality and reduce pressure.

• Use a retaining strap (or other appropriate tether) to secure the gas bottle.

• Carefully route the gas lines from the bottle to the analyzer, avoiding overlapping or 
entangling gas lines.

• Label the gas line at the instrument inlet for proper identification and maintenance.

• Ensure that the gas bottle is closed before connecting to the analyzer.

• Use 70 psi to 120 psi dry air or other dry inert gas.

The instructions below describe a typical installation. Some configurations require additional 
components, such as regulator expansion kits, when one gas source will be used for several 
operations or when the gas bottle cannot be located close to the analyzer.

Disconnecting the Depleted Bottle

1. Close the gas bottle shut-off valve, then open the regulator shut-off valve.

If using house air, it must be dried before entering the instrument.

Gas Bottle 
shut-off valve

Regulator 
shut-off 
valve
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2. Both gauges should read at or near zero; if not, disconnect the gas line from the regulator 
and allow the pressure to purge from the lines.

3. Use an appropriate wrench to loosen the nut at the regulator/gas bottle connection, then 
remove the regulator from the bottle.

You do not have to disconnect the gas line from the regulator or the instrument.

4. Replace the protective cap on the depleted bottle, disconnect the retaining strap, and 
remove the bottle from its current location.

Connecting a Replacement Gas Bottle

Move the replacement bottle close to the instrument and tether it into place.

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement 
bottle.

When connecting hazardous gases, be sure to vent properly and follow the safety 
procedures established for your lab.
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2. Attach the gas regulator to the connector on the gas bottle. Hand-tighten the nut, then use 
an appropriate wrench to tighten an additional 3/4 turn.

3. Check for leaks at the high-pressure side of the regulator and in the connector.

a. Turn the regulator control knob fully counterclockwise.

b. Slowly open the gas bottle shut-off valve, then close it.

c. Observe the pressure on the high-pressure gauge. 

• If the pressure is stable, proceed with the next step. 
   • If the pressure decreases, tighten the regulator connector nut until it becomes stable. 

4. Purge the air from the lines.

Do not overtighten the fitting; doing so may cause a leak.

Regulator 
Control knob

HIgh-pressure Gauge

Regulator 
connector nut

Gas Bottle 
Shut-Off valve

Regulator 
Shut-Off 
valve

Gas Bottle 
Shut-Off valve
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a. Turn the regulator shut-off valve counterclockwise to open.

b. Open the gas bottle shut-off valve to flow gas.

c. Close the regulator shut-off valve to stop flow.

d. Close the gas bottle valve.

5. Set the instrument pressure.

a. Turn the regulator control knob clockwise until the low-pressure gauge reads 22 psig 
(152 kPag).

b. Open the regulator shut-off valve.

c. Open the gas bottle shut-off valve and flow gas for 10 to 30 seconds.

d. Close the gas bottle shut-off valve.

6. If you disconnected the gas line to the instrument inlet, reconnect it now.

7. If you connected the same gas as the one you removed, you are ready to resume 
operation.
If you connected a different gas than the one you removed, you must specify the change; 
refer to Specifying Gas Ports, page 9-20.

Regulator 
Control knob

Low-pressure Gauge

Regulator 
Shut-Off 
valve

Gas Bottle 
Shut-Off valve
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Specifying Gas Ports

The ChemiSorb has gas inlets for up to 12 analysis gases. The gases you connect to the inlets 
must be specified in the analysis program. If you change gases on one of the inlets, you must 
edit the gas assignment as well. It is very important that the analysis program be kept informed 
of any change in gases.

1. Select Unit [n] > Unit Configuration; the Unit Configuration dialog is displayed.

2. Click the Gas button in the Configuration group box; the Gas Configuration dialog is 
displayed.

3. Click the down arrow at the appropriate port and choose the gas you attached to the port 
from the list.

4. Click OK to save the selections and close the Unit Configuration dialog.
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10.  ORDERING INFORMATION

Use one of the following methods to order components and accessories for the ChemiSorb HTP 
system:

• Call our Customer Service Department at (770) 662-3636
• Email orders to orders@micromeritics.com
• Contact your local sales representative

Please use the following information to place an order.

Part Number Item and Description

Cables

003-63801-00 Ethernet cable

Gas Bottle Accessories

004-25318-00 Reducer, stainless steel; 1/8 in. tube × 1/4 in. tube, accepts 1/8 in. tube, connects 
to 1/4 in. swage fittings

004-25549-00 Reducer, brass; 1/8 in. tube × 1/4 in. tube, accepts 1/8 in. tube, connects to 1/4 in. 
swage fittings

004-33601-00 Expansion Kit; adds an additional outlet to the gas regulator, includes fittings and 
instructions

004-33602-00 Pressure Relief Kit; prevents excessive gas pressure in the event of regulator 
failure (not to be used with noxious gases)

004-62230-32 Gas pressure regulator, CGA 320 fitting (CO2), 30 psig

004-62230-35 Gas pressure regulator, CGA 350 fitting (CO, H2), 30 psig

004-62230-54 Gas pressure regulator, CGA 540 fitting (O2), 30 psig

004-62230-58 Gas pressure regulator, CGA 580 fitting (Ar, He, Kr, N2), 30 psig

201-25818-00 Gas inlet line assembly, stainless steel, 1/8 in. diameter, 6 ft. long

201-25818-01 Gas inlet line assembly, stainless steel, 1/8 in. diameter, 16 ft. long
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290-25846-00 Copper tube, for gas inlet, 1/8 in. diameter × 6 ft. length

290-25846-01 Copper tube, for gas inlet, 1/8 in. diameter × 16 ft. length

Miscellaneous

004-32187-00 Gloves, cotton insulated

248-31702-00 Insulator disk, for oven, top

248-31706-00 Insulator disk, for oven, bottom

248-32701-00 Shield, for furnace

Operating Supplies

003-22633-02 Valve plunger for x-valve

003-53048-07 Thermocouple

004-25011-01 O-ring, -011 KALREZ, for x-valve manifold

004-25105-00 Front ferrule for exhaust line

004-25106-00 Rear ferrule for exhaust line

004-25158-00 Tool, for x- valves, 3-way

004-25474-00 O-ring, -013 KALREZ, for x-valve manifold

004-28410-01 Clip, for thermocouple

004-32025-00 Tubing, Tygon F-4040-A, 5/16 in. ID for instrument exhaust

004-32173-01 Tubing, Tygon F-4040-A .12 × .25 exhaust tubing from exhaust manifold to 
outside of instrument

004-62002-03 Plunger with spring 3-way valve

201-22600-00 Valve spring for mangalatch valve

248-25860-00 Tube, 3/8 D × 2.34 For exhaust

Part Number Item and Description (continued)
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248-32703-00 Mat, black, rubber, for lower shelf

250-25608-00 Valve gasket, Kel-F, for analysis manifold

250-25627-00 Valve plunger, Buna-N seal, for analysis manifold

Pneumatic Supplies

004-25681-01 Hose fitting for compressed air for furnace cooling

350-34040-00 Pneumatic Filter Assembly for air source

350-34041-00 Pneumatic Filter Assembly with water separator

Reference Materials

004-16825-00 Reference material, chemisorption

Sample Tube Accessories

004-25409-01 Cap for changing sample port frits

004-25653-00 Sample tube brush

004-32164-01 Wool, quartz, use with quartz sample tubes to constrain sample

004-54609-01 Sample tube brush for exhaust stem

004-54618-00 Tool, for removing sample port o-ring

004-54805-00 Tool, for extracting quartz wool from the sample tube

240-14855-00 Sample tube rack

240-25853-00 Sample tube funnel

248-32702-00 Quartz filter disc for sample tubes (100 per package)

280-32800-00 Sample tube support, assists sample weighing

Part Number Item and Description (continued)
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Sample Tube Components

248-61001-00 A - Sample tube, quartz

248-61004-00 B - Hanging filler rod, quartz

004-25466-00 C - O-ring, size -010, Buna-N; for sample tube exhaust

004-27041-00 D - Port filter, 20 m, 1/4 in. diameter

004-25044-00 E - O-ring, size -013, Buna-N, for sample tube

260-25843-00 F - Ferrule, 1/2 in.

300-25824-00 G - Sample port connector nut

240-32000-00 H - Stopper, for 1/2 in. sample tube

004-25673-00 I - O-ring, size -008, Kalrez

Part Number Item and Description (continued)
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004-27056-00 J - Exhaust filter, 20 m, 3/16 in. diameter

275-25803-00 K - Ferrule, 1/4 in. stainless steel

201-25822-00 L - Exhaust nut

004-32604-08 M - Cap (stopper), for 1/4 in. sample tube

Software and Manuals

248-20800-00 ChemiSorb HTP - current version software

248-33001-00 ChemiSorb HTP - Operator Manual and current software

248-42800-00 ChemiSorb HTP - Operator Manual

Vacuum Pump and Accessories

004-16003-01 Oil, vacuum pump, 1 liter

004-16830-00 Alumina

004-25630-00 Centering ring NW 16, for alumina trap

004-25653-00 Ring, centering, NW 16/10, for alumina trap

004-28998-02 Hose clamp, for vacuum pump

004-32025-00 Tubing, Tygon 5/16 ID, for vacuum pump exhaust

200-25879-00 Assembly, funnel

202-25814-00 Fitting, Adapter KF16, for vacuum pump exhaust

Part Number Item and Description (continued)
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A.  ERROR MESSAGES

Error messages are listed numerically. If the Action response instructs you to contact your 
service representative, record the error message and make backup copies of any files involved 
in the operation.

2200 and 2400 Series

2201- Cannot execute report subsystem.

2401- FATAL ERROR: (error message)

2430- Error accessing file (file name), error code = (number). 

Cause: Start Report failed to execute the report subsystem (which is a separate 
process).

Action: Restart the computer. If the problem persists, reinstall the application (this 
will not affect any of your sample files). If the problem continues, contact 
a Micromeritics service representative.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause A: Media may be damaged.

Action A: Clean the media drive. If this does not eliminate the problem, attempt 
operation using a backup copy of the file.

Cause B: Hard disk may be damaged.

Action B: Contact your service representative.
 248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01                                               A-1 



Appendix A ChemiSorrb HTP
2431- Error writing file (file name), error code = (number).

2432- Invalid response from MMI ‘FILE_READ’ request.

2433- New entries have been found in this directory. Refresh the directory 
information?

Cause C: A software error occurred when the file was accessed.

Action C: Contact your service representative.

Cause: The hard disk does not have enough space left to perform the operation.

Action: Copy files not used regularly from the hard disk to a portable media 
drive or network directory, delete them from the hard disk, and then try 
the operation again.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: Program files (sample information, analysis conditions, or report 
options) have been added to this directory by some function other than 
this application.

Action: Click Yes to update the directory information with data from each new 
file. This operation may take a minute.

Click No if you do not wish to spend the time updating the directory 
information. This option may be feasible if a large number of files have 
been copied into the directory and you know the name of the file you 
wish to access.
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2434- File (file name) — Subset # (number) wrote [nn] bytes, expected [nn] bytes.

2436- Path specification (path name) is invalid.

2437-  File (file name) does not exist.

2438- Disk drive (letter): is inaccessible.

2439- Cannot register file.
2440- Subset not found.
2441- Seek within file failed.
2442- Bad header in subset file.
2443- Subset owner denied access.
2444- Not a valid file format.
2445- Subset wrote the wrong amount of data.
2446- Error reading data.
2447- Error writing data.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: You entered an invalid path name and/or extension.

Action: Type a valid path name (including the proper extension) and press Enter.

Cause: You entered a file specification that does not exist.

Action: Enter an existing file specification or select a file name from the Files 
list.

Cause: You selected a disk drive that is not presently accessible.

Action: Ensure that the disk is not write-protected.

Cause: An unexpected error occurred when you tried to access a data file.

Action: Contact your service representative.
 248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01                                               A-3 



Appendix A ChemiSorrb HTP
2448- File directory (path name) is invalid. Resetting to the installation directory.

2449- This field does not contain a valid file specification.

2450- Sample Defaults may not be edited while this operation is in progress. Do you 
wish to save and close the Sample Defaults edit session?

2452- Attempt to write MICATTR.DIR in read only mode. (file name)
2453- Attempt to append MICATTR.DIR in read only mode. (file name)

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a 
file, use the search icon to navigate to the correct directory.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your DOS or Windows 
manual and re-enter the name.

Cause: You are in the process of initiating an automatic analysis (an analysis in 
which sample files are created using the defaults) while editing the 
defaults.

Action: Finish your edit session of the defaults and close the dialog. Then restart 
the automatic analysis.

Cause: The Read-Only attribute is turned on in the application’s 
MICATTR.DIR file (this file exists in each folder containing sample or 
parameter files).

Action: Use Windows Explorer to access the folder containing the 
MICATTR.DIR file and disable the Read-Only option.
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2454- Too many selections for a print-to-file operation. Only the first (number) selec-
tions will be processed. Please reselect the remainder.

2455- Too many selections for an export-to-file operation. Only the first (number) 
selections will be processed. Please reselect the remainder.

2456- Insufficient file handles available. Application cannot continue.

2457- Results cannot be displayed. More than (number) windows are currently dis-
playing or printing results.

2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

Cause: You selected too many files for this operation.

Action: Select only the number of files specified in the message. 

Cause: You have more than 50 files open at the same time.

Action: Refer to the manual for your operating system and set the limit for open 
files to 50 or greater.

Cause: You have too many windows open in the application.

Action: Close some of the open windows.

Cause: You attempted to exit the application while the analyzer is performing a 
critical operation. This operation must be completed before the applica-
tion can be stopped.

Action: Wait a few minutes before attempting to exit the application again.
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2459- An instrument is busy. A delay in restarting this application could result in loss 
of new data. Continue with program Exit?

2460-  Fatal Communications error on (unit n).

2461- No instruments are in operation. This application will unconditionally 
terminate.

Cause: You attempted to exit the application while an analysis is in progress. 
While this is possible, the data collected while the application is inac-
tive will not be permanently recorded until the application is re-started. 
A power failure to the instrument could cause some data to be lost.

Action: If you are not concerned with the potential for loss of data should a 
power failure occur, click Yes to continue; otherwise click No.

Cause: There was a fatal error in communication between the application and 
the software in the instrument. All displays for that instrument will be 
closed.

Action: Ensure that the analyzer is connected to the computer on the ethernet 
port configured in the Setup program. Exit the application and then 
restart it. If this error persists, contact your service representative.

Cause: At least one analyzer must be active for the application to operate. The 
initialization of the analyzers configured with the Setup program has 
failed. The application stops.

Action A: Usually this message is preceded by another message giving the reason 
for the analyzer’s failure to initialize. See the instructions for that mes-
sage. 

Action B: Check the cable connection between the analyzer and the computer. Ver-
ify that the analyzer has the power switch in the ON position and that the 
light on the front panel is illuminated. If the application continues to fail 
in its attempts to initialize the analyzer, contact your service represen-
tative.
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2477- (Unit n; Serial nn) did not properly initialize.

2478-  Error copying sequential data segment.

2479-  (Unit n; Serial nn) The instrument is busy performing an operation of which this 
application is unaware. Do you want to cancel? (Yes, No)

2480- File (file name) cannot be analyzed. It is currently being edited.

Cause: The software was unable to initialize the analyzer.

Action A: Run the Setup program and ensure that a valid ethernet port is selected; 
if not, select a valid one when prompted.

Action B: Reinstall the software, then restart application.

Action C: Contact your Micromeritics service representative if you continue to get 
this message.

Cause: An internal processing and/or hardware error occurred while accessing a 
portion of a sample file.

Action: Confirm that the media being accessed does not contain errors; for 
example, you may wish to use a utility such as ScanDisk. Contact your 
service representative if you continue to receive this error message.

Cause: During initialization of the application, the status of the analyzer was 
found to be in a different state than expected.

Action: Click Yes to cancel the operation in process, allowing the analyzer to 
reset and continue with initialization.

Click No to cancel the initialization process.

If you continue to get this message, verify that files in the application 
directory structure are not being changed or removed.

Cause: You attempted an analysis using a sample file that is being edited.

Action: Save the changes and close the dialog.
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2481- Error accessing the sample information file (file name).

2482- File cannot be opened for writing. It is already in use.

2483-  An analysis cannot be performed on (file name). It is open for editing and con-
tains errors.

2484- The edit session for (file name) must be saved before the analysis. Save 
changes and continue with the analysis.

Cause A: You attempted to open a file that is already open, possibly minimized.

Action A: View the minimized icons, locate and maximize the file.

Cause B: A computer or network problem occurred.

Action B: Check the performance of your computer devices or network.

Cause C: A software error occurred when the file was accessed.

Action C: Contact your service representative.

Cause: You attempted to open a file that is currently being used, possibly min-
imized.   

Action: View the minimized icons, locate and maximize the file.

Cause: You attempted to use a sample file containing errors that is currently 
open.

Action: Go to the window containing the file, correct the errors, and save it.

Cause: You attempted to start an analysis using a file that contains unsaved 
changes and is open for editing.

Action: Select Yes to save the changes and continue the analysis. 

Select No to cancel the analysis and return to the sample file.
A-8                                                      248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01 



ChemiSorb HTP Appendix A
2486- Cannot construct (name) report type. Program will terminate.
2487- Cannot start report generator. Error code (number). Program will terminate.

2488- File (file name) cannot be opened for editing. 

2489- File (file name) cannot be opened for writing. 

2490- No ‘.INI’ file present. Application will terminate.

Cause A: You may not have full rights to the application’s folders and files.

Action A: Contact your system administrator and have him grant you full rights.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative if you continue to receive this error 
message.

Cause: The file you specified is being used in another edit operation.

Action: Check the Windows list to locate the other edit session.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.

Cause: The ASCII (.INI) file containing initialization and system options infor-
mation cannot be found. The .INI file may have become corrupted. The 
application cannot operate without this file.

Action: Use the Setup CD to uninstall the application, then reinstall it to create a 
new INI file.

When you uninstall the application, only the application files are 
deleted; data files remain intact.
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2491- Highlighted fields contain errors. Please correct the errors before closing.

2492- This field’s entry is invalid.

2493- An entry is required for this field.

2494- Value is out of the valid range.
2495- Value is out of the valid range. Enter a value between (value) and (value).

2496- Invalid number.

2497- This field contains an invalid character.

Cause: The highlighted fields contain invalid entries. You will not be able to 
close the dialog until you correct the errors.

Action: Check the entries, correct the errors, and close the dialog.

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

Cause: This field requires a valid entry for you to proceed.

Action: Enter or select an appropriate value.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select an appropriate value.

Cause: The number you entered in the highlighted field is invalid.

Action: Check the entry and enter or select a valid number.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.
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2498- The requested change to the Sample’s status is invalid at this time.

2499- Sequence number must contain at least 3 digits.

Cause: A request to change the file’s status (for example, from automatically 
collected to manually entered) could not be done.

Action: Contact your service representative if you continue to receive this error 
message. Record the name of the sample file in which the problem 
occurred.

Cause: You tried to enter a sequence number that did not contain at least three 
digits.

Action: Enter a sequence number that contains at least three digits.
 248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01                                               A-11 



Appendix A ChemiSorrb HTP
2500 Series

2500- All sample file names that can be created using the sequence number pattern 
already exist. You may want to modify the next sequence number. 

2501- System resources have reached a dangerously low level. Please close some 
windows to avoid the loss of data.

2502- Error writing to file (name) during print. Error code: (number).

2503- Error converting file (file name). Could not create DIO intermediate file.

Cause: No more sample information files can be created using the currently 
entered file name sequence number.

Action: Select Options > Sample Defaults from the Main Menu and enter a 
new sequence number.

Cause: A large number of windows are open and consuming the system 
resources available to all applications.

Action: Close one or more windows on the screen. Contact your service repre-
sentative if you continue to receive this error message.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause A: Insufficient space is available on the hard disk. The DIO file is placed in 
the directory specified by the TEMP environment variable. 

Action A: Determine if there is sufficient space on the drive where the TEMP 
directory is located.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative if you continue to receive this error 
message.
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2504- Cannot create output file for sample (sample name).

2505- Error Logger cannot be initialized. Error code (number). Program will exit.

2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your service represen-
tative if you continue to receive this error message.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.

Cause: The selected output device is not installed in Windows.

Action: Install the device using the Control Panel, Printers operation, or select a 
different output device.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay does exist.

Cause: An error occurred while the program was opening a file necessary to the 
report operation.

Action: Use the name given in the error message to investigate. Contact your 
service representative if you continue to receive this error message.
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2510- (sample file) Error parsing reports from file (name). Reports cannot be 
produced.

2511- Print job (name) has been cancelled due to insufficient disk space. Delete 
unnecessary files and restart the report.

2512- Print job (name) been canceled.

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and remove 
the invalid character.

Cause B: The system was unable to create the usual temporary files during the 
report, possibly due to insufficient disk space.

Action B: Check the space available on the hard disk.

Cause C: An internal processing error occurred.

Action C: Contact your service representative.

Cause: The disk drive does not have enough space for the temporary file 
required by the Windows Print Manager. Therefore, printing of the 
requested report has been canceled.

Action: Delete unnecessary files from the disk. 

Cause: The requested print job was canceled at your request.

Action: None required.
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2513- Unable to read the calibration file (file name).

2514- Unable to write the calibration file (file name).

2515- Warning: Changing the calibration information will affect the performance of 
the instrument. Only qualified service personnel should do this. Do you wish to 
proceed?

2516- Warning: Keeping a backup copy of the calibration data is recommended by 
Micromeritics. Would you like to do so now?

2517- Canceling this dialog will reset the calibration state to what it was when this 
dialog was first opened. Are you sure you want to cancel?

Cause: You selected an invalid calibration file or one that cannot be read.

Action: Be sure the media containing the calibration file has no problems.

Cause: An attempt to Save calibration data has failed due to possible media 
problems.

Action A: Be sure the media you want to Save the file to has no problems.

Action B: Choose an alternate media to Save the calibration data.

Cause: You have started the process of performing a calibration operation.

Action: Calibration operations should only be done by or under the direction of 
qualified service personnel.

Cause: You have performed a calibration operation; a backup copy is recom-
mended.

Action: Perform a calibration Save operation.

Cause: You have not accepted the calibration you performed.

Action: If the calibration operation was successful, click Accept.
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2520- No data points available for reporting.

2521- Unable to program controller.

2522- Invalid controller application file.

Cause: You requested a report for a data file which contained no data points rel-
evant to the report.

Action: The affected report will not be produced. If the data file contains no 
points, select another file for the report. If the data file contains points, 
verify that you selected a sufficient number of points for the report on 
the Collected/Entered Data dialog.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.

Cause: The application’s control file is corrupt or has been deleted.

Action: Reinstall the ChemiSorb analysis program.
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2523- Programming the controller failed.
2524- CRC check failed on programming controller.
2525- Unknown error programming controller.
2526- Controller download was not successful.
2527- Controller CRC error on boot block.
2528- Controller DRAM error.
2529- Controller Com1: error.
2530- Controller Com2: error.
2531- Controller debug port error.

2532- The instrument contains a different software version. Do you want to reset it?

2533- Analyzer initialization failed.

2534- Error opening file (name) for printing. Error code: (number).

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: The application has discovered a different version of software operating 
in the analyzer. 

Action: If there are no analyzers other than the ChemiSorb connected to the 
computer, select Yes and allow the updated software to load.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.
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2548- System status (n)

2549- Error accessing online manual file (code #).

2550- Attempts to acquire the instrument’s status timed out.

2551- Unable to establish the TCP connection with the instrument.

Cause: There was a problem establishing communication with the analyzer.

Action: Ensure that the communications cable is seated firmly in the ethernet 
slot at the analyzer connection and the computer connection.

If you continue to get this message, contact your Micromeritics service 
representative.

Cause: The operator’s manual file could not be located.

Action A: Reinstall the application.

Action B: Copy the contents of the manual folder on the setup CD to the appli-
cation directory.

Cause: There was a problem establishing communication with the analyzer.

Action: Ensure that the communications cable is seated firmly in the ethernet 
slot at the analyzer connection and the computer connection.

If you continue to get this message, contact your Micromeritics service 
representative.
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2552- Configured serial number does not match instrument.

2554- File (name) does not contain any report data.

2556- Directory database (file name) error (code).

Cause: The serial number of the instrument is different from the one expected 
by the application.

Action: Run the setup program on the installation CD; choose the Remove 
operation to remove the incorrect serial number. Then choose the Add 
operation to add the correct serial number.

If the problem persists, contact your Micromeritics representative.

Cause: You attempted to open a previously saved report file but the file has no 
report data.

Action: Select a different file. 

Cause: An internal software or computer has occurred. 

Action: Navigate to the application directory and delete the file name shown in 
the message; the application will generate a new one.

If the problem persists, contact your Micromeritics representative.
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4000 Series

4002- Thermal Transpiration correction had no effect.

4003- Error Converting Pressures.
4004- Error Computing Volume Adsorbed.

4006- Report Type Not Found.
4007- Error Processing Report.

4027- Fewer than two sample files have data suitable for heat of adsorption reports.

Cause: The Apply thermal transpiration correction option was selected on 
the Report Options dialog. However, the correction did not change any 
pressure by more than one percent. 

Action: Deselect this option to disable this message. This correction is only 
applicable for very low pressures.

Cause: An internal processing and/or hardware error occurred during report 
generation.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: An internal processing and/or hardware error occurred during report 
generation.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: Less than two of the sample files you selected for heat of adsorption 
reports contain appropriate data.

Action: Edit the Quantity Adsorbed table, or select other sample files.
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4057- At least two data points are needed for Freundlich calculations.

4058- At least two data points are needed for Temkin calculations.

4080- The compressibility factor table has [nn] pressure entries.  Only [nn] are 
allowed.

Cause: Less than two data points have been selected for the Freundlich report; 
at least two are required.

Action: Select Freundlich points on the Collected Data dialog. If calculation 
assignments are not being used, edit the Freundlich Report options, 
Absolute pressure range in the sample file.

Cause A: Less than two data points have been selected for the Temkin report; at 
least two are required.

Action A: Select Temkin points on the Collected Data dialog. If calculation assign-
ments are not being used, edit the Temkin Report options, Absolute 
pressure range in the sample file.

Cause B: You have selected at least one point with a negative pressure value to 
include in the Temkin report.

Action B: Negative pressure points void Temkin calculations. Open the sample file 
and click the Collected Data tab. Locate the negative value(s) in the 
Temkin column and deselect it (them).

Cause: The compressibility factor table in the adsorptive properties has too 
many pressure values for analysis.

Action: Edit the table to remove unneeded pressure entries.
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4081-  In the compressibility factor table, the 4 temperatures below [nn] and 7 tem-
peratures above must span at least 10 K.

4082-  Compressibility factors must be greater than zero for temperatures near 
ambient and pressures up to the maximum manifold pressure.

4090-  The compressibility factor table is empty.

Cause: The compressibility factor table in the adsorptive properties has too 
many entries for temperatures near ambient.

Action: Edit the table to remove unneeded temperature entries.

Cause: The compressibility factor table in the adsorptive properties contains 
zeros or negative values for the temperatures and pressures expected 
during analysis.

Action: Edit the table to add missing compressibility factors.

Cause: The compressibility factor table in the adsorptive properties does not 
have any data.

Action:  Load an appropriate compressibility factor table.
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6000 and 6100 Series

6000- An error occurred while loading the application control information.  Data entry 
cannot be performed. (Code number)

6056- The Psat gas must be the same as the analysis gas if Po is calculated from 
Psat and the analysis gas is dosed from the Psat tube.   

6102- The instrument (Unit n, SN NN) is not calibrated.   

Cause: An error occurred accessing the control information disk file required 
by this application.

Action: The disk drive may have failed or be corrupt. Run diagnostics on the 
disk drive.

Cause:  Dosing from the Psat tube is selected in the adsorptive properties and the 
analysis conditions Po and temperature options specify that Po should be cal-
culated from the Psat of a gas, but the Psat gas differs from the analysis gas.

Action: Select a gas for the Psat measurement that has the same mnemonic as the anal-
ysis gas. Typically the analysis and Psat gas will be krypton but the Psat gas 
will include the solid Psat vs. T table.

Cause: One or more calibration operations have not been performed.

Action: Using the setup CD, reinstall the calibration files. If this does not cor-
rect the problem, contact your Micromeritics representative.
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6200 Series

6200- Could not construct (name) report type. Program will terminate.

6203- File cannot be opened for editing. It is already in use.

6210- Only one analysis task may be included in the analysis conditions.

6211- The gas selected for the (task name) task is different than the gas selected for 
the neighboring tasks. An evacuation task must be added to add this task. Add 
evacuation and proceed? 

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: The file you specified is being used in another edit operation.

Action: Close the file in use and try to open the file again.

Cause: You attempted to insert a second analysis task into the Selected Tasks 
list.

Action: If the analysis task is to be inserted at the current position in the task list, 
you must first delete the other analysis task.

Cause: You entered a new task and the gas does not match the gas in the pre-
vious task. Mixing gases may be dangerous.

Action: Select Yes to automatically insert the evacuation task. Select No to con-
tinue editing the task options.
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6212- A leak test is specified without a preceding evacuation. Do you wish to insert 
an evacuation task?

6213- The maximum allowed number of tasks is selected. Delete some tasks before 
proceeding.

6214- An analysis task is specified without a preceding evacuation. An evacuation 
task will be entered for you and you may edit it. 

6215- The Selected Tasks list contains adjacent tasks using different gases. Do you 
still wish to save this file?

Cause: You inserted or deleted a task in the Selected Tasks list and left a leak 
test task without a preceding evacuation task. The leak test will fail if the 
sample pressure exceeds 0.5 mmHg.

Action: Select Yes to evacuate the sample between the two tasks. Select No if 
you do not wish to include evacuation

Cause: You attempted to insert more than twenty tasks.

Action: You may specify no more than twenty tasks in one sample file. If more 
preparation steps are required, use two sample files. The first sample file 
should contain only preparation tasks; the second file should contain any 
remaining preparation tasks and an analysis task.

Cause: You inserted or deleted a task in the Selected Tasks list, leaving the 
analysis task without a preceding evacuation task.

Action: Edit the evacuation task accordingly.

Cause: You attempted to save a sample file in which one task in the Selected 
Tasks list uses a different gas than the previous/next task. Mixing gases 
may be dangerous.

Action: Select No if you do not want to save the file. Return to the Analysis con-
ditions dialog and insert an evacuation task between all flow, soak and 
analysis tasks which use different gases.
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6216- The selected task has already been executed. It may not be changed or deleted.

6217- New tasks may only be inserted following task (number).

6218- An analysis task may not be inserted while an experiment is in progress.

6219- No new tasks may be inserted. Analysis is complete.

6220- Tasks may not be deleted after an experiment has been started.

Cause: You attempted to edit or delete a task after it was already performed.

Action: Edit or delete a task not yet performed.

Cause: You attempted to insert a task before the task currently being executed.

Action: Insert new tasks following the task number specified in the message.

Cause: You attempted to insert an analysis task in the Selected Tasks list for a 
sample file which is currently being processed by the analyzer.

Action: If you wish to insert an analysis task, first cancel the experiment in prog-
ress. Then delete the tasks which had executed up to the time of the can-
cellation, insert an analysis task, and restart the experiment

Cause: You attempted to insert a new task in the Selected Tasks list for a sam-
ple file which is currently being processed by the analyzer. All tasks 
have been processed and the analyzer is performing the termination 
sequence.

Action: Create a new sample file containing the desired tasks and submit it for 
processing.

Cause: You attempted to delete a task from the Selected Tasks list after the 
sample file was submitted for analysis.

Action: Reduce the duration of the task to minimum value.
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6222-  (Unit n) (gas name) required by task (number) is not configured on the selected 
unit.

6223- Sample has no Analysis Task entry. Do you wish to proceed with the analysis?

6224- Sample has no pressure table entries. Do you wish to proceed with the 
analysis?

6225- The Selected Tasks list contains adjacent tasks using different gases. Do you 
still wish to close this file? (yes, no)

Cause: You attempted to start an analysis which requires a gas not entered in the 
unit configuration information. The analysis is canceled.

Action: Select Unit [n] > Unit Configuration; click Gas to display the Gas 
Configuration dialog and specify the valve to which the required gas is 
connected.

Cause: You attempted to analyze a sample file with no analysis task entry.

Action: Select No to cancel the analysis, add an analysis task, and restart the 
analysis.

Cause: You attempted to start an analysis using a sample file for which no pres-
sure table was defined.

Action: Select Yes to proceed with the analysis; all preparation tasks and the 
free-space measurement are performed, but no data points are collected. 
Select No to cancel the analysis; enter a pressure table for the sample.

Cause: You attempted to close a file that has adjacent experiment tasks which 
specify different gases. Incompatible gases may be mixed during sample 
preparation.

Action: Select No if you do not want gases to be mixed on the sample. Select 
Yes to return to the Analysis conditions dialog and add evacuation tasks 
if necessary.
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6226- (gas symbol) required for backfilling the sample at the end of the analysis is 
not configured on the selected unit.

6228- There is no helium attached to the unit. Free space will not be measured.

6230- The Active Metals Table Options dialog does not specify a stoichiometry factor 
for the adsorptive (gas name) of the element (metal name). One (1.0) was sub-
stituted for this value in the calculations.

Cause: The gas specified for use in backfilling the sample at the end of the 
experiment is not configured on the instrument.

Action: Select Unit > Unit Configuration to display the Unit Configuration dia-
log. Click Gas to display the Configuration Gas Options dialog; select 
the gas inlet port to which the required gas is connected.

Cause: You attempted to start an analysis in which a measured free space was 
requested but a helium gas tank was not detected.

Action A: You attached a helium tank, but failed to configure its port. Select Unit 
[n] > Unit Configuration, click the Gas push button and assign helium 
(He) at the appropriate port.

Action B: You do not have a helium tank attached to the unit. Attach a helium tank, 
then select Unit [n] > Unit Configuration, click the Gas push button 
and assign helium (He) at the appropriate port.

Action C: Perform the analysis without a measured free space.

Cause: You specified a non-zero percent of sample weight for an element in the 
Active Metals Table of the sample report options but you did not specify 
a stoichiometry factor for the adsorptive used in the analysis.

Action: The calculation proceeds with the default value and the program pro-
duces a report. Edit the sample information file to include the correct 
value and run the report again.
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6231- No element in the Active Metals Table Options has a “% of Sample Weight” 
value greater than zero. Metallic Dispersion and Metallic Surface Area will no 
be calculated.

6232- Sinfelt (Difference) Plot cannot be produced: Fewer than two data points were 
selected for inclusion in the calculations.

6234- Leak test failure - the observed outgas rate of [VAC0] [VAC-U] exceeds the limit 
of [VAC0] [VAC-U].

6235- Leak test failure in task (number): The sample was not fully evacuated prior to 
the test.

Cause: All elements in the Active Metals Table of the sample report options 
have the value zero entered for the percentage of sample weight.

Action: The calculations proceed and the program produces an incomplete 
report. Edit the sample information file to include the correct value and 
run the report again

Cause: You selected fewer than two data points for inclusion in the Sinfelt (or 
Difference) plot calculation. The plot requires at least two data points to 
be produced.

Action: Edit the sample information file to select the data points used in the cal-
culation. 

Cause: The outgas rate specified in the leak test criteria was exceeded.

Action: Check sample tube fitting to ensure that it is securely attached to the 
port. Then start the analysis again.

Cause: The sample was at a pressure greater than 0.5 mmHg at the start of the 
leak test. A leak test cannot be performed unless the sample has been 
fully evacuated.

Action: Insert an evacuation task into the Selected Tasks list immediately before 
the leak test. If an evacuation task is already present, ensure that the 
evacuation is being performed at the same temperature as the test and 
that the duration of the evacuation is adequate.
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6236- Pressure exceeded [PR0] [PR-U] while flowing (gas).

6237- (Unit {number}) Analysis canceled in task (number): Time limit exceeded while 
attempting to reach temperature (number)C.

6238- Furnace is not in the raised position. This is not the recommended operating 
configuration. Do you wish to proceed with the analysis?

6248- The selected task is currently executing. It may not be changed or deleted at 
this time.

Cause: The pressure in the manifold exceeded the indicated maximum, while 
flowing gas over the sample.

Action: Verify that the exhaust line is not plugged or restricted. Reduce the pres-
sure of the flowing gas at the tank regulator. Resume the experiment 
while monitoring the manifold pressure and flow rate. Adjust the regu-
lator pressure to achieve the desired flow rate with a manifold pressure 
of less than the indicated maximum.

Cause A: The furnace has malfunctioned.

Action A: Contact your service representative.

Cause B: The pressure within the cooling line is too low.

Action B: Increase the pressure of the cooling gas to between 10 and 20 psi.

Cause: The elevator holding the furnace is not in the fully raised position. 
Unless a custom furnace or Dewar is being used, it is not the correct 
operating position.

Action: Select No to stop the analysis initialization; then correctly position the 
furnace. Select Yes if you are using custom equipment and are certain it 
is installed correctly.

Cause: You attempted to edit or delete a task which is currently in operation.

Action: None required for this task. For future reference, you must suspend the 
analysis to edit or delete a task.
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6249- The sample file (number) is already present in the sequence.

6264- Calculations failed for first analysis data.

6265- Calculations failed for repeat analysis data.

6266- Calculations failed for differential data.

6267- Fewer than two repeat points are available.

6268- Fewer than two difference points are available.

6269-  Line fit could not be done for (primary, repeat, or difference) data.

Cause: You attempted to insert a sample file that is already in the sequence.

Action: Create or choose another file.

Cause: The report could not be produced for the indicated data set. Additional 
messages on the error report provide more detail.

Action: See actions for the other error messages.

Cause: At least two points are required for calculations.

Action: Edit the calculation assignments for this report.

Cause: The line fit for the Difference or Sinfelt report failed.

Action: Check that the data points are appropriate for fitting. See actions for 
other error messages on the report.
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6500 Series

6500- Failed to evacuate manifold to VAC SET in (number of) seconds. Calibration 
canceled.

6504- Unable to write the calibration file (name).

6505- Unable to read the calibration file (name).

6506- Calibration file for (file name) is invalid.

Cause A: The vacuum set point is set too low.

Action A: Reset VAC SET point to 5.0 mmHg. If the VAC SET point is already at 
5.0 mmHg or above, the vacuum gauge may need servicing.

Cause B: Leak in manifold.

Action B: Locate the leak and repair it. Refer to Chapter 9, Troubleshooting and 
Maintenance. Restart calibration.

Cause C: Valve failure.

Action C: Identify the leaking valve. Contact your service representative.

Cause: A Save to File operation failed.

Action: Confirm there is sufficient free space on the media receiving the file and 
that the media is not corrupted. If the problem persists contact a 
Micromeritics service representative.

Cause: A Load from File operation failed.

Action: Confirm there is sufficient free space on the media receiving the file and 
that the media is not corrupted.  If the problem persists contact a 
Micromeritics service representative.
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6510- Main pressure transducer overrange detected.

6511- Sample transducer overrange detected.

6512- Time limit exceeded while dosing manifold to (pressure) with (gas).

Cause: A manifold pressure over 1000 mmHg was detected. The exhaust for the 
instrument or the exhaust port on a sample tube may be blocked.

Action A: Inspect for and clear any blockage.

Action B: Observe caution if operating the analyzer manually. 

If the problem persists, contact a Micromeritics service representative. 

Cause: A sample pressure over 960 mmHg was detected. The exhaust on a sam-
ple tube may be blocked.

Action A: Inspect for and clear any blockage.

Action B: Observe caution if operating the analyzer manually. 

If the problem persists, contact a Micromeritics service representative.

Cause A: The maximum time was exceeded before the target pressure point was 
reached. The nitrogen regulator may be set too low or turned off.

Action A: Set the analysis gas regulator to 10 psig (0.7 bar). Then resume the 
analysis.

Cause B: The analysis gas bottle is empty.

Action B: Connect a new analysis gas bottle. Then resume the analysis.
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6513- Time exceeded while evacuating manifold.

6514- Time limit exceeded while evacuating sample (servo).

6515- Time limit exceeded while evacuating sample (unrestricted).

Cause A: Maximum manifold evacuation time was exceeded before the vacuum 
set point was achieved. Vacuum pump may be turned off. 

Action A: Turn on vacuum pump switch. Then restart the analysis.

Cause B: The manifold is contaminated or leaking.

Action B: Correct the problem, then restart the analysis.

Cause A: The maximum time for evacuating the sample through the servo was 
exceeded before the unrestricted evacuation pressure was achieved. Pos-
sible causes are a leak in the sample tube fitting or a crack in the sample 
tube. 

Action A: Check the sample tube and the sample tube fitting; ensure that the tube is 
securely attached to the port. Then restart the analysis.

Cause B: The vacuum pump may be turned off.

Action B Turn on the vacuum pump and restart the analysis.

Cause: The maximum time for evacuating the sample through the unrestricted 
valve was exceeded. Possible causes are a leak in the sample tube fit-
ting or a crack in the sample tube. 

Action: Check the sample tube and the sample tube fitting; ensure that the tube 
is securely attached to the port. Then restart the analysis.
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6518- Servo calibration failed.

6519- Zero calibration failed.

6520- Match calibration failed.

6521- Fill timeout while (task). Check the (gas) supply pressure and resume.

Cause A: The maximum time was exceeded before the target pressure point was 
reached. The nitrogen regulator may be set too low or turned off.

Action A: Set the analysis gas regulator to 10 psig (0.7 bar), then resume the 
analysis.

Cause B: The analysis gas bottle is empty.

Action B: Connect a new analysis gas bottle, then resume the analysis.

Cause: A transducer offset measured after evacuation was out of tolerance.

Action: Repeat the calibration. If the problem persists, contact your Micromer-
itics service representative.

Cause: A transducer scale measured after dosing to the match pressure was out 
of tolerance.

Action: Verify that the vacuum pump is operating properly, then repeat the cal-
ibration. 

If the problem persists, contact your Micromeritics service representa-
tive.

Cause A: The maximum time was exceeded while filling the sample tube and/or 
manifold with the specified gas. The gas regulator may be set too low or 
turned off.

Action A: Ensure that the gas regulator is in the On position and that is set to 22 
psig (152 kPag), then resume the analysis.  
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6522- Warning: Measured flow rate is out of tolerance on (Port n). 

6523- Furnace cooling to (temp) time limit exceeded on (Port n).

6530-  Analysis canceled: Bad thermocouple detected on (Port n). Caution: Use 
extreme care when handling the sample thermocouple and sample tube as the 
furnace and those components may be at an unsafe temperature.

Cause B: The gas bottle is empty.

Action B: Replace the gas bottle, then resume the analysis.

Cause: The mass flow rate during a flow task was over 10 cc/min above or 
below the requested rate.

Action: Ensure that the gas regulator for the flowing gas is set to 20 psig.

Cause A: The furnace for the indicated port has malfunctioned.  

Action A: Contact your service representative.

Cause B: The pressure within the cooling line is too low.

Action B: Increase the pressure of the cooling gas to between 10 and 20 psi.

Cause A: The thermocouple is unplugged. 

Action A: Plug in the thermocouple and try again.

Cause B: The thermocouple has malfunctioned.

Action B: Replace the thermocouple.
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6531-  Analysis canceled: Sample or furnace temperature exceed limit on (Port n).

6532-  Analysis canceled: Port temperature exceed limit on (Port n).

6533-  Analysis canceled: Manifold temperature exceed limit.

6534-  Analysis canceled: Temperature control enabled on (Port n) with elevator not in 
position.

6535-  Temperature control disabled on (Port n). Maximum (furnace or sample) tem-
perature exceeded.

Cause: A sample or furnace temperature above the maximum allowed was 
reported. The thermocouple may have malfunctioned.

Action: Replace the thermocouple.

If the problem persists, contact a Micromeritics service representative.

Cause: A port or manifold temperature above 50 ºC was reported. The manifold 
cooling vents may be obstructed.

Action: Ensure that nothing is obstructing the vents and that the cooling fans are 
operating properly.

Cause: The analysis on the specified port is temperature-controlled and the ele-
vator has malfunctioned.

Action: Contact your Micromeritics service representative.

Cause: A sample or furnace temperature above the maximum allowed was 
reported.

Action: Replace the thermocouple.

If the problem persists, contact a Micromeritics service representative.
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6536- Analysis canceled: Main pressure transducer overrange detected.

6537- Analysis canceled: Sample transducer overrange detected on (Port N).

6538-  Analysis canceled: Sample pressure on (Port n) greater than [pressure] is not 
allowed.

6539-  Analysis canceled: Time limit exceeded while waiting for the sample tempera-
ture on (Port n) to stabilize.

Cause: A manifold pressure over 1000 mmHg was detected. The exhaust for the 
instrument or the exhaust port on a sample tube may be blocked.

Action A: Inspect for and clear any blockage.

Action B: Observe caution if operating the analyzer manually. 

If the problem persists, contact a Micromeritics service representative. 

Cause: A sample pressure over 960 mmHg was detected. The exhaust on a sam-
ple tube may be blocked.

Action A: Inspect for and clear any blockage.

Action B: Observe caution if operating the analyzer manually. 

If the problem persists, contact a Micromeritics service representative.

Cause: A manifold pressure greater than the maximum allowed was attained 
during dosing.

Action: The analysis cancelled; data up to the point of cancellation have been 
stored.

Cause: The maximum time to achieve the requested temperature was exceeded.

Action A: Ensure that the furnace insulator disk and the safety shield on the spec-
ified port are in place

Action B: Verify that the sample thermocouple is giving appropriate readings.
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6540-  Analysis canceled: Zero of the manifold transducer(s) failed.

6541-  Analysis canceled: Zero of the (Port n) transducer(s) failed.

6542-  Analysis canceled: Matching of sample transducer to manifold transducer on 
(Port n) failed.

6543-  Analysis canceled: Matching of sample 1000 mmHg to 10 mmHg transducer on 
(Port n) failed.

6544- Analysis canceled: Cumulative quantity dosed exceeded [quantity] on (Port n).

Cause: The offset value after calibration exceeded the recommended limit.

Action: Verify that the vacuum pump is operating correctly. Manually evacuate 
the manifold to ensure a proper vacuum is observed.

If you continue to get this message, contact your Micromeritics service 
representative.

Cause: The transducer did not respond correctly.

Action: Contact your Micromeritics service representative.

Cause A: More than the maximum allowed quantity has been dosed onto the sam-
ple; possibly due to leaks in the system.

Action A: Ensure that the sample tube is securely attached to the port, then restart 
the analysis.

Cause B: You may have used too much sample.  

Action B: Multiply the maximum value from the Quantity Adsorbed column of the 
Isotherm report by the sample mass. If the result exceeds the maximum 
quantity allowed, reduce the amount of sample and restart the analysis.
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6545-  Analysis canceled: Unknown gas requested.

6546-  Analysis canceled: Servo evacuation failed to maintain soak pressure.

6548- All samples must have analysis task.

6549- All samples must have the same backfill gas.

Cause: You attempted to start an analysis using a sample information file in 
which the analysis gas specified does not match any gas connected to the 
analyzer.

Action: Connect the appropriate gas and specify its existence in the Unit con-
figuration dialog, or choose another gas.

Cause: Evacuation through the servo could not compensate for a rise in the sam-
ple pressure during a soak task.

Action A: Verify that the vacuum pump is operating properly.

Action B: Check the sample tube and the sample tube fitting; ensure that the tube is 
securely attached to the port.

Cause: You attempted to analyze a sample file with a sample file that does not 
have an Analysis task.

Action: Edit the Selected Tasks list in Analysis conditions so that it includes an 
Analysis task.

Cause: The backfill gas in the indicated sample file is different from the other 
sample files chosen for the analysis. 

Action: Edit the backfill gas selection in the sample file so that it matches the 
others.
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6550- All samples must have the same number of tasks.

6551- All samples must have tasks in the same order.

6553- All (task name) tasks with temperature control enabled must have the same 
temperature and rate.

6554- All tasks must have the same ‘evacuate for’ and ‘below’ values.

Cause: The number of tasks in the indicated sample file is different from the 
other sample files chosen for the analysis. 

Action: Edit the Selected Tasks list in the sample file so that it matches the tasks 
in the others.

Cause: The tasks in the indicated sample file are in a different order than those 
in the other sample files chosen for the analysis. 

Action: Edit the Selected Tasks list so that are in the same order as those in the  
others.

Cause: The indicated sample has a task with temperature settings that are dif-
ferent from the corresponding task in the other samples chosen for the 
analysis.

Action: Edit the task list in the sample file so that it uses the same settings as the 
other samples.

Cause: The indicated sample has a task with evacuation settings that are differ-
ent from the corresponding task in the other samples chosen for the anal-
ysis.

Action: Edit the task list in the sample file so that it uses the same settings as the 
other samples.
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6555- All Soak tasks must have the same time and minimum pressure.

6556- All Flow tasks must have the same time.

6557- This file is already selected for the analysis.

6558- Gas (mnemonic) in sample file (file name) does not match any gas in the unit.

Cause: The indicated sample has a task with soak settings that are different from 
the corresponding task in the other samples chosen for the analysis.

Action: Edit the task list in the sample file so that it uses the same settings as the 
other samples.

Cause: The indicated sample has a task with a Flow duration that is different 
from the corresponding task in the other samples chosen for the analysis.

Action: Edit the task list in the sample file so that it uses the same duration as the 
other samples.

Cause: You attempted to select a file for analysis that is already selected for 
another port.

Action: Select or create a different file.

Cause: You attempted to start an analysis which requires a gas not entered in the 
unit configuration information. The analysis is canceled.

Action A: Choose another gas.

Action B: Select Unit [n] > Unit Configuration; click Gas to display the Gas 
Configuration dialog and specify the valve to which the required gas is 
connected.
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6559- Gas (mnemonic) in sample file (file name) does not match any gas in the Gas 
Defaults.

6560- None of the requested quantities adsorbed is within the range of the primary 
data of more than one sample file.

6561- None of the requested quantities adsorbed is within the range of the repeat 
data of more than one sample file.

6562- None of the requested quantities adsorbed is within the range of the different 
data of more than one sample file.

6563- The sample (file name) does not have enough primary data. A minimum of two 
adsorption points is required.

6564- The sample (file name) does not have enough repeat data. A minimum of two 
adsorption points is required.

6565- The sample (file name) does not have enough difference data. A minimum of 
two adsorption points is required.

Cause: The properties for a gas needed for the analysis are not in the Gas 
Defaults table.

Action: Select Options > Gas Defaults/MFC Constants from the main menu 
and add the gas properties.

Cause: The Heat of Adsorption report could not be produced because the spec-
ified quantities adsorbed lie outside of the range of the collected data in 
the selected sample files.

Action A: Adjust the entries in the table of quantities adsorbed.

Action B: Exclude primary, repeat, or difference data from the report.

Cause: The Heat of Adsorption report could not be produced because the spec-
ified sample files do not have enough data.

Action A: Select files with more data.

Action B: Exclude primary, repeat, or difference data from the report.
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6566- The sample (file name) does not have any primary data in the range of the 
requested quantities adsorbed.

6567- The sample (file name) does not have any repeat data in the range of the 
requested quantities adsorbed.

6568- The sample (file name) does not have any difference data in the range of the 
requested quantities adsorbed.

6569- No data sets are selected.

6570- No reports sets are selected.

Cause: The specified quantities adsorbed lie outside of the range of the col-
lected data in the indicated sample file. That file’s data will not be used. 
The report will still be produced if at least two other files have appro-
priate data.

Action A: Adjust the entries in the table of quantities adsorbed.

Action B: Exclude primary, repeat, or difference data from the report.

Cause: All data sets were excluded from the report.

Action: Include primary, repeat, or difference data in the report.

Cause: None of the Heat of Adsorption reports were selected.

Action: Select the Tabular report, Isostere report, or the Heat of Adsorption 
report.
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B.  CALCULATIONS

This appendix contains the calculations used in the ChemiSorb program.  

Real Gas Equation of State

All gas accounting calculations in the ChemiSorb HTP utilize the real gas equation of state 
and compressibility factor data traceable to NIST.

Where:

n = quantity of gas
P = pressure
T = temperature
V = volume
z(P,T) = compressibility factor for the gas of interest at the given pressure and 

temperature.

Quantity of gas in cm3 STP is given by

Free Space

The free space is the physical volume below the sample valve. The different temperatures in 
the sample tube, stem, and port must be accounted for.

Free-space volumes are calculated using the following equations:

n
PV

z P,T T
--------------------=

Q n 
TSTD

PSTD

-----------=

np

PsVp

z Ps,Tp Tp

--------------------------=

ns nd np–=

Vs

nsz Ps,Ts Ts

Ps

------------------------------=
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The reported free space is:

The quantity of gas in the free space for a given data point is:

Where:

nd = quantity of gas dosed
np = quantity of gas in the port
ns = quantity of gas in the sample tube
Ps = sample (and port) pressure
Tp = port temperature
Ts = sample temperature
Vp = volume of the sample port
Vs = volume of the sample tube
z(P,T) = gas compressibility factor at pressure P and temperature T for the gas 

used

Vf Vp Vs+=

np Ps =
Vp

z Ps,Tp Tp

--------------------------
Vs

z Ps,Ts Ts

-------------------------+ 
 
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Quantity Adsorbed

A portion of the dosing volume may be at a slightly elevated temperature due to heating of 
the sample ports. So the manifold volume is partitioned into a volume at the temperature of 
the manifold block and a volume at the average temperature of the ports.

Where:

na = quantity of gas adsorbed

nd = quantity of gas dosed

nf = quantity of gas in the free space

P1m = manifold pressure before dosing onto the sample

P2m = manifold pressure after dosing

T1m = manifold temperature before dosing onto the sample

T2m = manifold temperature after dosing

T1p = average of all port temperatures before dosing onto the sample

T2p = average of all port temperatures after dosing

Vm = volume of the dosing manifold 

 and  = constants that determine the relative weights of the manifold and port 
temperatures

na nd nf–=

nd P1mC P1m,T1m,T1p  P2mC P2m,T2m,T2p –=

C P,Tm,Tp  Vm


z P,Tm Tm

-------------------------- 
z P,Tp Tp

------------------------+ 
 =
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Weighted Metal Parameters

The stoichiometry factor, atomic weight, and density used in calculations are averages 
weighted by the number of moles of each active metal. For example, the average stoichiom-
etry factor is

Where:

ni = number of moles of metal,     

where:
fraction of sample weight
fraction reduced
X  =  number of metal atoms in the oxide
Y  =  number of oxygen atoms in the oxide
Wm = Atomic weight of metal

Wo = Atomic weight of Oxygen

Average density and atomic cross-sectional area are calculated similarly.

Difference and Sinfelt Methods

The y-intercept quantity adsorbed (Q0) is used for several calculations in the difference and 
Sinfelt reports. This value can be determined in two ways. If one point selected, Q0 is the 
quantity adsorbed for that point.

Difference 

The repeat isotherm data are subtracted from the primary isotherm. Q0 is the y-intercept of a 
straight line through the difference data.

Sinfelt 

Both the primary and repeat isotherms are fitted to a straight line. Q0 is the difference 
between the y-intercepts of the fit lines.

S

niSi

i



ni

i


---------------=

ni
X

XWm YWO+
------------------------------=
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Metal Dispersion

Where:

Vmol  22414 cm3/mol; the molar volume of an ideal gas at standard temperature and 

pressure

Metallic Surface Area

The metallic surface area is the total active metal surface area available for interaction with 
the adsorbate.

Where:

NA  6.023 × 1023 the number of atoms per mole

Crystallite Size

Where:

k = shape factor; 6 for sphere, 5 for cube
 = weighted average density of the active metals

D 100% 100% 
Q0S

Vmol i 
pi

wi

-----
-------------------------=

Ametal

NAQ0SAatom

Vmol

-----------------------------=

dxtal
1000k

Ametal

-----------------=
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Langmuir Surface Area

Transform

The Langmuir isotherm is:

The isotherm is transformed so that P/Q is plotted as a function of pressure. The transformed 
data are fitted with a straight line. the slope (m) and intercept (y0) of the fit line are used in the 
calculations below.

Surface Area

  

Monolayer Capacity 

 

Langmuir b Value

Dissociative Chemisorption

The Langmuir isotherm may be derived for dissociative chemisorption.

The calculations are performed with the slope and intercept of a fit of  as a function 

of .

Q
Qm

------- bP
1 bP+
----------------=

ALang

AatomSNA

Vmolm
---------------------- 10 18–  

m2

nm2
---------=

Qm
1
m
----=

b
1

y0Qm

------------=

Q
Qm

------- b P

1 b P+
--------------------=

P
Q

-------

P
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Freundlich Isotherm

The Freundlich isotherm has the form:

where 

Q = quantity of gas adsorbed
Qm = quantity of gas in a monolayer
C = temperature-dependent constant
m = temperature-dependent constant

The pressure is absolute; typically, m > 1. In terms of quantity adsorbed,

Taking the log of both sides yields:

Q
Qm

------- CP1/m=

Q QmCP1/m=

Q  Qm C
1
m
---- P+=
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Temkin Isotherm

The Temkin isotherm has the form,

where

Q = quantity of gas adsorbed
Qm = quantity of gas in a monolayer
q0 = the differential heat of adsorption at zero surface coverage
A = a0 exp {-q0/RT}, where 0 and a0 are adjustable constants

In terms of quantity adsorbed,

Thus, the plot of the natural log of absolute pressure vs. quantity adsorbed yields a straight 
line with slope RTQm/q0 and intercept (ln A) RTQm/q0.

Q
Qm

------- RT
q0
--------- A0P ln=

Q
RTQm

q0
--------------- A0  Pln+ln =
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C.  GAS CONVERSION CONSTANTS

The ChemiSorb analyzer uses Mass Flow Controllers (MFCs) to control the flow of gases. 
These MFCs require a conversion constant for each gas or gas mixture, to compensate for vari-
ations in gas flows resulting from variations in the gases’ properties. A default gas table con-
taining MFC conversion constants is included on the Options menu. The following table 
provides a more complete list of gases and their conversion constants.

You may wish to determine a new conversion constant if you are using a unique gas mixture 
(refer to Gas Mixtures, page C-5).

Gas Conversion Constants for the MFC

Gas Symbol MFC Conversion Constant 
(H2 = 1.000)

Acetylene C2H2 0.6535

Air (mixture) 0.9901

Allene C3H4 0.4752

Ammonia NH3 0.7822

Argon Ar 1.3861

Arsine A5H3 0.7525

Boron Trichloride BCl3 0.4356

Boron Trifluoride BF3 0.5743

Bromine Pentafluoride BrF5 0.2871

Bromine Trifluoride BrF3 0.4356

Butane C4H10 0.2871

Butene C4H8 0.3267

Carbon Dioxide CO2 0.7723

Carbon Monoxide CO 0.9802

Carbon Tetracloride CCl4 0.3465

Carbon Tetrafluoride CF4 0.4752

Carbonyl Fluoride COF2 0.2673

Carbonyl Sulfide COS 0.6733

Chlorine Cl2 0.8218

Chloroform CHCl3 0.4356

Chlorine Trifluoride ClF3 0.4257

Cyanogen C2N2 0.4950

Cyclopropane C3H6 0.5050

Deuterium D2 0.9901
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Gas Conversion Constants for the MFC  (continued)

Gas Symbol MFC Conversion Constant 
(H2 = 1.000)

Diborane B2H6 0.5446

Dichlorosilane SiH2Cl2 0.4356

Dimethylamine (CH3)2NH 0.6634

Dimethylether (CH3)2O 0.5842

Ethane C2H6 0.5446

Ethyl Chloride C2H5Cl 0.2871

Ethylene C2H4 0.6139

Ethylene Oxide C2H4O 0.5842

Fluorine F2 0.9208

Fluroform CHF3 0.5644

Freon 11 CCl3F 0.3762

Freon 12 CCl3F2 0.3861

Freon 13 CClF3 0.4257

Freon 13 B1 CBrF3 0.4059

Freon 14 CF4 0.4703

Freon 21 CHCl2F 0.4554

Freon 22 CHClF2 0.5050

Freon 23 CHF3 0.5644

Freon 113 CCl2F-CClF2 0.2277

Freon 114 CCl2F4-CClF2 0.2554

Freon 115 CClF2-CF3 0.2713

Freon 116 CF3-CF3 0.2277

Germane GeH4 0.6436

Helium He 1.3762

Hexamethyldisizane HMDS 0.1386

Hydrogen H2 1.0000

Hydrogen Bromide HBr 0.9703

Hydrogen Chloride (Dry) HCl 0.9802

Hydrogen Fluoride HF 0.9901

Hydrogen Iodide HI 0.9505

Hydrogen Selenide H2Se 0.8317

Hydrogen Sulfide H2S 0.8416
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Gas Conversion Constants for the MFC  (continued)

Gas Symbol MFC Conversion Constant 
(H2 = 1.000)

Isobutane C4H10 0.3069

Isobutylene C4H8 0.3366

Krypton Kr 1.3762

Methane CH4 0.8020

Methylamine CH3NH2 0.5644

Methyl Bromide CH3Br 0.6436

Methyl Chloride CH3Cl 0.6832

Methyl Fluoride CH3F 0.7525

Methyl Mercaptan CH4S 0.5842

Neon Ne 1.3861

Nitric Oxide NO 0.9901

Nitrogen N2 0.9950

Nitrogen Dioxide NO2 0.7525

Nitrogen Trioxide N2O3 0.4356

Nitrogen Trifluoride NF3 0.5446

Nitrous Oxide N2O 0.7426

Oxygen O2 0.9802

Ozone O3 0.7327

Pentaborane B5Hg 0.2871

n Pentane C5H12 0.2376

Perchloryl Fluoride ClO3F 0.4455

Phosgene COCl2 0.5050

Phosphine PH3 0.7822

Phosphorous Pentafluoride PF5 0.3465

Propane C3H8 0.3861

Propylene (Propene) C3H6 0.4653

Silane SiH4 0.6733

Silicon Tetrachloride SiCl4 0.3168

Silicon Tetrafluoride SiF4 0.3960

Sulfur Dioxide SO2 0.7228

Sulfur Hexafluoride SF6 0.2970

Trichlorosilane Cl3HSi 0.3267

Trimethylamine (CH3)3N 0.3168
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 Gas Conversion Constants for the MFC  (continued)

Gas Symbol MFC Conversion Constant 
(H2 = 1.000)

Tungsten Hexafluoride WF6 0.2871

Uranium Hexafluoride UF6 0.2178

Vinyl Bromide C2H3Br 0.5248

Vinyl Chloride C2H3Cl 0.5347

Vinyl Fluoride C2H3F 0.5743

Xenon Xe 1.3762
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Gas Mixtures

A conversion constant for a mixture of gases can be determined easily using the conversion 
constants for each gas in the mixture.  

1. Record the names and constants for each gas in the mixture.

2. Use the following formula to calculate the conversion constant for the gas mixture. 

M = the mixture conversion constant
P = the percentage of gas n in the mixture, expressed as a whole number 

(example: for 15%, use 15, not .15)
F = the conversion constant (factor) for gas n 

3. Enter the gas mixture in the Gas Defaults table; use M as the conversion constant.

Mixture name:_____________________ Constant:____________________

Gas Name Conversion Constant 

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

M
1

P1

F1 100
---------------------

P2

F2 100
--------------------- +...+

Pn

Fn 100
---------------------+

----------------------------------------------------------------------------------------------------=
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ChemiSorb HTP Appendix D
D.  CONFIGURING AN ETHERNET PORT

Your computer and analyzer communicate by means of an ethernet connection. This 
appendix contains instructions for configuring an ethernet port in Microsoft®  Windows 7, 
Windows Vista, or Windows XP Professional. The instructions do not apply to any other 
operating system. 

The sample screens shown in this appendix are Microsoft operating system 
screens, which may be subject to change. The screens are included for reference 
purposes only. 

Depending on your desktop settings, you may have to access the dialogs in this 
procedure in a different manner. Refer to your Windows help system if you need 
assistance. 
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Windows 7 and Windows Vista 

1. Select the Windows icon from the Status bar at the bottom of the screen, then select 
Control Panel. 

2. Double-click on Network and Sharing Center; a dialog similar to this one is 
displayed.

3. Click Manage network connection from the Tasks list on the left side of the 
window, then click Local Area Connection for your analyzer on the dialog that 
displays. You should see a dialog similar to this one.

Click here
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4. Click Properties; the Local Area Connection Properties dialog is displayed.

5. Highlight Internet Protocol Version 4, then click Properties; the Internet Protocol 
Version 4 Properties dialog is displayed.  

6. Click Use the following IP address, then enter the following in the IP address field:
192 168 77 100. Use the right arrow key to advance to the fourth field.

7. The following numbers should display in the Subnet mask field: 255.255.255.0. If 
these numbers are not displayed, enter them.

8. Leave all other fields in the dialog blank.

After entering 77 in this field, 
use the right arrow key on 
your keyboard to advance to 
the next field.
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9. Click OK to close the Internet Protocol Version 4 dialog.

10. Then click OK or the X in the upper right-hand corner of the remaining dialogs and 
windows to close them.
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Windows XP Professional

1. Select Start > Settings > Network Connections from the Status bar at the bottom of 
the screen; the Network Connections dialog is displayed.

2. Double-click the appropriate Local Area Connection, which is actually the ethernet 
port; the Local Area Connection Status dialog is displayed. 

3. Click Properties; the Local Area Connection Properties dialog is displayed. 

If no Local area connections are displayed, Windows did not detect an ethernet 
port. Contact your system administrator.
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4. Scroll to Internet Protocol (TCP/IP) and make sure a check mark appears in the box 
to the left of the item. If it does not, click on the box to insert a check mark.

5. Select Internet Protocol (TCP/IP) to highlight it, then click Properties; the Internet 
Protocol dialog is displayed. 

6. Click Use the following IP address, then enter the following in the IP address 
fields: 192 168 77 100.

Make sure Internet
Protocol (TCP/IP) 
is checked

After entering 77 in this field, 
use the right arrow key on 
your keyboard to advance to 
the next field.
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7. The following numbers should display in the Subnet mask field: 255.255.255.0. If 
these numbers are not displayed, enter them.

8. Leave all other fields in the dialog blank.

9. Click OK to return to the Local Area Connection Properties dialog, then OK on this 
dialog to return to the Local Area Connection Status dialog. 

10. Click Close to close the Local Area Connection Status dialog.

11. Close the Network Connections dialog.
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E.  ATOMIC WEIGHTS AND CROSS-SECTIONAL 
AREAS FOR SELECTED METALS

Metal Symbol Atomic Weight
(g/mole)

Cross-Sectional 
Area

(sq nm)

Density
(g/mL)

chromium Cr 51.996 0.0635 7.19

cobalt Co 58.933 0.0662 8.9

copper Cu 63.546 0.0680 8.96

gold Au 196.967 0.08696 18.9

hafnium Hf 178.490 0.0862 13.3

iridium Ir 192.220 0.0769 22.4

iron Fe 55.847 0.0613 7.89

manganese Mn 54.938 0.0714 7.43

molybdenum Mo 95.940 0.0730 10.2

nickel Ni 58.710 0.0649 8.8

niobium Nb 92.906 0.0806 8.57

osmium Os 190.220 0.0629 22.6

palladium Pd 106.400 0.0787 12.0

platinum Pt 195.090 0.0800 21.4

rhenium Re 186.207 0.0649 21.0

rhodium Rh 102.906 0.0752 12.4

ruthenium Ru 101.070 0.0613 12.4

silver Ag 107.868 0.0869 10.5

tantalum Ta 180.947 0.0800 16.6

thorium Th 232.038 0.1350 11.7

tin Sn 118.710 0.1082 4.54

tungsten W 183.850 0.0741 19.3

vanadium V 50.942 0.0680 6.11

zirconium Zr 91.220 0.0877 6.51
 248-42800-01 - ChemiSorb HTP Operator’s Manual - V2.01                                            E-1 



 

 



ChemiSorb HTP Appendix F
F.  FORMAT OF EXPORTED DATA

This appendix details the format and meaning of data in unreduced reports. Each record is ter-
minated by a carriage return and line feed. Character strings are delimited by double 
quotation marks.

Record position indicates the relative position of a record within a group. The different types 
of counter records indicate those sections of the file having a variable number of records; 
counter records specify the number of entries (types of information) contained in a table.

Record 
Position Information Conveyed Form

1 Sample ID quoted string
(40 characters)

2 Operator ID quoted string
(40 characters)

3 Submitter ID quoted string
(40 characters)

4 Bar code quoted string
(40 characters)

5 Mass floating point

6 Type of data
0 = Automatically collected
1 = Manually entered

integer

7 Count of data points for primary analysis integer

(Each entry for this counter appears on one line, 
separated with a comma.)

Pressure value
Quantity dosed
Elapsed time
Sample temperature
Port temperature
Assignments

1 = Difference report
2 = Sinfelt
3 = Both
4 = Neither

floating point
floating point
integer
floating point
floating point
integer

Count of data points for repeat analysis
Same columns as primary analysis
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INDEX

Symbols
$ symbol, 8-8

A
Active metals

defaults, 8-12
Active Metals Defaults command, 8-12
Active metals table

options, 5-27
Add Log Entry push button, 5-7
Adding an analyzer, 4-6
Adsorptive, 5-19

options, 8-13
Stoichiometry factor, 5-28, 8-13

Adsorptive push button, 5-28, 8-13
Advanced format, 8-3

sample information file, 3-8, 5-5
specifying default values, 8-6

Alumina, replacing in oil vapor traps, 9-12
Analysis

performing, 3-21
preparing for, 3-11
repeat, 5-21
sequence, 3-22
temperature, 5-19
termination, 5-14

Analysis conditions file, 5-12
creating, 3-6
listing file statistics, 2-7
listing statistics, 3-26
opening, 2-7
printing contents, 3-24

Analysis program, 1-4
exiting, 2-7
uninstalling, 4-16
using, 2-6

Analysis Sequence command, 6-8
Analyzer

adding another, 4-6
changing ethernet connection, 4-13
cleaning, 9-4
electrical requirements, 1-5
maintaining, 9-2
moving from one computer to another, 4-8
physical dimensions, 1-5
removing, 4-12
specifications, 1-5

turning on and off, 2-5
weight and dimensions, 1-5

ASCII format
saving reports, 7-11

Atomic cross-sectional area, 5-27
for metals, E-1

Atomic weight, 5-27
for metals, E-1

Autoscale
axes, 5-31
onscreen graphs, 7-14

Axis
coordinates, viewing, 7-17
properties, editing, 7-16
range, 5-31

Axis Properties dialog, 7-16

B
Backfill

gas, 5-13
sample tube, 5-14

Bar code, 5-6
Basic format, 8-4

sample information file, 3-10, 5-8

C
Calculations

crystallite size, B-5
dissociative chemisorption, B-6
free space, B-1
Freundlich, B-7
gas quantities, B-1
Langmuir surface area, B-6
metal dispersion, B-5
metallic surface area, B-5
quantity adsorbed, B-3
Temkin isotherm, B-8
weighted metal parameters, B-4

Calibrate Pressure Offset dialog, 6-27
Calibrate Servo dialog, 6-28
Calibration, 6-27

match transducers, 6-28
MFC, 8-14
pressure offset, 6-27
readings, 6-24
servo valve, 6-28
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Calibration command, 6-27
Calibration file

loading, 6-29
reinstalling, 4-15
saving, 6-29

Cascade windows, 2-7, 2-9
Cautions, defined, 1-3, 4-5
Cleaning

analyzer, 9-4
sample tubes, 3-11

Clear push button, 5-22
Close All command, 5-44
Close command, 5-44
Close Reports command, 7-4
Columns, editing on onscreen reports, 7-13
Compatibility check, 6-4
Components and Connectors, 2-1

front panel, 2-1
rear panel, 2-3
side panel, 2-4

Compressibility
factor, 8-15
table, loading, 8-15

Computer requirements, 1-7
Conventions

file name, 2-7
used in operator’s manual, 1-3

Creating
Analysis conditions files, 3-6, 5-12
Report options files, 3-7, 5-25
Sample information files, 3-8, 5-4
sample information files, 5-4

Cross hair, axis, 7-17
Curve Properties dialog, 7-15

D
Data

collected, 5-41
copy to clipboard, 7-16
entered manually, 5-14, 5-41
isotherm, exporting, 5-48
selecting display options, 8-16

Defaults
Advanced format, 8-6
Basic and Restricted formats, 8-9
file name extensions, 2-7
for parameter files, 8-6
gas, 8-14
sample file sequence number, 8-7

Delete push button, 5-22
Difference Method report, 5-32
Directory

parameter files, 8-17

Dose amount, 5-20

E
Edit Quantities Adsorbed dialog, 7-6
Element, 5-27
Elevator

lubricating drive assembly, 9-3
push buttons, 2-2
raising and lowering, 2-2, 6-15

Enable Manual Control command, 6-13
Environment conditions, 1-5
Equilibration, 5-23
Error messages, A-1

2200 and 2400 Series, A-1
2500 series, A-12
4000 series, A-20
6200 series, A-24
6500 series, A-32

Ethernet
configuring port for Windows 7, D-2
configuring port for Windows Vista, D-2
configuring port for XP, D-5

Evacuation, 5-15
backfill gas, 5-13
heat rate, 5-16
task, 5-15
temperature, 5-16
time, 5-15, 5-21, 5-24

Exhaust system, attaching, 2-3
Exit command, 5-51
Export command, 5-48
Export data, 5-48

format used, F-1
Exporting sample files, 3-28

F
File

opening, 2-7
statistics, 3-26

File menu, 5-1
Close all command, 5-44
Close command, 5-44
Exit command, 5-51
Export command, 5-48
List command, 5-47
Open command, 5-3
Print command, 5-45
Save All command, 5-44
Save as command, 5-44
Save command, 5-44

File name
default extensions, 2-7
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included as part of file description, 8-7
Filler rod, 3-13

cleaning, 3-11
Filter disks, 3-15
Flow

gas, 5-16
temperature, 5-16
time, 5-16

Free space, 5-24, 5-43
calculations, B-1
measurement, 5-24

Freundlich report, 5-36
calculations, B-7

Front Panel, 2-1
Function keys

 See Shortcut keys
Furnace, raising and lowering, 2-2, 6-15

G
Gas

connecting, 9-16
conversion constant, 8-14
conversion constants, list of, C-1
disconnecting depleted bottle, 9-16
for soaking, 5-18
guidelines for connecting to analyzer, 9-16
inlets, 2-4
specifying ports for, 6-26, 9-20

Gas Configuration dialog, 6-26
Gas Defaults / MFC Constants command, 8-14
Graph

copy to clipboard, 7-16
editing onscreen, 7-14
grid lines, 8-16
legend, editing, 7-16

Graph Grid Lines command, 8-16
Graph Grid Lines dialog, 8-16
Graph overlay, 3-29, 5-26
Graphic, showing in report header, 5-29
Grid lines, 8-16

H
Heat of Adsorption report, 2-7, 7-5
Help menu, 2-9
Histogram, 7-15

I
Insert push button, 5-22
Insert Quantity Range dialog, 7-6
Instrument log, showing, 6-22

Instrument schematic, 6-18
component descriptions, 6-13

IP address
entering, Windows 7 and Windows Vista, D-3
entering, Windows XP, D-6

Isosteric heat of adsorption, 7-5
Isotherm data, 5-48

example of output, 5-50
Isotherm report, 5-30

L
Langmuir Surface Area report, 5-35
Leak test, 5-17

task options, 5-17
Legend Properties dialog, 7-16
List command, 5-47
Local area connection, D-5
Log entry, 5-7
Log report, 6-22
Logo, displaying in report header, 5-29

M
Main menu, 2-8
Maintenance, system, 9-1
Manifold temperature, on schematic, 6-16
Manual control, 6-13
Manually entered data, 5-14
Mass Flow Controller, 1-4, 6-16

See also MFC
Menu structure, 2-8
MFC

calibration, 8-14
gas conversion constant, 8-14
gas conversion constants list, C-1

Monolayer capacity, 5-36, 5-38
Moving an analyzer to another computer, 4-8

N
Notes, defined, 1-3, 3-17, 5-6

O
Oil vapor trap, replacing alumina, 9-12
Online manual

accessing, 2-7
Onscreen report, 7-9

editing, 7-13
saving, 7-11
shortcut menus, 7-13
See also  Report
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Open command, 5-3
Open Compressibility Factor Table dialog, 8-15
Open Report command, 7-4
Operator, specifying, 8-7
Operator’s manual

conventions, 1-3
organization, 1-1

Option presentation
Advanced format, 8-3
Basic format, 8-4
Restricted format, 8-5

Option Presentation command, 8-2
Options menu, 8-1

Active Metals Defaults command, 8-12
Gas Defaults / MFC Constants command, 8-14
Graph Grid Lines command, 8-16
Option Presentation command, 8-2
Parameter Files Directory command, 8-17
Sample Defaults command, 8-6
Service Test Mode command, 8-17
Thermal Transpiration on Live Graph command, 

8-17
Units command, 8-16

Options report, 5-40
Outgas rate, 5-17
Overlay samples check box, 5-30
Overlay, graph, 3-29

P
Parameter File Directory Selection dialog, 8-17
Parameter files, 5-4

Analysis conditions, 5-12
default values, 3-1
defining, 3-5
directory, 8-17
listing statistics, 3-26
printing contents, 3-24
specifying location, 8-17

Password
Restricted format, 8-5
Service tests, 8-17

Port
assignment, 6-26
filter, replacing, 9-6
status, 2-2

Pressure
offset, 6-27
table, 5-21

Pressure push button, 5-21
Pressure zero calibration, 6-27
Preventive maintenance schedule, 9-2
Print command, 5-45
Printing file contents, 3-24, 5-45

Q
Quartz wool, 3-15

R
Rear panel, 2-3
Removing an analyzer, 4-12
Repeat analysis, 5-21
Replace All push button, 5-7
Replace push button, 5-12
Report

closing, 7-4
closing all, 2-7
examples, 7-18
generating, 7-2
graphs, editing onscreen, 7-14
header, 7-9
Heat of Adsorption, 7-5
legend, editing, 7-16
onscreen, 7-9
opening, 7-4
saving in other formats, 7-11
starting, 2-7
Tabular, editing onscreen, 7-13
Tool bar, 7-10
zoom feature, 7-17

Report after analysis, 6-5
Report options file, 5-25

creating, 3-7
listing statistics, 2-7, 3-26
opening, 2-7
printing contents, 3-24

Report Settings dialog, 6-5
Reports

difference method, 5-32
Freundlich, 5-36
isotherm, 5-30
Langmuir surface area, 5-35
Options, 5-40
options, 5-40
Sample log, 5-40
Sinfelt method, 5-34
Temkin, 5-38
types available, 5-26

Reports menu, 7-1
Close Reports command, 7-4
Open report command, 7-4
Start Report command, 7-2

Restricted format, 8-5
password, 8-5
sample information file, 3-10, 5-11
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S
Sample

determining mass of, 3-14
mass, 5-6
monolayer capacity, 5-36

Sample Analysis command, 6-3
Sample defaults, 8-6

Advanced format, 3-1, 8-6
Basic and Restricted formats, 3-3
Restricted format, 8-9
specifying for Advanced format, 8-6
specifying for Basic format, 8-9

Sample Defaults command, 8-6
Sample file name, specifying default sequence, 8-7
Sample information file, 5-4

Advanced format, 3-8, 5-5
Basic format, 3-10, 5-8
exporting, 3-28
listing statistics, 2-7, 3-26
opening, 2-7
printing contents, 3-24
Restricted format, 5-11
specifying defaults, 8-6

Sample log entry, 5-7
Sample Log report, 5-40
Sample tube

cleaning and labeling, 3-11
installing, 3-18
replacing O-ring, 9-4

Save All command, 5-44
Save As command, 5-44
Save command, 5-44
Schematic

accessing pop-up menus, 6-13
manual control, 6-13
See also Instrument schematic

Select a Task dialog, 5-13
Select Calibration File dialog, 6-29
Sequence

analysis, 3-22
number, specifying, 8-7

Service Test Mode command, 8-17
Servo valve

calibrating, 6-28
settings, 6-14

Set Temperature Controller dialog, 6-15
Setup program, 4-4

adding an analyzer, 4-6
changing analyzer setup, 4-13
moving an analyzer to another computer, 4-8
reinstalling calibration files, 4-15
removing an analyzer from the computer, 4-12
uninstalling the software, 4-16

Shortcut keys, 2-6
for instrument schematic, 6-13

Shortcut menu, 2-6
accessing, 2-7
for graphs, 7-14
for tabular reports, 7-13

Show All Readings command, 6-19
Show Instrument Log command, 6-22
Show Instrument Schematic command, 6-18
Show Status command, 6-20
Side panel, 2-4
Sinfelt Method report, 5-34
Soak task, 5-18
Software

installing, 4-1
installing upgrade, 4-5
uninstalling, 4-16
using, 2-6
using for other functions, 4-4
version, 6-24

Specifications, 1-5
Spreadsheet format

saving reports, 7-11
Start Report command, 7-2
Start Report dialog, 7-2
Status window, for analyses, 6-20
Stoichiometry factor, 5-28
Submitter, specifying, 8-7
Subnet mask

entering, Windows 7 and Windows Vista, D-3
entering, Windows XP, D-7

System
description, 1-4

T
Target pressure tolerance, 5-20
Task

Analysis, 5-19
Evacuation, 5-15
Flow, 5-16
inserting, 5-13
Leak test, 5-17
Soak, 5-18

Temkin report, 5-38
calculations, B-8

Temperature
manifold, 6-16
readings on schematic, 6-15
specifications, 1-5

Thermal transpiration
correction, 5-29
on live graph, 8-17

Tile windows, 2-7, 2-9
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Title Properties dialog, 7-16
Tool bar, reports window, 7-10
Transducer

match, 6-28
offset, 6-28

Troubleshooting, 9-1

U
Unit Configuration command, 6-24
Unit menu, 6-1

Analysis Sequence command, 6-8
Calibration command, 6-27
Enable Manual Control command, 6-13
Sample Analysis command, 6-3
Show All Readings command, 6-19
Show Instrument Log command, 6-22
Show Instrument Schematic command, 6-18
Show Status command, 6-20
Unit Configuration command, 6-24

Units command, 8-16
Units Selections dialog, 8-16
Units, selecting, 8-16
Unrestricted evacuation, 5-15

V
Vacuum pump

changing or adding oil, 9-9
inspecting oil level, 9-9
replacing alumina in oil vapor trap, 9-12

Valves
manual control, 6-13
servo, 6-14

Volume calibration, 6-24

W
Warnings, defined, 1-3
Windows menu, 2-9

X
X-axis range, 5-31
X-axis scale, 5-30

Y
Y-axis range, 5-31

Z
Zoom feature, 7-17
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